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OVERVIEW 

The U.S. Environmental Protection Agency (EPA) Benchmark Dose Software 
(BMDS) was developed as a tool to facilitate the application of benchmark dose 
(BMD) methods to EPA hazardous pollutant risk assessments. This help file 
provides instruction on how to use the BMDS, but is not intended to address the 
EPA BMD methods. However, every attempt has been made to make this 
software consistent with EPA Risk Assessment Forum (RAF) Benchmark Dose 
Technical Guidance Document (U.S. EPA, 2012). 

HISTORY OF BMDS DEVELOPMENT 

Research into model development for BMDS started in 1995 and the first BMDS 
prototype was internally reviewed by EPA in 1997. After external and public 
reviews in 1998–1999, and extensive Quality Assurance testing in 1999–2000, 
BMDS version 1.2 was released in April, 2000. Subsequent versions were 
released up to version 1.4.1b in August 2007. BMDS version 2.3.1 featured a 
revamped user interface and new dichotomous models (“Dichotomous 
Alternative” model type). 

A history of the versions of BMDS released by EPA is contained in the Version 
History appendix. 

The models contained in the current version of BMDS are listed in the Model 
Descriptions section of this file. 

HOW EPA USES BMD METHODS 

EPA uses BMD methods to estimate reference doses (RfDs) and reference 
concentrations (RfCs), which are used along with other scientific information to 
set standards for noncancer human health effects. 

Prior to the availability of tools such as BMDS, risk assessment benchmarks 
such as RfDs and RfCs were determined from no-observed-adverse-effect levels 
(NOAELs), which represent the highest experimental dose for which no adverse 
health effects have been documented. 

However, using the NOAEL in determining RfDs and RfCs has long been 
recognized as having limitations: 

 It is limited to one of the doses in the study and is dependent on study design 

http://www.epa.gov/raf/publications/benchmarkdose.htm
http://www.epa.gov/raf/publications/benchmarkdose.htm
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 It does not account for variability in the estimate of the dose-response 

 It does not account for the slope of the dose-response curve 

 It cannot be applied when there is no NOAEL, except through the application 
of an uncertainty factor (Crump, 1984; Kimmel and Gaylor, 1988). 

A goal of the BMD approach is to define a starting point of departure (POD) for 
the computation of a reference value (RfD or RfC) or slope factor that is more 
independent of study design. The EPA Risk Assessment Forum has published 
technical guidance for the application of the BMD approach in cancer and non-
cancer dose-response assessments (U.S. EPA, 2012). 

Using BMD methods involve fitting mathematical models to dose-response data 
and using the different results to select a BMD that is associated with a 
predetermined benchmark response (BMR), such as a 10% increase in the 
incidence of a particular lesion or a 10% decrease in body weight gain. 

BMDS facilitates these operations by providing simple data-management tools 
and an easy-to-use interface to run multiple models on the same dose-response 
dataset. Results from all models include a reiteration of the model formula and 
model run options chosen by the user, goodness-of-fit information, the BMD, and 
the estimate of the lower-bound confidence limit on the BMD (BMDL). Model 
results are presented in textual and graphical output files that can be printed or 
saved and incorporated into other documents. 

RUNNING A BMDS SESSION 

Running the models on a dataset consists of five basic steps. 

 Step 1: Create a new session or open an existing session. 

 Step 2: Select the appropriate models based on the type of dataset being 
evaluated. 

 Step 3: Create a dataset using the BMDS spreadsheet capability or import a 
data file. 

 Step 4: Specify the parameters associated with the model selected by 
choosing or creating a new option file. 

 Step 5: Run the Model and view the tabular and graphical results. 
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FUTURE OF BMDS 

EPA plans to continually improve and expand the BMDS system. 

Use the BMDS web page as your most up-to-date source of information and 
updates pertaining to the BMDS. The entire BMDS system or model updates can 
be downloaded from the web site. The source code files for the models used in 
the BMDS system are also available via the BMDS web site to reviewers and 
programmers who might be interested in performing an in-depth analysis of the 
model algorithms and features.  

We welcome and encourage your comments on the BMDS software and the 
model source code files. Please provide comments, recommendations, 
suggested revisions, or corrections through our Help Desk Form. Once in the 
BMDS system, if you have problems or concerns, please use the “Problem 
Report” feature listed in the BMDS “Help” menu. 

References 

 Crump, K. 1984. A new method for determining allowable daily intakes. Fund. 
Appl. Toxicol. 4: 854–871. 

 Kimmel, C.; Gaylor, D. 1988. Issues in qualitative and quantitative risk 
analysis for developmental toxicology. Risk Anal. 8: 15–21. 

 U.S. EPA. 2012. Benchmark Dose Technical Guidance. Risk Assessment 
Forum, U.S. Environmental Protection Agency, Washington, DC 20460: 
EPA/100/R-12/001, June 2012. 

http://www.epa.gov/bmds
http://bmds.epa.gov/eticket/
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USING BMDS 2.6.0.1 

SETTING UP BMDS 2.6.0.1 

SYSTEM REQUIREMENTS 

 BMDS requires at least 16 Megabytes of RAM and should run in Microsoft 
Windows 2000, NT, XP, Vista, 7, and 8, however only operation in Windows 
XP has been fully tested at this time. BMDS Version 2.6.0.1 can be installed 
in any folder where the user has create/read/write privileges. 

 BMDS also requires the latest version of .NET (4.0 or later). If your machine 
is set up to allow or be notified of downloads of Microsoft software, then it is 
likely that that version of the .NET framework is already installed. Otherwise, 
the latest version of .NET for client desktops can be downloaded from the 
Microsoft site. 

 To run the ToxicoDiffusion model included in this version of BMDS, you must 
download and install the 32-bit edition of version 3.1 or later of the R 
statistical software to your computer. 

DETERMINING WHETHER BMDS IS PROPERLY INSTALLED 

The following procedure will help you determine whether the BMDS components 
have properly loaded and the application is working as expected. 

1. Start BMDS. 

2. From the BMDS application menu, choose File>Open>Dose Response 
Session (.ssn). The Open File dialog box should display the contents of 
the BMDS SessionFiles folder. 

3. Select and open any .ssn file (e.g., Cancer-BMR10.ssn). The Session 
screen should appear. 

4. Click the Save As button and resave the session under a different name 
(e.g., Cancer-BMR10-test.ssn; you can delete this file later). 

5. Click the Run button on the Session screen. Plots and a summary report 
should appear. 

6. At the top of the summary report screen, select File>Export to Excel. Pre-
selected summary report data should export to several Excel worksheets, 
with the “Dichotomous Format” or Continuous Format” worksheet in the 
initial view. 

https://www.microsoft.com/net
https://www.r-project.org/
https://www.r-project.org/
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If you are able to complete the above steps without difficulty (aside from normal 
model error messages), BMDS is likely to be installed properly and completely. 

Note  To keep your BMDS system current, check the BMDS website  
periodically for updates to the software or help manual. 

CREATING A BMDS DESKTOP ICON 

You may find it more convenient to run BMDS from a desktop shortcut icon. To 
do so: 

1. Delete any older BMDS shortcut icons on your desktop. 

2. In Windows Explorer, navigate to the newly installed BMDS application 
folder. 

3. Right-click the BMDSxxx.exe file (where “xxx” denotes the current BMDS 
version number). A context menu appears. 

4. Click Send To. A submenu appears. 

5. Click “Desktop (Create Shortcut)”. Windows creates a shortcut to the file 
on your desktop. 

UNINSTALLING PREVIOUS VERSIONS OF BMDS 

It is not necessary to uninstall previous versions of BMDS to install and run 
BMDS 2.6.0.1. However, to maintain the functionality of previous sessions, it is 
recommended that you retain the directory structure for the folders where your 
previous model runs reside. 

The uninstall procedure depends on the version of BMDS you’re running. 

Uninstalling BMDS 2.1.2 and earlier 

The uninstall process will NOT remove any data, option, session, output, or plot 
files you created in previous versions of BMDS. 

1. Go to the Add/Remove Programs control panel (Windows XP or earlier) or 
the Programs and Features control panel (Windows Vista, Windows 7). 

2. Select the BMDS program in the list. 

3. Select Uninstall. 

http://www.epa.gov/bmds
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Note If you don't have the required access rights in the computer, the Remove 
button will not be shown. You should uninstall BMDS by re-starting the 
original setup.exe file and then choosing “Remove Benchmark Dose 
Software.” 

TUTORIAL: RUNNING A BMDS SESSION 

A BMDS session requires some initial setup. Once a session has been created 
and its parameters defined, it can be saved and run again later. 

There are five primary steps for running a BMDS session, and each step has its 
own responsibilities and nuances. The following sections provide a simplified 
tutorial that overviews each step of the process. The tutorial also references 
more detailed procedural explanations located elsewhere in this documentation. 

STEP 1: CREATE OR OPEN A SESSION FILE 

Use the File menu commands or the BMDS toolbar to create a new session or 
open an existing session. The Session Grid window serves as the home base 
and organizing metaphor for your BMDS work, and you can use it to access 
other parts of BMDS, such as the Data Grid and Model Option Screen. 

Creating a new session file 

 

 Click the New Session button on the BMDS toolbar to open a new Session 
Grid window, or 

 Use the File>New menu to select one of the options described in Table 1: 
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Table 1: File>New menu options for creating a new session file 

Option Description 

Dose Response Session  
(.ssn) 

Opens a new Session Grid window. 

Multiple Tumor Analysis  
(.tum) 

Creates a new session for the analysis of multiple 
tumors via multistage modeling (Multiple Tumor 
Analysis). You must specify data file and option file 
names to use for the session. 

Opening an existing session 

 

 Click the Open Session icon on the Toolbar, or 

 Select the File>Open>Dose Response Session (.ssn) menu to display the 
Open dialog box and select a previously saved session (*.ssn) file. 

 You can also select File>Open>Concentration x Time Analysis (.ten) to 
open a previously saved Concentration x Time Analysis (tenBerge) file or 
File>Open>Multiple Tumor Analysis (.tum) to open a previously saved 
session for the analysis of multiple tumors via multistage modeling (Multiple 
Tumor Analysis). 

See also: 

Working with the Session Grid 

STEP 2: SELECT THE APPROPRIATE MODEL(S) 

A BMDS session is typically used to analyze a single set of data with multiple 
models. However, BMDS is capable of processing multiple sets of data and 
multiple models in a single session. 

In this step, you use the BMDS Session Grid window to select the model(s) you 
want to run. 
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Selecting a Model Type and Model Name 

1. With a session open and the session table displayed in the BMDS 
interface, use the drop down list in the Model Type column to select a 
model for that row. 

 

2. Right-click in the row under the Model Name column to display a menu of 
appropriate models for the selected Model Type. 

 

3. Click on the appropriate model name in the dropdown list to select it. 

See also: 

 Adding and Deleting Session Grid Rows 

 Copying and Pasting a Data File Name 

 Model Types and Abbreviations 

STEP 3: CREATE OR IMPORT A DATASET 

Data are stored in files with the *.dax extension. You can use commands from 
the Session Grid window to call up the Data Grid window, which you use to enter 
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and edit data. After the data are entered/modified as desired, you can save and 
close the Data Grid window. 

The file name that appears in the Session Grid's Data File column should be the 
same file name that appears in the Data Grid window's title bar. 

Working with data files 

If a session or dataset is already loaded in the Session Grid window, right-click 
on a field in the Data File column to display a context menu of options. 

 

Table 2 describes the available context menu options. 

Table 2: Context menu options for data files 

Option Description 

New Data File  
(*.dax) 

Create a new data file using the Data Grid window 

View Data File View the currently selected data file in a read-only Data Grid 
window 

Edit Data File Edit the currently selected data file in the Data Grid window 

Change to  
Another Data File 

Display the Open dialog box to select a different data file 

Working with the Data Grid window 

Right click on the column titles to display column options. You can rename a 
column or create a new column of data by running a mathematical operation on 
the existing data. 



Benchmark Dose Software (BMDS) User Guide  Using BMDS 2.6.0.1 

BMDS version: 2.6.0.1 Page 17 of 310 Release Date: February 12, 2016 

 

For the BMDS-provided session templates, the data grid contains pre-specified 
column labels depending on the Model Type. The column labels for each model 
type are described in Table 3.  

Table 3: Pre-specified column labels for each model type 

Model Type Pre-Specified Column Labels 

Dichotomous Dose, N, Effect 

Nested Dose, Response, Total, Litter 

Continuous Dose, N, Mean, Std 

Cancer Dose, N, Effect, Effect2, Effect3, Percent 

Selecting a Model and Adding Data 

With the Data Grid open, you can select the Model Type and Modelyou want to 
run on the dataset. Afterward, you can choose to open an existing dataset or 
manually enter or import data. Using the standard Windows Cut-Copy-Paste 
commands, you can also copy and paste data from an Excel spreadsheet into 
the Data Grid. 

See also: 

 Working with the Data Grid and Datasets 

 Working with the Session Grid 

 Using Session and Option File Templates 

 Copying and Pasting a Data File Name 

STEP 4: SPECIFY MODEL PARAMETERS 

After selecting the model (in the Session Grid) and creating or importing the 
dataset (in the Data Grid), the next step is to specify the parameters associated 
with the model. You can do this by choosing or creating a new option file. 
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Creating a new model options file 

A model's option parameters are stored in files with the *.opt extension. In the 
Session Grid, right-click on a field under the Model Option File column to display 
menu options enabling you to create a new option file or select an existing option 
file. 

 

Selecting the New Option File (*.opt) command displays the Model Option 
Screen, shown below. From this screen, you can view and edit the parameter 
options. 
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After specifying the parameters, press the Save or Save As …buttons to save 
your work in an option file. Option files may be saved to a specified path, set to 
default values, and optimized using the buttons along the bottom of the window. 

The Model Option Screen's status bar displays the model and model type that 
the parameters will affect. In the previous screenshot, the selected model is 
Dichotomous and the model type is Gamma. 

Enter any freestyle text into the User Notes field to capture important information 
about the parameters. 

The data file that will be used (and its path) are displayed in the Data File field. 
Click the Show button to display the file's contents in the Data Grid window. 

Displaying the Model Input File 

After an option has been created or added to the session, right-click on the 
option file's name and select Display Model Input File from the session screen 
to view the model input file. The model input file's format is *.d. 
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The following screenshot shows the model input file as displayed within the 
BMDS text viewer. Within this viewer you can edit, save, or print the model input 
file. 

 

See also: 

 Working with the Model Option Screen 

 Working with the Model Option File Column 

STEP 5: RUN THE MODEL AND VIEW RESULTS 

After you have specified the session, model, dataset, and model parameters, 
BMDS is ready to run the model. 
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Specifying output file names 

BMDS automatically assigns an output file name for each model run (session 
row) corresponding to the following naming convention: 

[3 letter model abbreviation]-[name of data file]-[name of 

option file].out 

Model abbreviations are listed here. 

If you want to use a different output file name, right-click in a specific Out File 
column cell to specify a file name that will contain the result output. 

 

Selecting which models to run 

Select which models to run by placing checkmarks in the appropriate rows under 
the Run? column. Right clicking will display a submenu allowing all boxes to be 
checked or unchecked at once. 

 

After you have selected the models to be run in the session, click the Run button 
in the bottom left of the Session Grid window. The Session Grid's status bar will 
display a “Please wait processing . . .” message while BMDS calculates the 
results. 



Benchmark Dose Software (BMDS) User Guide  Using BMDS 2.6.0.1 

BMDS version: 2.6.0.1 Page 22 of 310 Release Date: February 12, 2016 

Viewing the results 

If the “Summary Report” option has been selected under the Tools > Options 
menu, the results will be displayed in two new windows: a textual Summary 
Report and a Summary Graph. 

The Summary Report window displays the variables set for each of the models 
run in a tabular format. Each lettered column corresponds to the models 
previously added in the session window. 

 

Right-click in any lettered column to display a menu with the options described in 
Table 4. 
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Table 4: Summary Report window’s context menu options 

Option Description 

Show Out/Graph Display individual graphs and Out File data 

Display Array Values To display array values, right-click on a cell containing the 
word “Array.” 

Open Data File Display the data file linked to the displayed results.  

Open Option File Display the option file linked to the displayed results.  

The following screenshot shows an example of an individual graph and Out File 
data display. 
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Display array data by selecting Display Array Values from the Summary Report 
window. The following screenshot displays the result. 

 

The Summary Graphs window displays graphs corresponding to each model run. 
Individual graphs may be copied to the clipboard and inserted into other files 
such as Microsoft Word documents. 
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See Also: 

 Working with Reports and Output 

 Viewing Output Files 

 Viewing Plots 

 Using GnuPlot 
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WORKING WITH THE MENUS, TOOL BARS, & STATUS BARS 

At all times, BMDS displays a menu bar and a tool bar at the top of the BMDS 
application window, and a status bar at the bottom of the window. 

BMDS presents different menu options depending on the type of window 
displayed, such as the Session window. The Data Grid window, which opens 
within the BMDS main window, presents a reduced set of menu options. 

This section describes the different options provided by the BMDS menus and 
toolbar. It also describes the information conveyed by the status bar. 

FILE MENU 

Table 5: File menu options 

Command Function 

New/Dose Response Session  
(.ssn) 

Creates a new session 

New/Dataset (.dax) Creates a new dataset with a default extension of .dax. 

Selecting this item displays a submenu with the 
following options: 

 Continuous Data. Selecting this item displays another 
submenu, with the following options: 

 Summarized (Means & Stds) 

 Individual Response 

 Dichotomous Data 

 Nested Data 

 Generic Data 

New/Multiple Tumor Analysis  
(.tum) 

Creates a new session for the analysis of multiple 
tumors via multistage modeling (Multiple Tumor 
Analysis). 

Open/Dose Response Session  
(.ssn) 

Opens previously saved session. 

Open/Dataset (.dax)  Opens previously saved dataset. 

Open/Concentration x Time  
Analysis (.ten) 

Opens previously saved Concentration x Time Analysis 
(tenBerge) file. 

Open/Multiple Tumor Analysis  
(.tum) 

Opens previously saved session for the analysis of 
multiple tumors via multistage modeling (Multiple Tumor 
Analysis). 

Save Session (Session window) Saves changes to the selected session. 

Save Session As …  
(Session window) 

Displays the standard Windows Save As dialog box so 
the current session can be saved under a new filename. 

Close Session  
(Session window) 

Closes the selected Session window. 
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Command Function 

Print Prints the contents of the selected Session window. 

Exit Closes the BMDS application. BMDS will prompt you to 
save any unsaved changes. 

Print Setup  
(Session window) 

Displays the standard Windows Print Setup dialog box, 
where you can select such options as orientation, 
margins, paper size, and so on. 

Print Preview  
(Session window) 

Displays a new window showing how the printed 
document will look. The toolbar buttons at the top of the 
window enable you to display one or more pages at a 
time, change magnification, jump to a specific page, and 
so on. 

EDIT MENU 

The Edit menu commands assist with copying, cutting and pasting data within the 
BMDS output file. The commands can be implemented by selecting them from 
the menu with a mouse or by using the indicated key strokes. 

Table 6: Edit menu options 

Command Function 

Cut (Ctrl+X)  Selected data is cut from an active output file. 

Copy (Ctrl+C)  Selected data is copied from an active output file; or a selected 
data file name is copied from the Data File column of an active 
session grid. 

Paste (Ctrl+V)  Cut/copied data is pasted into output file at cursor location. 

Delete (Del) Delete selected data. 

Select All (Ctrl+A) Selects all text in current active window. 

VIEW MENU 

Table 7: View menu options 

Command Function 

Tool Bar Toggles the visibility of the tool bar and icons. A checkmark to the 
left of this option in the menu indicates the tool bar is visible. 

Status Bar Toggles the visibility of the status bar at the bottom of the BDMS 
screen. A checkmark to the left of this option in the menu indicates 
the status bar is visible. 
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TOOLS MENU 

Table 8: Tools menu options 

Command Function 

View Plot …  Displays a submenu for the following options to use for viewing a 
graph: 

 Using BMDS …  

 Using GnuPlot …  

View Output File …  Opens saved Output file in new window. 

Preferences …  Displays separate Preferences dialog boxes for the Update 
function, Summary Report windows, and Data Grid windows. 

BMDS displays the following dialog box for Update Preferences: 

 

Select how often or whether you want BMDS to check for new versions of the 
software. Click Check for updates now to manually check for BMDS updates. 
BMDS will display a message stating either that the current version is up to date 
or that a new version is available for download and install. 



Benchmark Dose Software (BMDS) User Guide  Using BMDS 2.6.0.1 

BMDS version: 2.6.0.1 Page 29 of 310 Release Date: February 12, 2016 

BMDS displays the following dialog box for Report Preferences: 

 

Table 9: Report Preferences options  

Option Function 

Summary Report A checkmark to the right of this option indicates a summary report 
and summary plots will be displayed after a session run. 

If unchecked, the summary report is not generated and plots are 
displayed in separate windows. 

Group By This option determines how a session's results (summary reports and 
summary plots) are grouped together. 

Results can be grouped by end points or by the data filename. 

BMDS displays the following dialog box for Data Grid preferences: 

 

Table 10: Data Grid Preferences options  

Option Function 

Default Number of Rows Determines how many rows appear when creating a 
new dataset. 
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Option Function 

Default Number of Columns Determines how many columns appear when creating 
a new dataset. 

Session Grid menu 

This menu is available only when a session window is open. 

Table 11: Session Grid menu options  

Command Function 

Insert Row Inserts a new row above the currently selected row in the session 
grid. The currently selected row is indicated by the black arrow to 
the left of the row number. 

Add Row(s) From the dropdown list, select a predefined number of rows to add 
to the session grid or all the models of a chosen group to add. 
BMDS creates the rows only after Add Row(s) is selected. 

Delete Row Deletes the currently selected row in the session grid. 

Data Grid menu 

This menu is available only when a Data Grid window is open. 

Table 12: Data Grid menu options  

Command Function 

Add Column(s) From the dropdown list, select a predefined number of columns to 
add to the data grid. BMDS creates the columns only after Add 
Column(s) is selected. 

Add Row(s) From the dropdown list, select a predefined number of rows to add 
to the data grid. BMDS creates the rows only after Add Row(s) is 
selected. 

Insert Row Inserts a new row above the currently selected row in the data grid. 
The currently selected row is indicated by the black arrow to the left 
of the row number. 

Insert Column Inserts a new column to the left of the current column. The column 
that has a selected cell is the current column. 

Delete Row Deletes the currently selected row in the data grid. 

Delete Column Deletes the currently selected column in the data grid. The column 
that has a selected cell is the current column. 
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Windows Menu 

Options under the Windows menu are only available when multiple windows are 
open inside the BDMS program. 

Table 13: Windows menu options  

Command Function 

Tile Horizontal Tiles windows horizontally. 

Tile Vertical Tiles windows vertically. 

Cascade Displays windows in a cascade arrangement. 

Close all Closes all windows inside the BDMS program. 

Window List A list of currently open windows is displayed. Clicking on a 
particular window name will bring the selected window to the top. 
The current top window will have a checkmark to the left of its 
name. 

Help Menu 

Table 14: Help menu options  

Command Function 

BMDS Help Displays the contents of the Help documentation in a new window. 

Quick Start Opens the BMDS Quick Start Guide in the default web browser. 

BMD Technical 
Guidance 

Opens the BMD Technical Guidance PDF in the default web 
browser. 

BMDS Home Opens the BMDS Home page in the default web browser. 

BMDS Support Currently not implemented. 

About …  Window describing the BMDS Sponsors and Credits, BMDS 
program version, and a disclaimer. 

Tool Bar 

Table 15: Tool Bar buttons and options  

Icon Command Function 

  

New Creates a new session window. 

  

Open  Opens a previously saved session. A regular Dose-
Response session (a file with the .ssn extension) or an 
existing Concentration x Time model analysis (a file with 
the .ten extension) may be opened this way. 

http://www.epa.gov/bmds/benchmark-dose-software-bmds-quick-start-guide
http://www.epa.gov/raf/publications/pdfs/benchmark_dose_guidance.pdf
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Icon Command Function 

  

Save Session  Saves the current session. 

 

Print Prints the results of the current session. 

  

New Dataset  Create a new dataset. 

 

Open Dataset  Opens an existing dataset. 

 

View Output File Opens saved Output file in new window. 

  

Exit  Exit the program. 

Status Bar 

Each window in BMDS has its own status bar and communicates different 
information. 

Table 16: Status bar information for BMDS windows  

Status Bar Location Functions 

BMDS application window Displays the results of actions executed within session and 
data windows, such as when rows or columns are inserted, 
a session is saved, or when a parameter options file is 
opened for editing. 

Session Grid Displays the Model Type and Model Name for the currently 
selected row. 

Parameter Options window Displays the Model Type and Model Name for the currently 
selected row. 
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WORKING WITH THE SESSION GRID 

From the Session Grid window, you can specify the models you want to use and 
run one or more sessions at a time. The Session Grid also enables you to drill 
down to data files, option files, and parameter settings for a specific session. 

THE SESSION GRID WINDOW 

The Session Grid window opens inside the BMDS application, as shown in the 
following screenshot. 

 

Components of the BMDS application window are, from top to bottom: 

 BMDS title bar with the current BMDS version number. 

 The BMDS menu bar. When a session window is open, the Session Grid 
menu appears. 

 The BMDS toolbar. 

 At the bottom of the window is the BMDS status bar. 

Components of the Session Grid window are, from top to bottom: 

 The Session Grid title bar displays the path and file name of the currently 
loaded session file. 

 Rows and columns arranged as in a spreadsheet. From the dropdown lists, 
you can specify the models you want to run for a session. 

 Buttons to run or save a session and to close the Session Grid window. 
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OPENING EXISTING SESSION FILES 

 Click the Open Session icon on the Toolbar, or 

 Select the File>Open>Dose Response Session (.ssn) menu to display the 
Open dialog box and select a previously saved session (*.ssn) file. 

 You can also select File>Open>Concentration x Time Analysis (.ten) to 
open a previously saved Concentration x Time Analysis (tenBerge) file or 
File>Open>Multiple Tumor Analysis (.tum) to open a previously saved 
session for the analysis of multiple tumors via multistage modeling (Multiple 
Tumor Analysis), as shown in the following screenshot. 

 

CREATING A NEW SESSION FILE 

 Click the New Session button on the BMDS toolbar to open a new Session 
Grid window, or 

 Use the File>New menu to select one of the options described in Table 17. 

Table 17: Menu options for creating a new session grid 

Options Description 

Dose Response Session  
(.ssn) 

Opens a new Session Grid window. 

Multiple Tumor Analysis  
(.tum) 

Creates a new session for the analysis of multiple 
tumors via multistage modeling (Multiple Tumor 
Analysis). You must specify data file and option file 
names to use for the session. 

See also: 

 Working with the Session Grid 

 Working with the Data Grid and Datasets 
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SELECTING THE APPROPRIATE MODEL(S) FOR THE DATA 

A BMDS session is typically used to analyze a single set of data with multiple 
models. However, BMDS is capable of processing multiple sets of data and 
multiple models in a single session. 

1. With a session open and the session table displayed in the BMDS 
interface, use the drop down list in the Model Type column to select a 
model for that row. 

 

2. Right-click in the row under the Model Name column to display a menu of 
appropriate models for the selected Model Type. 

 

3. Click on the appropriate model name in the dropdown list to select it. 

See also: 

 Adding and Deleting Session Grid Rows 

 Copying and Pasting a Data File Name 

 Model Types and Abbreviations 
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WORKING WITH THE DATA FILE COLUMN 

From the Session Grid, you can open the Data Grid window to create a new 
dataset, switch to a different dataset, or edit or view an existing dataset. You can 
also open the Model Input File, which is a text file that contains instructions for 
running the model. 

 

With a session open in the Session Grid and with datasets specified in the Data 
File grid, you can right-click on any Data File column cell and select options 
described in Table 18.  

Table 18: Data File column’s context menu options  

Command Action 

New Data File (*.dax) Opens an empty, untitled dataset 
(“UntitledData.dax”) in a new Data Grid window. 

View Data File Opens the selected dataset into a read-only Data 
Grid window. You cannot modify data in this view. 

Edit Data File Opens the selected dataset into a new Data Grid 
window for editing.  

Change to Another Data File Displays an Open dialog box where you can select 
a different data file to be used for that model. 

Display Model Input File (*.(d)) Opens a text-edit window within BMDS that 
displays the model input file. You can view, modify, 
and save the model's input parameters from the 
text-edit window. 
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WORKING WITH THE MODEL OPTION FILE COLUMN 

From the Session Grid, you can open the Model Option Screen to create a new 
option file, select a different option file, or edit or view the selected option file. 
You can also open the Model Input File, which is a text file that contains 
instructions for running the model. 

 

With a session open in the Session Grid and with option files specified in the 
Data File grid, you can right-click on any Model Option File column cell and 
select the context menu options described in Table 19.  

Table 19: Model Option File column’s context menu options  

Command Action 

New Option File (*.opt) Opens a new Model Option screen for the selected 
model type. 

View Option File Opens the selected option file into a read-only 
Model Option screen. You cannot modify data in 
this view. 

Edit Option File Opens the selected option file into a new Model 
Option Screen for editing.  

Change to Another Option File Displays an Open dialog box where you can select 
a different option file to be used for that model. The 
default is the BMDS OptionFiles directory.  

Display Model Input File Opens a text-edit window within BMDS that 
displays the model input file. You can view, modify, 
and save the model's input parameters from the 
text-edit window. 
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Note When working within a session, changes made to one option file (i.e., for 
one model) can be “transferred” to other option files included in that 
session (i.e., those for other models). Changes to the dose, sample size, 
response, mean, or standard deviation variables can therefore be done 
without having to make those changes separately in every option file. The 
user will be prompted to choose whether variable name assignment 
changes made in one option file should be made in all other option files 
included in that session. 

See also: 

Working with the Model Option Screen 

WORKING WITH THE OUT FILE COLUMN 

The results of a BMDS session run are saved to an output file (*.out). 

BMDS automatically assigns an output file name for each model run (session 
row) corresponding to the following naming convention: 

[3 letter model abbreviation]-[name of data file]-[name of 

option file].out 

An example output file name would be: 

lin_Continuous2_Lin-ConstantVariance-BMR1Std-IndResp.out 

Clearing the current output file name 

1. Select a cell in the Session Grid's Out File column that has an output file 
name. 

2. Right-click to display the popup menu and select Clear Out File. The cell's 
contents are cleared. 

Specifying a new output file name 

1. Select a cell in the Session Grid's Out File column. The cell can be empty 
or contain an output file name. 

2. Right-click to display the popup menu and select Set Out File To. The 
Save As dialog is displayed. Select the file you want to use or enter the 
name of the file as you want it to appear in the Out File column. 

See also: 

 Step 5: Run the Model and View Results 
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 Model Types and Abbreviations 

SPECIFYING THE MODELS TO INCLUDE IN A SESSION 

After you have defined the models, data, parameters, and output file names, you 
must select which models to be included in the session run. 

Placing checkmarks in the appropriate rows under the Run? column will include 
those models in the session run. 

Right clicking will display a submenu allowing all boxes to be checked or 
unchecked at once. 

 

After you have selected the models to be included in the session run, click the 
Run button in the bottom left of the Session Grid window. 

See also: 

Step 5: Run the Model and View Results 

RUNNING MULTIPLE SESSIONS 

In addition to running a session, BMDS can run multiple sessions simultaneously. 
That is, BMDS can compute the results of a session while running computations 
on a separate session. 

To run multiple sessions, open and specify more than one Session Grid window 
and click each window's Run button. 

The following screenshot shows three separate Session Grid windows open 
within the BMDS application window. 
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ADDING AND DELETING SESSION GRID ROWS 

You can add columns and rows to, and delete rows from, Session Grids and 
Data Grids. 

You can delete columns from Data Grids only. 

Note  When all of the cells in a column/row are empty the column/row is 
removed when the dataset is saved. However, if a column/row contains 
any data at all, the column/row is retained when the dataset is saved. 

 To insert a row above the currently selected row, select Session Grid>Insert 
Row. 

 To delete the currently selected row, select Session Grid>Delete Row. 
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 To add multiple rows above the currently selected row, select Session Grid, 
pick a pre-defined option from the dropdown list, and click Add Row(s).  
 
You can add either a number of rows (1, 2, 5, 10, or 20) before the currently 
selected row or all the models for a selected Model Type (All Continuous, All 
Dichotomous, All Dichotomous Alternative, All Nested Dichotomous). Adding 
All Continuous, for example, inserts 5 rows of the Continuous model type, 
with each continuous model in its own row (Exponential, Hill, Linear, 
Polynomial, and Power). 

See also: 

 Working with the Menus, Tool Bars, & Status Bars 

 Adding and Deleting Data Grid Columns and Rows 

COPYING AND PASTING A DATA FILE NAME 

1. In a Session Grid, click on a filename in the Data File column. 

2. Press Ctrl-C or select Edit>Copy to copy the data file reference. 

3. Click on a blank cell in the Data File column where you want to insert the 
reference. 

4. Press Ctrl-V or select Edit>Paste. 

See also: 

Copying, Cutting, and Pasting Data 
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WORKING WITH THE DATA GRID AND DATASETS 

Data are stored in files with the *.dax extension, but you can import files of other 
formats (space-, tab-, or comma-delimited, Excel 2003, or BMDS 1.xx). 

Use the Data Grid window to enter and edit data. After the data are 
entered/modified as desired, you can save and close the Data Grid window. The 
appropriate data file name should be displayed in the Session Grid's Data File 
column. 

The default number of rows and columns for a new Data Grid window is 1000 
and 50, respectively, but you can change this in the Tools>Preferences menu. 

Note Decimal Separators: BMDS supports regional settings for the decimal 
separator in the user interface and in spreadsheets created by the Export 
to Excel function.  
 
Thousands Separators: No “thousands separator” (regardless of regional 
setting) can be used in the data; that is, one thousand can only be written 
as 1000 rather than as 1,000. 

THE DATA GRID WINDOW 

 

Components of the Data Grid window are, from top to bottom: 

 The title bar, which includes the path and file name of the currently loaded 
dataset. 

 The menu bar, with its own File and Edit menu options that apply specifically 
to the Data Grid window. There is also a Data Grid menu that enables you to 
add or remove rows and columns. 
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 A toolbar from which you can select the Model Type and Model Name you 
wish to apply to the dataset. When the dataset is ready for you to specify 
variables, press the Proceed button to display the Model Option screen. 

 The Data Grid spreadsheet. From here, you can enter, edit, and sort data; 
rename columns; and perform mathematical transformations on columns. 

PREDEFINED COLUMN TITLES FOR MODELS 

New Data Grid windows are pre-loaded with column labels that work with the 
session templates provided with BMDS. The user can change the column labels, 
but should be aware that the dataset will not run in a BMDS session file unless 
the template option files in the session file are revised to recognize the new 
column label. 

For the BMDS-provided session templates, the data grid contains pre-specified 
column labels as described in Table 27. 

Table 20: Column labels for template types  

Template Type Pre-Specified Column Labels 

Dichotomous Dose, N, Effect 

Nested Dose, N, Response, Covariate 

Continuous Dose, N, Mean, Std 

OPENING EXISTING DATASET FILES 

When Open Dataset is chosen from the File menu or the Open Dataset button is 
pressed the user will be prompted for a file to load or import. 

 Click the Open Dataset icon on the Toolbar, oror 

 Select the File>Open>Dataset (.dax) option. 

Selecting either option displays the Open dialog box. By default, BMDS initially 
displays any BMDS dataset files (*.dax) in the BMDS program directory's Data 
folder. 

Note Decimal Separators: BMDS supports regional settings for the decimal 
separator in the user interface and in spreadsheets created by the Export 
to Excel function.  
 
Thousands Separators: No “thousands separator” (regardless of regional 
setting) can be used in the data; that is, one thousand can only be written 
as 1000 rather than as 1,000. 
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See also: 

Decimal and Thousands Separators in BMDS 

CREATING A NEW DATASET 

You can create a new dataset in any of the following ways: 

 Click the New Generic Dataset button on the BMDS toolbar to open a new 
Data Grid window. A new Data Grid window contains 1000 rows and 50 
columns.  

 In a Session Grid window, right-click in the Data File column and select New 
Data File (*.dax) to open a new Data Grid window. 

 Use the File>New>Dataset (.dax) menu and select one of the following 
options. Selecting an option opens a new Data Grid window with the selected 
Model Type and a default Model Name filled in, unless otherwise noted. 

 Continuous Data. Selecting this item displays another submenu, with the 
following options: 

 Summarized (Means & Stds) 

 Individual Response 

 Dichotomous Data 

 Nested Data. 

 Generic Data. For this option, Model Type and Model Name are blank. 

See also: 

Changing the Default Number of Rows and Columns 

SELECTING A MODEL TO RUN 

At the top of the Data Grid window are two fields where you specify the Model 
Type and then the specific Model you wish to apply to the dataset. Select the 
choices you want from the dropdown lists. 

 

See also: 

Model Types and Abbreviations 
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ENTERING OR IMPORTING DATA 

If you opened an existing dataset file, then data will already be present in the 
Data Grid. However, if you selected the New Dataset option, then a blank Data 
grid window appears. From there, you can create a new dataset in a variety of 
ways. 

Warning Do not import or create datasets that have two or more columns 
with the same name. BMDS calculations depend on the columns having 
unique names. 

Note Decimal Separators: BMDS supports regional settings for the decimal 
separator in the user interface and in spreadsheets created by the Export 
to Excel function.  
 
Thousands Separators: No “thousands separator” (regardless of regional 
setting) can be used in the data; that is, one thousand can only be written 
as 1000 rather than as 1,000. 

Entering data 

 You can manually type the data into individual cells of the Data Grid. 

 You can copy and paste data using the standard Windows Cut-Copy-Paste 
commands from an Excel spreadsheet into the Data Grid. 

Importing data 

BMDS can import delimited DOS text files, files in Excel 2003 format, or BMDS 
1.xx dataset files. 

BMDS dataset files are stored as DOS text files delimited with blanks; each line 
represents a row in a spreadsheet and each blank signifies the start of a new 
value within the row. If your file has a similar format, then from the Data Grid's 
File menu you can choose either “BMDS 1.xx Dataset” if the file has a .set 
extension or “Space Delimited Text File.” 

You can import a dataset only into a blank Data Grid. 

Note  The first row of the imported file is reserved for column headers (variable 
names). Once imported, you can rename the column header. Column 
headers must be one word with no spaces. 

5. From the BMDS toolbar, click the New Generic Dataset button. An empty 
Data Grid window is displayed. 
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6. From the Data Grid's File menu, select Import Data From and then the 
type of file you want to import. Valid file formats include: 

 Tab-delimited text file (*.txt) 

 Space-delimited text file (*.txt) 

 Comma-separated values text file (*.csv) 

 Excel 2003 (or earlier) spreadsheet (*.xls) 

 BMDS 1.xx dataset (*.set) 

See also: 

 Renaming Columns 

 Decimal and Thousands Separators in BMDS 

COPYING, CUTTING, AND PASTING DATA 

You can select one or multiple cells of data within BMDS and then use the 
standard Windows Cut (Ctrl+X), Copy (Ctrl+C), Paste (Ctrl+V), and Select All 
(Ctrl+A) commands to move the data wherever you like. These commands are 
also accessible from the BMDS application's Edit menu. 

You can use these commands to transfer data to and from spreadsheet 
applications such as Excel and Lotus. 

Selecting multiple sequential cells 

Multiple cells can be copied or pasted at the same time. 

 Using the mouse: Click and drag to highlight the selected cells you want to 
copy or cut. 

 Using the mouse and keyboard: Click on the first cell to select it. Press the 
Shift key and then click on the last cell to select all the cells. 

Copying and pasting multiple cells of data 

This technique enables you to copy or paste the same data file reference into 
multiple cells much more quickly than you could by doing so one at a time. This 
technique lets you to set the same data file for multiple models all at once. You 
could, for example, highlight five cells containing a data file reference, click on 
the first blank cell in a series, and then paste to insert the five references. 

Note  The amount of information you can paste is constrained by the number of 
empty cells. If only 3 cells are empty, and you have copied 10 cells, then 
only the three empty cells receive the pasted information. 
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1. Select a cell that has the data file reference you want to copy, and press 
CTRL-C or select Edit>Copy. 

 

2. Select the blank cells that will receive the copied data file value. 

 

3. Press CTRL-V or select Edit>Paste to paste the data file value into the 
selected cells. 
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RENAMING COLUMNS 

Data Grids are initially created with names in the form of Col1, Col2, Col3, and so 
on. You can rename columns in the Data Grid window to provide more 
meaningful names describing the data. 

However, if you rename Data Grid's column labels, you must also revise the 
template option files in the BMDS session file so that BMDS can recognize the 
new column label. If you do not revise the template option files, then BMDS will 
not run the dataset with the revised column labels. 

Column headers must be one word with no spaces. 

1. Right-click on a column title to display a popup menu. 

2. Select Rename Column. The Rename dialog box appears. 

 

3. Enter a one-word title with no spaces. Valid column titles can include 
InterCapitaliZation, Punc.Tua.Tion, or Hy-Phens. 

4. Select the Save and Exit button. 

TRANSFORMING A COLUMN OF DATA 

You can create a new data column in the Data Grid window by performing a 
mathematical operation on existing data fields. 

1. In the Data Grid window, right-click on the column title. 



Benchmark Dose Software (BMDS) User Guide  Using BMDS 2.6.0.1 

BMDS version: 2.6.0.1 Page 49 of 310 Release Date: February 12, 2016 

2. Select Transform Column form the popup menu. The Variable 
Transformation dialog box appears. 

 

3. Select an operation from the Transformation dropdown menu. Depending 
on the transformation, enter extra information as required. For example, 
for “SE to Standard Deviation,” specify the Data Grid column that holds 
the standard error value and the column that holds the value for Subjects 
in Dose Group. Or, for “Raise Column to Power X,” enter the column to be 
transformed and then the “X” value. 

4. Click OK. The transformed data will appear in the designated column. 

See also: 

Data Transformation Types 

DATA TRANSFORMATION TYPES 

When you transform an existing data column in the Data Grid window, you direct 
BMDS to run a mathematical operation on the data to create a column of new 
data. 

Not all transformations are valid for any possible data values. In general, you 
should be aware of what constitutes valid inputs for all of the 
transformations. Be cautious when using the transformations if the goal is to 
derive valid numeric inputs for subsequent modeling. 

You can direct BMDS to perform any of the following transformations. 

Log Base 10 of a single column 

This option will return the Log() base 10 of all values in the selected column. 

Log Base e (Natural Log) of a single column 

This option will return the Log() base e of all values in the selected column. 



Benchmark Dose Software (BMDS) User Guide  Using BMDS 2.6.0.1 

BMDS version: 2.6.0.1 Page 50 of 310 Release Date: February 12, 2016 

Note Be aware that not all transformations are valid for any possible data 
values. In particular, logarithmic transformations (log10 or natural log) of 
non-positive values will result in non-numeric values.  
 
If you attempt a logarithmic transformation of 0 (which may occur 
when transforming the dose variable, when a control, or 0-valued, dose 
group is included), BMDS displays the result “-Infinity” for the transformed 
0 value. This is consistent with the fact that the limit of log(x) is negative 
infinity as x approaches 0.  
 
If you attempt a logarithmic transformation of a negative number, 
then BMDS displays the result “NaN,” indicating that the result is “not a 
number.”  
 
Both “-Infinity” and “NaN” are not numeric values and should not be used 
as input for dose-response modeling; errors will occur if this is attempted. 

Exponential Base 10 of a single column 

This option will return 10 to the x where x is the value in the column for each 
row in that particular column. 

Exponential Base e of a single column 

This option will return e to the x where x is the value in the column for each 
row in that particular column. 

Raise column to Power X 

This option will raise each value in a column to a specified Power x, where x 
is a user specified number. 

Multiply column by constant X 

This option will multiply each value in a column by a specified constant x, 
where x is a user specified number. 

Add two columns 

This option will return the value of one column added to the value of a second 
column for each row in that particular column. 

Subtract two columns 

This option will return the value of one column minus the value of a second 
column for each row in that particular column. 

Multiply two columns 

This option will return the value of one column multiplied by the value of a 
second column for each row in that particular column. 
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Divide two columns 

This option will return the value of one column divided by the value of a 
second column for each row in that particular column. 

Quantilize column 

This option will return either a 0 or a 1 for all rows based on whether the value 
in the selected column is Larger or Smaller than a user specified value. If the 
selected adverse direction is “Larger,” a 0 will be returned for values lower 
and a 1 will be returned for values larger than the user specified value. If the 
selected adverse direction is “Smaller,” a 1 will be returned for values lower 
and a 0 will be returned for values larger than the user specified value. 

Add X to column 

This option will add a constant X to each value in a column, where x is a user 
specified number. 

SE to Standard Deviation (SD) 

This option will convert standard errors (SE) from a designated column to 
standard deviations and place them in a designated SD column. The user 
must also designate the column that contains the number of subjects in each 
dose group as that value (n) is used in the calculation. 

See also: 

Transforming a Column of Data 

DEFINING MODEL OPTIONS AND DATASET VARIABLES 

After you click the Data Grid window's Proceed button, BMDS displays the 
Model Option Screen. 

BMDS will display the Model Option Screen appropriate to the model chosen on 
the Data Grid window. The following screenshot shows the Model Option Screen 
for the NLogistic Nested Dichotomous model. 
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From this option screen, the user assigns columns in the dataset to the required 
variables and selects the model options (e.g., parameter constraints and BMRF 
values). When these choices are complete, click the Run button to complete the 
analysis of the selected dataset. 

All of the variables required for a model must be linked to a column in the 
spreadsheet. Variables required for running BMDS on a dataset will differ 
according to the Model Type selected; these variables appear in the “Column 
Assignments” section of the Model Option Screen for the chosen model.  

Table 21 describes the required variables for each model type.  
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Table 21: Required variables for BMDS model types 

Model Types Required Variables 

Dichotomous and  
Dichotomous_Alternative 

 Dose 

 # Subjects in Dose Group 

 Incidence or % Positive 

Continuous If response data are reported by dose group, 
then the following columns in the Data Grid 
must be identified: 

 Dose 

 # Subjects in Dose Group 

 Mean 

 Standard Deviation 

If response data are reported for each 
individual animal, then the following columns 
must be identified: 

 Dose 

 Response 

Nested  Dose 

 Litter Specific Covariate 

 Incidence 

 Litter Size 

The Model Option Screens and analysis requirements for a 
Rptd_Resp_Measures, or Conc x Time model are somewhat different and are 
discussed elsewhere in this documentation. 

The following sections describe the variables mentioned above in more detail. 

Dose 

Variable representing the amount of a substance an experimental subject 
consumes (e.g., oral drinking water or food studies), is injected with (e.g., 
gavage or intravenous injection studies), or is exposed to (e.g., inhalation 
studies). For inhalation studies, this column would represent the 
concentration of the substance in the air being inhaled. Most of the time Dose 
will be an independent variable under the control of the experimenter. 
However, for epidemiological studies Dose, as well as confounding factors 
such as age, smoking habits and duration of exposure, are not under the 
control of the experimenter and may be different for each individual 
responder. While BMDS allows for the entry and analysis of individual Dose 
information, provisions for factoring the impact of confounders have not as yet 
been incorporated. 
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#Subjects in Dose Group 

Independent variable representing the total number of subjects within a dose 
group for which a continuous Response is measured or dichotomous 
Incidence is identified. 

Incidence 

Dependent variable used for Dichotomous and Nested Models to represent 
the number of subjects within a Dose group responding in a positive, 
generally considered adverse, manner. 

% Positive 

Dependent variable used for Dichotomous Models to represent the percent of 
the total number of subjects within a Dose group that responded positively. 
The data for this column must be entered as a percent, not a fraction. 

Mean 

Dependent variable used for Continuous Models to represent the average 
response within a group (sum of all responses in group divided by 
Subjects/Group). 

Standard Deviation 

The positive square root of the variance for a Dose group, which is the sum of 
the squared deviations of the individual responses from the mean, divided by 
# Subjects in Dose Group-1. 

Response 

This dependent variable refers to the individual continuous data responses by 
subject. If this variable is used, the Subjects/Group, Mean and Standard 
Deviation continuous data variables are not used and are grayed out. 

Litter Size 

Number of live pups per litter. 

Litter Specific Covariate 

This is a covariate such as body weight of dams, number of implants or litter 
size that is felt to best explain response variability between litters. It is used in 
the nested models to try to account for that variability. See Nested Model 
Descriptions for more details. 

See also: 

Appendix B: Model Options Screen Fields Reference 
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ADDING AND DELETING DATA GRID COLUMNS AND ROWS 

You can add columns and rows to, and delete rows from, Session Grids and 
Data Grids. 

You can delete columns from Data Grids only. 

Note  When all of the cells in a column/row are empty the column/row is 
removed when the dataset is saved. However, if a column/row contains 
any data at all, the column/row is retained when the dataset is saved. 

 

 To insert a row above the currently selected row, select Data Grid>Insert 
Row. 

 To delete the currently selected row, select Data Grid>Delete Row. 

 To add multiple rows above the currently selected row, select Data Grid, pick 
a predefined number of rows to add from the picklist (1, 2, 5, 10, 50, or 100), 
and click Add Row(s). 

 To insert a column to the left of the currently selected column, select Data 
Grid>Insert Column. In the Set Name dialog box, enter a name for the new 
column and click Save and Exit. 

 To delete the currently selected column, select Data Grid>Delete Column. 

 To insert multiple columns, select Data Grid, pick a predefined number of 
columns from the picklist (1, 2, 5, or 10), click Add Column(s), enter titles for 
the new columns in the Set Name dialog box, and click Save and Exit. The 
new columns are added to the rightmost side of the Data Grid window. 

See also: 

 Working with the Menus, Tool Bars, & Status Bars 

 Adding and Deleting Session Grid Rows 
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CHANGING THE DEFAULT NUMBER OF ROWS AND COLUMNS 

The BMDS Data Grid windows default to 1000 rows and 50 columns. These 
defaults are easily changed. 

1. From the BMDS application window, select Tools>Preferences, and 
select Data Grid to display its Preferences dialog box. 

 

2. Enter new values in the appropriate fields. 

3. Click OK. 

RUNNING TREND TESTS 

When the user opens a dataset (or creates a new dataset and fills in the body of 
that new file), and if that dataset is identified as appropriate for a Dichotomous or 
Dichotomous_Alternative Model Type (the Model Type is selected to be 
Dichotomous or Dichotomous_Alternative), the Trend Test button (upper right 
corner of the Data Grid window) becomes active. 
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Clicking the Trend Test button implements a Cochran-Armitage trend test (cf. 
Haseman, 1984, “Statistical Issues in the Design, Analysis and Interpretation of 
Animal Carcinogenicity Studies”, Environmental Health Perspectives, 58, p. 385). 
That test is used to determine if there appears to be a dose-related trend in 
response. 

If the user has selected a dataset with the default column headers (Dose, N, 
Effect), then the Trend Test screen that appears (as shown below) will show the 
calculated test statistic value (z) and the associated p-value. This can be verified 
by observing that the time-date stamp on the trend test screen is the current time 
and date. The user can select other column headers for the dose, sample size 
(N), and/or effect variable and run the test again by clicking the Run Test button. 

 

If the columns headers in the dataset are not Dose, N, and Effect (i.e., if BMDS 
cannot find any one of those column headers in the dataset), then the trend test 
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will NOT be automatically implemented; the user MUST enter the appropriate 
column headers in the trend test screen and click the Run Test button. 

For interpretation, a p-value that is small (e.g., less than 0.05) indicates the 
presence of a dose-related trend. 

SORTING DATA 

In the Data Grid window, left-click on a column header to sort the dataset by that 
column's values. Click again to toggle between ascending order and descending 
order for the sort. 

An up-pointing triangle in a column indicates that its values are sorted ascending; 
a down-pointing triangle indicates a descending sort order. 

You must save the dataset to retain the sort order. 

Note  Sorts only work with numeric data and non-empty cells. Enter a zero in an 
empty cell to ensure proper sorting. 

EXPORTING DATA 

Using BMDS, you can export a dataset to delimited text files that can be imported 
into other applications for further analysis. 

1. With a dataset loaded, from the Data Grid menubar select File>Export 
Data To and select one of the following options: 

 Tab-delimited text file (*.txt) 

 Space-delimited text file (*.txt) 

 Comma-separated values text file (*.csv) 

2. In the Save As dialog box, specify a file name and location for the export 
file and select Save. 

SAVING A DATASET 

The dataset's file name is shown in the Data Grid's title bar, as shown below. If 
you opened the dataset from within a Session Grid window, then the filename in 
the Data Grid's title bar should match the filename in the Session Grid's Data File 
column. 
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Newly created data sets are initially assigned a default name of “Untitled.” 

If a model is run on a dataset before it is saved to another name, the results of 
the model run are saved to the root directory of the BMDS program. 

It is recommended that you save datasets to a unique directory. The Data 
subdirectory within the BMDS program directory is usually a good location for 
consolidating your BMDS data files. 

Saving changes to the current dataset 

From the Data Grid's File menu, select Save Dataset. BMDS will save any 
changes to the dataset file name that is displayed in the Data Grid's title bar. 

Saving a dataset to a different name and directory location 

1. From the Data Grid's File menu, select “Save Dataset As . . .” 

2. The Save As dialog box displays. Enter a new file name in the File Name 
field. 

3. The Save As dialog box defaults to the Data subdirectory of the BMDS 
program directory. If you want to save the file to a different location, 
navigate to that location and click Save. 

4. BMDS saves the new file as a BMDS dataset with a .dax extension. 

Note  For result files (such as .out and .plt) from model runs on a single dataset 
(not when run from a session), BMDS prefixes the dataset's file name and 
saves the files to the same directory as the .dax file. 
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WORKING WITH THE MODEL OPTION SCREEN 

When you click the Proceed button on the Data Grid window, the Model Option 
screen is displayed. The Model Option screen lets users change options 
available for a model run. 

When BMDS is initially run or when the Set Values to Defaults button is 
selected, all options are set to their default values. Options chosen and saved to 
an Option file with the “.opt” extension are retained for later use. 

 

Each Model Option screen contains features that are unique to the model being 
run. However, all Model Option screens share the following common features: 
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Model Type and Name 

The status bar In the lower left corner of the Model Option screen displays the 
name of the specific model being employed and the model type 
(Dichotomous, Continuous, Nested, Dichotomous Alternative, or Repeated 
Response Measures). 

User Notes field 

This is an editable field of up to 80 characters in length. The content of this 
field will be displayed in a single line of text under the date in the *.out file. 

Data File field 

A field displaying the name of the data file (*.dax) file. 

Out File Name field 

Displays the output path and file name. Click the Set button to change the file 
name and/or location. 

Column Assignments section 

This section allows the user to assign columns from the data file to the 
parameters that are required for model runs. 

Optimizer Assignments section 

This section specifies information controlling the determination of 
convergence of the model runs. In general, you can safely leave these 
settings at their default values. 

 Iteration: An upper limit to the number of iterations that will be used in the 
optimizations (default = 250). 

 Relative Function: This specifies the criterion for ascertaining relative 
function convergence (default = 1.0e-8) 

 Parameter Function: This specifies the criterion for ascertaining parameter 
convergence (default = 1.0e-8) 

Parameter Assignments section 

The user can choose one of three options related to parameter values: 

 Default option: the initial estimated value for a parameter is determined by 
the program and its value will vary during optimizations. 

 Specified option: the initial value for a parameter is as specified by the 
user and its value will remain at that specified value during all 
optimizations. 

 Initialized option: the initial estimated value for a parameter is entered by 
the user but its value will vary during optimizations. If the Initialized 
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option is checked for any parameter, the user must choose the 
Specified or Initialized option for all parameters. 

Other Assignments section 

This section contains information on parameter constraints and choices for 
BMD and BMDL calculations. All models contain the following fields in the 
Other Assignments section. 

 BMD Calculation: Specifies whether or not the user wants a BMD (with 
associated BMDL) calculated. 

 BMDL Curve Calc: When this option is selected, the graph resulting from 
the model run will display a blue BMDL curve. The BMDL curve is 
estimated by calculating the BMDL for BMDs at BMRs of 1, 5, 10, 20 and 
30%, and connecting these points via either a straight line or a curve. The 
calculation of the BMDL curve has been known to cause some 
convergence problems and can significantly increase computer run time, 
particularly if several models are being run in a session. Thus, the current 
default and recommended option is to not request calculation of the BMDL 
curve unless absolutely necessary (the BMDL for the requested BMRF will 
still be estimated and displayed in the output file regardless of the choice 
for this option). 

 Confidence Level: The confidence level (default 0.95) associated with the 
BMDL calculation. Confidence level must be a number >0 and <1. 

 BMRF: The factor defining the benchmark response level. Its value will 
depend on the Risk Type or BMR Type specified by the user (one of these 
types will also be in the Other Assignments section, depending on the 
model type). 

Other Buttons 

 Save. Save the current Model Option settings to an .opt file. 

 Save As …Save the current options under a different file name. 

 Set Values to Defaults. Return values to their defaults for the selected 
model. 

 Optimize Initial Param. Values. 

 Run. Run the model using the current option settings. 

 Close. Close the Model Option screen. 

See also: 

Using Session and Option File Templates 
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DICHOTOMOUS AND DICHOTOMOUS_ALTERNATIVE MODEL 
OPTION SCREENS 

All of the common options described in Working with the Model Option Screen 
are available on the Model Option screen for Dichotomous and 
Dichotomous_Alternative models. In addition, the options described in this 
section are available in all Option screens for dichotomous models. 

 

Dose Groups 

This is a read-only field indicating the number of Dose groups recorded from 
the dataset file for input into the model. 
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Risk Type 

Choices are “Extra” (Default) or “Added.” Added risk is the additional 
proportion of total animals that respond in the presence of the dose, or the 
predicted probability of response at dose d, P(d), minus the predicted 
probability of response in the absence of exposure, P(0). Extra risk is the 
additional risk divided by the predicted proportion of animals that will not 
respond in the absence of exposure, 1—P(0). The BMRF for all dichotomous 
models must be between 0 and 1 (not inclusive). 

Note about BMRF and Graphs 

The response associated with the BMR that is displayed in the graphical 
model output will only be the same as the BMR when P(0) = 0. This is 
because to obtain the actual response value one must solve for P(d) in the 
equation for added or extra risk discussed above. In addition to the two 
options listed above for all dichotomous models, the following options are 
available for specific models of the Dichotomous or Dichotomous_Alternative 
Type. 

Restrict Slope >= 1 

Models: LogLogistic, Log-Probit, Dichotomous-Hill 

Selecting this feature (Default for LogLogistic and Dichotomous Hill models) 
restricts the slope parameter (β) to a value of 1 or greater. For the LogLogistic 
and Dichotomous Hill models, if β < 1, the slope of the dose-response curve 
becomes infinite at the control dose. For the LogProbit and LogProbit-BgDose 
models, the slope of the dose-response curve can be very steep at low doses 
at or below the BMD or BMDL, before it becomes smaller approaching zero 
dose. Such characteristics, for all four models, may be biologically unrealistic, 
and can lead to numerical problems. 

Restrict Power >= 1 

Models: Gamma , Weibull 

Selecting this feature (Default) restricts the power parameter (α) to a value of 
1 or greater. If α < 1, then the slope of the dose-response curve becomes 
infinite at the control dose. This may be biologically unrealistic, and can lead 
to numerical problems when computing confidence limits, so EPA 
recommends restricting α >= 1 

Degree of Polynomial 

Models: Multistage, Multistage-Cancer 

This is the degree of the polynomial model that will be used, or the number of 
times dose is factored into the model equation (maximum = 23). A value must 
be entered here before the model will run. Polynomial degree should not 
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exceed the number of dose groups unless the beta coefficients of the model 
are specified or restricted (beta coefficients are always restricted in the 
multistage-cancer model). 

Restrict Betas >= 0 

Models: Multistage 

Selecting this feature (Default) restricts all of the beta (β) parameter 
coefficients in the multistage model to a value of 0 or greater. 

See also: 

 Dichotomous Model Options Fields 

 Dichotomous_Alternative Model Options Fields 

 Dichotomous Model Descriptions 

 Dichotomous Models—Text Output 

CONTINUOUS MODEL OPTION SCREENS 

All of the common options described in Working with the Model Option Screen 
are available on the Model Option screen for Continuous models. In addition, the 
options discussed in this section are available in all Model Option screens for 
Continuous models. 
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Constant Variance 

When selected (Default), the model assumes a constant variance across all 
dose groups. If not selected, then the model assumes that the variance can 
be different for each dose group, and varies as a power function of the mean 
response (see Continuous Model Descriptions for more details). 

Adverse Direction 

Choices for the Adverse Direction option are “Automatic,” (Default), “Up” or 
“Down.” This option refers to whether adversity increases as the dose-
response curve rises “up” or falls “down.” If automatic is chosen, the software 
chooses the adverse direction based on the shape of the dose-response 
curve. Manually choose the adverse direction if you know the direction of 
adversity for the endpoint being studied. This selection only impacts how the 
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user-designated BMR is used in conjunction with model results to obtain the 
BMD. 

BMR Type 

The BMR type is the method of choice for defining the response level used to 
derive the benchmark dose (BMD). The choices allowed are “Rel. Dev.” 
(Default), “Abs. Dev.,” “Std. Dev.,” “Point” and “Extra” (Hill model only). 

Rel. Dev. (Relative Deviation) means the response associated with the BMR 
will be the background estimate plus or minus (depending on the Adverse 
Direction) the product of the background estimate times the BMRF entered by 
the user. 

Abs. Dev. (Absolute Deviation) means the response associated with the 
BMR will be the background estimate plus or minus the BMRF. 

Std. Dev. (Standard Deviation) means the response associated with the 
BMR will be the background estimate plus or minus the product of the BMRF 
times the standard deviation for the control group data. 

Point means the response associated with the BMR will be the BMRF value 
itself. 

Extra (Hill only) means the response associated with the BMR will be the 
background estimate plus or minus the product of the BMRF times the 
difference between the background estimate and the model estimate of the 
maximum/minimum response. “Extra” is similar to Extra risk for dichotomous 
data, except that the maximum (or minimum) achievable response is not 1, 
but is estimated from the model. 

Rel. Dev.Response = m(0) + (BMRF* m(0)) (Default) 

Abs. Dev.Response = m(0) + BMRF 

Std. Dev.Response = m(0) + (BMRF*STD) 

Point Response = BMRF 

Extra (Hill and some exponential models only) 

for “up” Response = m(0) + (BMRF*(mmax—m(0))) 

for “down” Response = m(0)—(BMRF*( m(0)—mmin)) 

where m(0) is the mean response when exposure equals zero, STD is the 
standard deviation when exposure equals zero, mmax is the maximum 
predicted mean from the Hill or exponential model, and mmin is the minimum 
predicted mean from the Hill or exponential model. 
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Note When response data is lognormally distributed, the BMR Types acquire 
different meanings. As of BMDS 2.6.0.1, only continuous exponential 
models can assume lognormal distribution. For more information, refer to 
Unique Options for Exponential Models. 

In addition to the three options listed above for all continuous models, the 
following options are available for specific continuous models. 

Degree Poly 

Models: Linear, Polynomial 

This is the degree of the polynomial model that will be used, or the number of 
times dose is factored into the model equation (maximum = 21). A value must 
be entered here before the model will run. Polynomial degree should not 
exceed the number of dose groups unless the beta coefficients of the model 
are restricted. For the linear model, this field is set to 1 and is not editable. 

Restrict Power >= 1 

Models: Power, Exponential 

The power parameter can be restricted to be greater than or equal to one. 
The power is unrestricted if this option is not selected. This option is currently 
disabled for the exponential models. 

Restrict n > 1 

Model: Hill 

The n parameter of the Hill model can be restricted to be greater than one. 
The n parameter is unrestricted if this option is not selected. 

Restriction 

Linear, Polynomial 

Restrictions on coefficients of the dose terms can be “None” (Default), “Non-
negative” (>0), or “Non-positive” (<0). Note that, while no restrictions (None) 
is the current default for this option, the user should specify that the 
parameters be restricted to either Non-negative or Non-positive values 
whenever possible to avoid “wavy” model responses (see details in 
Polynomial Model description). Since there is only one dose coefficient in the 
continuous Linear model, this is sometimes referred to as restricting the slope 
of this model. 

BMDL Curve Calculation 

Linear, Polynomial, Power 
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When this option is selected, the graph resulting from the model run will 
display a blue BMDL curve. The BMDL curve is estimated by calculating the 
BMDL for BMDs at BMRs of 1, 5, 10, 20 and 30%, and connecting these 
points via either a straight line or a curve. The calculation of the BMDL curve 
has been known to cause some convergence problems and can significantly 
increase computer run time, particularly if several models are being run in a 
session. Thus, the current default and recommended option is to not 
request calculation of the BMDL curve unless absolutely necessary (the 
BMDL for the requested BMRF will still be estimated and displayed in the 
output file regardless of the choice for this option). 

See also: 

 Continuous Model Options Fields 

 Continuous Models—Descriptions 

 Continuous Models—Text Output 

 Unique Options for Exponential Models 

Unique Options for Exponential Models 

The exponential model choice actually allows the user to run up to four models 
that have exponential-dose terms. These models are referred to as exponential 
Models 2–5 (following a designation by Dr. Wout Slob, wherein the restricted 
(flat) model was model 1). Refer to the section on Exponential Continuous Model 
Description for additional details. 

The user may choose to run any or all of the exponential models when running 
from a Session screen. (When running on a single dataset by use of the data 
grid, all exponential models will be run.) 

Moreover, the user may select to have the exponential model runs reported 
(grouped) together in one output file or on separate output files. These choices 
are made in the Model Selection section of the exponential model option screen: 
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Other options unique to the exponential model option screen are as follows: 

Distribution: The user may choose to assume that the data are normally or 
lognormally distributed around the dose-group-specific means. The choice of 
the distribution affects that type of MLE solution that may be obtained (see 
next option). Moreover, when a lognormal distribution is assumed, only 
constant (log-scale) variance models will be fit to the data; such models 
correspond to an assumption of a constant coefficient of variation. 
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Solution: The user may choose to get an exact or approximate MLE solution. 
When the data are assumed to be normally distributed, the choice is fixed at 
“Exact” because the exact solution is available no matter how the data are 
presented (either as group-specific means and variances or as individual 
responses). When the data are assumed to be lognormally distributed and the 
data are presented in terms of group-specific means and standard deviations, 
then the exact MLE solution can not be obtained. In that case, the “Solution” 
option is fixed at “Approximate” and the means and standard deviations of the 
log-transformed data are estimated as follows: 

log-scale mean = ln(mean)—ln(1+(std/mean)2)/2 

log-scale std = sqrt[ln(1+(std/mean)2)] 

When the data are assumed to be lognormally distributed and the individual 
responses are available the user may choose between the exact and 
approximate solutions. In this case, the user is advised to select the exact 
solution; the only reason to select the approximate solution in this case would 
be to compare it to other calculations that were done approximately out of 
necessity. 

Also note that in the “Parameter Assignments” section, each model has a 
separate tab to allow model-specific parameter designations (the default, 
specified, and initialized options discussed above). 

Definition of BMR Types under Lognormal Distribution Assumption 

The Exponential models allow the user to assume that the response data are 
lognormally distributed, with median values defined by the dose-response 
function and a constant log-scale variance. Under such an assumption the BMR 
types are defined and implemented so that they are calculated by the program to 
return BMDs as follows (where BMRF is the numerical value, specified by the 
user, indicating the response, or change in response, of interest): 

Relative Deviation: The natural scale median value at the BMD, m(BMD), 
differs from the natural scale median at 0 dose, m(0), such that |m(BMD)—
m(0)|/m(0) = BMRF. 

Absolute Deviation: The natural scale median value at the BMD, m(BMD), 
differs from the natural scale median at 0 dose, m(0), such that |m(BMD)—
m(0)| = BMRF. 

Standard deviation: The log-scale mean at the BMD, ln(m(BMD)), differs 
from the log-scale mean at 0 dose, ln(m(0)), such that |ln(m(BMD))—

ln(m(0))|/(0) = BMRF, where σ(0) is the log-scale standard deviation at 0 

dose. Recall that (0) = ln(GSD(0)). This definition allows the user to use 
BMRF’s typical of an analysis where a normal distribution of responses is 
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assumed (e.g., the EPA default of 1 standard deviation) and still maintain the 
logic and rationale for such choices, since the log-transformed response 
values under the lognormal assumption would themselves be normally 
distributed. 

Point: The natural scale median value at the BMD, m(BMD), equals the 
BMRF, i.e., m(BMD) = BMRF. 

See also: 

 Continuous Exponential Model Options Fields 

 Continuous Models—Descriptions 

 Continuous Models—Text Output 

 Exponential Continuous Models—Description 

NESTED MODEL OPTION SCREEN 

All of the common options described in Working with the Model Option Screen 
are available on the Model Option screen for Nested models. In addition, the 
options discussed in this section are available in all Model Option screens for 
Nested models. 

Note that in the “Column Assignments” section, the parameter “Litter Size” 
replaced “#Subjects in Group” from earlier BMDS versions. Also, an additional 
parameter, “Litter Specific Covariate,” has been added. These designations 
reflect the primary use of the nested models, i.e., for modeling data from 
reproductive or developmental assays in which the number of responders within 
litters of certain sizes are recorded. 

The options described in the rest of this section are available in all Option 
screens for nested models. 
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Risk Type 

Choices are “Extra” or “Added.” Additional risk is the additional proportion of 
total animals that respond in the presence of the dose, or the probability of 
response at dose d, P(d), minus the probability of response in the absence of 
exposure, P(0). Extra risk is the additional risk divided by the proportion of 
animals that will not respond in the absence of exposure, 1—P(0). Thus, extra 
and additional risk are equal when background rate is zero. 
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Fixed Litter Size 

Choices are “Control Group Mean” (Default) or “Overall Mean.” See Nested 
Model Descriptions for an explanation as to why this option is necessary, and 
which choice would be preferred for your given dataset. Basically, if the Litter 
Specific Covariate is not affected by dose, the Overall Mean should be used. 
If the Litter Specific Covariate is affected by dose, consider using the Control 
Group Mean. 

Litter Specific Covariate 

Provides user with the option to allow the models to attempt to account for a 
litter specific covariate or not. If “Use Litter Specific Covariate” is selected 
(Default), all of the Theta values are estimated . If “Don't Use Litter Specific 
Covariate” is chosen, all of the Theta values are set to zero. 

Intralitter Correlations 

Provides user with the option to allow the models to attempt to estimate 
intralitter correlations or assume they are zero. If “Estimate Intralitter 
Correlations” is selected (Default), all of the Phi values are estimated (one for 
each dose group). If “Assume Intralitter Correlations Zero” is chosen, all of the 
Phi values are set to zero. 

Dose Groups 

This is a read-only field indicating the number of Dose groups recorded from 
the dataset file for input into the model. 

Restrict Power >=1 

Power parameter can be restricted to be > 1 (Default) 

Bootstrap Iterations 

Specify the number of bootstrap iterations (default is 1000) to run to estimate 
goodness of fit. It is recommended to keep the value at a minimum of 1000. 

Specify Bootstrap Seed 

Select this feature to specify a bootstrap seed for the random number 
generator. Default is that BMDS auto-generates a seed for the random 
number generator based on the system clock. 

Seed (Hexadecimal Value) 

If Specify Bootstrap Seed is selected, enter the value here in hexadecimal 
form. Example: “1E240”. 

See also: 

 Nested Model Options Fields 
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 Nested Models—Descriptions 

 Nested Models—Text Output 

REPEATED RESPONSE MEASURES OPTION SCREEN 

After a dataset has been created and saved with a name that is not “Untitled,” the 
user can initiate a repeated response measures analysis. 

From the Data Grid window's Model Type field, select “Rptd_Resp_Measures” 
from the dropdown list and click Proceed. Note that currently ToxicoDiffusion is 
the only model of this type, so no model selection needs to be done. The 
ToxicoDiffusion model includes graphical outputs showing the observed and 
model-predicted time-course data, residuals, and a summary of the bootstrap-
based BMDL calculations. 

An example dataset for use with the Repeated Response Measures model is 
shown in the following figure: 

 

The data for such an analysis will consist of one or more measurements from any 
given experimental unit (animal) at different times before or after the exposure. 
Thus, the dataset must include a column that identifies which animal the 
observations come from (the “ID” column in the above figure). Even though it is 
assumed that each animal is exposed to only one dose level, each row of data 
must include the dose value; the column assignment for that dose value is 
specified as shown above. The time of each observation (row) must be given (the 
“time” column) and the value of the response at that time must be recorded (in 
the “fore.grip” column). You will specify these columns in the Option Screen's 
Column Assignments section. 

Clicking on Proceed opens a special Option Screen specifically designed to 
facilitate modeling with the Repeated Response Measures model: 



Benchmark Dose Software (BMDS) User Guide  Using BMDS 2.6.0.1 

BMDS version: 2.6.0.1 Page 76 of 310 Release Date: February 12, 2016 

 

This Option Screen is very similar to that for other BMDS models, so the 
following information will focus on its unique aspects. 
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Plotting Assignments 

Identify the properties of the resulting graphs here. 

Parameter Assignments 

This section allows the user to either: 

 Enable the program to find initial values for the optimization runs (the 
default values of “-9999” shown in the option screen are merely flags to 
pass to the input file that indicate this default option—they are not real 
initial values), or 

 Initialize the parameter values to values of the user's choice (the “Initialize” 
option). Currently, the Repeated Response Measures model does not 
allow users to specify values of the model parameters. 

Other Assignments 

This section lets the user define other important components for the analysis. 
The time at which exposure occurs (time zero in many experiments) must be 
specified. So too must the user specify the background degree, which is an 
integer between 0 and 2 that determines how the responses are assumed to 
vary over time in the absence of exposure. This background (without-
exposure) variation is defined by a polynomial of the specified degree 
(constant, linear, or quadratic for the choices 0, 1, or 2, respectively). 

Adverse responses can be defined in one of two ways. Either a background 
rate of adverse response is specified (e.g., a 5% rate of adverse response in 
the absence of exposure) or cut-off value(s) can be specified, with the 
assumption that values above or below (depending on the adverse direction) 
the cut-off(s) are adverse. The background rate of response need only be 
defined of the definition is in terms of background rate (probability) of 
response; the cut-off(s) need only be defined if the definition is in terms of cut 
point(s). 

“Other Assignments” also allows the user to specify the number of bootstrap 
iterations to run to estimate confidence bounds. As shown in the example 
screen above, those bounds can be one-sided or (if the “Use Two Sided CI?” 
box is checked) two-sided. 

The number of bootstrap iterations should be large enough to provide a stable 
estimate of the bounds. The Bootstrap Iteration value shown above (100) is 
almost certainly too low for a final, stable estimate of those bounds. Values on 
the order of 100 or more will probably be required in most cases; the user 
should perhaps do several runs to determine that the bound estimates have 
stabilized for the number of iterations chosen. Increasing the number of 
iterations will noticeably increase the time it takes to run the model. 
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Note  For “Confidence Level” the user must actually enter a p value such that 
the level of confidence is (1-p)*100%. For example, in the example screen 
above, the “Confidence Level” field has the value 0.05. This corresponds 
to requesting 95% confidence limits: (1—0.05)*100% = 95%. 

Study Description 

Here, the user can supply any additional experiment-specific information that 
s/he wished to have reported in the output files. 

Running the model 

Once all the options have been specified as desired, clicking the Run button 
will initiate the repeated measures analysis. The run will produce a set of five 
graphs that will flash momentarily on the screen. When the run is complete, 
the full set of five plots will be available in a summary plot screen. The 
individual plots can be copied and pasted into other files (such as a Word 
document file). 

See also: 

 Repeated Response Measures Model Options Fields 

 Repeated Response Measures Model Text Output 

 Repeated Response Measures Model Description 

CONCENTRATION X TIME MODEL OPTION SCREEN 

The option screen for analysis of Concentration x Time (CxT) data is a bit 
different from the option screens for other BMDS models, reflecting differences in 
the types of analyses they implement. 
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When first opened the only portion filled in is the top of the Option Screen, which 
displays the data from the dataset that was used to open this screen (along with 
the file path for the saved dataset). This top portion is for display of information 
only; it cannot be edited from this screen. Any changes to the data must be made 
on the Data Grid window, from which this option screen was created. 

The data should include a variable corresponding to the number of subjects in 
each group (“Exposed” in this example) and the incidence in each group (“Dead” 
in this example). When the user fills in those two choices in the Column 
Assignments section of the screen, the remaining column names will 
automatically appear as possible explanatory variables (Explanatory Var1, etc.): 
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Currently, there is a limit of five possible explanatory variables. There must be at 
least two possible explanatory variables to run the Concentration x Time model; if 
there is only one possible explanatory variable, the user does not need the 
Conc_x_Time model—a standard dose-response model for dichotomous data 
(Dichotomous or Dichotomous_Alternative model types) will suffice. 

One way (typically, the primary way) for a possible explanatory variable to be 
included in the model is as a main effect (it enters the model as a “stand-alone” 
independent variable. For a possible explanatory variable to be used as a main 
effect, the box under the “Main Effect” column must be checked for that particular 
explanatory variable. Not all of the possible explanatory variables need be 
included in the model as main effects. 

After selecting the explanatory variables to be included as main effects, the user 
can then define up to 3 product terms to be included in the model. Note that 
explanatory variables included as main effects need not be in the product terms, 
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and conversely, the product terms need not be restricted to explanatory variables 
included as main effects. One example is shown in the following screenshot: 

 

Note that explanatory variables 1 and 2 are selected as main effects (but variable 
3 is not). Also note that a product term is being selected for inclusion in the 
model; this product term consists of variable 2 (a main effect) and variable 3 (not 
a main effect). Therefore, this model would contain 2 main effects and 1 product 
term. 

The variables can be used as is or they can be transformed. The transformations 
currently available are the logarithmic (y = Ln(x)) and the reciprocal (y = 1/x) 
transformations. Whatever transformation is chosen will be used everywhere that 
variable occurs in the specified model (main effect and any product terms). The 
three transformation choices are accessed for each variable from the drop down 
list in the “Transform.” column to the right of the variable name. 

A logit or a probit model may be selected as the basis for the concentration-time 
modeling from the drop down menu for the “Model” field just below the Column 
Assignments: 
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In the above screen shot, note that there is a (disabled) option for a background 
correction. Because that option is disabled, all Concentration x Time models 
currently run in BMDS will not have a background response correction. 

The user has the option of specifying the name of the output file that will contain 
the results of the run. A name can be selected by clicking on the “ . . .” button to 
the right of the grayed out “Out File” name field. DO NOT enter a name in that 
grayed out field. Click the “ . . .” button and a window will appear showing the 
contents of the last file where BMDS files were accessed (the Data folder under 
BMDS if you have just opened BMDS). Navigate from there to the place you 
want to save the output file, and enter a name of your choice in the “File name” 
field of that window. That name and its associated path will then appear in the 
option screen “Out File” field. REMEMBER, as always in BMDS, the output file 
name (and the folders in the path to it) should NOT have spaces in the name. 

At this point, the model can be run to completion and parameter estimates 
obtained. This would suffice to allow estimation of all parameters needed for 
generating plots (via the Excel tool that implements two graphing options; see 
Graphic Output from Models in this documentation for more information). 
However, if the user wants more information reported in the model output file, 
additional selections can be made as described below. 

The user may specify what additional types of estimates are desired; there are 
three choices as indicated in this screenshot of the lower portion of the CxT 
option screen (any or all of the choices may be selected): 
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Note that in the above screen shot, much of the lower portion of the option 
screen is inactive (grayed out) because, at this point, no additional calculations 
have been requested. 

The three options for additional calculations are discussed in the following 
sections. 

Options for Additional Calculations 

 Option 1—Calculate Dose for Given Response 

 Option 2—Calculated Response for Given Explanatory Variables 

 Option 3—Ratio of Parameters for Two Explanatory Variables 

See also: 

 Concentration x Time Data 

 Concentration x Time Model Description 

 Concentration x Time Model Text Output 

Option 1—Calculate Dose for Given Response 

A BMD type of calculation would correspond to the choice “Calculate Dose for 
Given Response” where the user specifies a response level (as a percent strictly 
between 0 and 100, e.g., 95 as in this example) and then requests the value for 
one of the explanatory variables included in the model (usually dose or 
concentration) when the other explanatory variables are set to specific values. To 
obtain such estimates, check the box (by clicking on it) in the “Calculations 
Desired?” row for the “Calculate Dose for Given Response” column. 

Note  When that box is checked, the Run button will no longer be active (it will 
be grayed out) because the user needs to provide additional information in 
the “Calculated Dose” section in order for the calculation to succeed. (The 
same is true when the other options for additional calculations discussed 
below are requested.)  
 
Also (here and in the following two options for additional calculations), the 
fields in which the user specifies the input needed for the requested 
calculations will be grayed out until and unless the corresponding 
“Calculations Desired?” box is checked. 
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The following screenshot shows how to access the variable choices for the 
required fields (that have not become active because the “Calculations Desired?” 
box is checked) via the drop down lists in the “Calculated Dose” section: 

 

In this case, the model will calculate what concentration of exposure will result in 
a 10% response when time = 60 minutes and body weight = 220 grams. 

Note  The estimates provided in the output will not be valid unless all 
explanatory variables used in the model (as main effects or in one or more 
product terms) are listed either in the row “Find Corr. Value For” (the 
variable one wants to calculate) or have been set to a value in one (and 
only one) of the “When” rows. 

The “Std. Deviation for Confidence Interval” can be determined from Table 22. 
Note that this approach was used here because one might often be using a value 
from a t-distribution rather than a normal distribution. Refer to Concentration x 
Time model for additional information. 
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Table 22: Deviates corresponding to confidence levels of interest for confidence interval 
estimation (from standard normal distribution) 

α Confidence Level Deviate 

0.2 80% 1.282 

0.1 90% 1.645 

0.05 95% 1.960 

0.01 99% 2.576 

The user can determine the deviate to use for other confidence levels of interest 
from a table of quantiles of a standard normal distribution, available in many 
elementary statistics books (or s/he may compute them using Microsoft Excel 
function “NORMSINV” and putting in (1-?/2) as the argument to that function 
when interest is in the 100*(1-?) confidence interval). 

Option 2—Calculated Response for Given Explanatory Variables 

The user can also calculate the response level expected when all of the 
explanatory variables (the ones included as main effects or in product terms) are 
at specified values; s/he does so by choosing “Calc. Response for Given Exp 
Vars” (i.e., by checking the box in the “Calculations Desired” row under that 
column). In the following screenshot, the user has requested that the output 
report the probability of response when exposure is to 1000 ppm, for 60 minutes, 
for an animal weighing 225 g. 
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The std deviation to input when confidence interval calculations are requested 
are the same as above for the “Calculate Dose” request. 

Note  The estimates provided in the output will not be valid unless each 
explanatory variable used in the model (as main effects or in one or more 
product terms) is listed and given a value in one (and only one) of the 
“When” rows in the “Calculated Response” section of the screen. 

Option 3—Ratio of Parameters for Two Explanatory Variables 

Finally, the user may calculate the ratio of the parameters of two main effects by 
choosing “Ratio of Parameters for Two Exp. Vars”. This ratio is often considered 
when concentration and time are logarithmically transformed, as a measure of 
“n,” which is the slope of the response contours on the Ln(conc)-Ln(time) plots. 

As in the previous two requests for additional calculations, the user indicates that 
such estimates are desired by checking the box in the “Calculations Desired?” 
row in the “Ratio of Parameters for Two Exp. Vars” column. Then the cells 
corresponding to the remaining required fields will no longer be grayed out and 
values must be entered for all such fields in order to run the model. 

The following screenshot shows that the user has requested the ratio of the 
coefficients for Conc_mg_Per_m3 and Minutes. 

 

The above example also shows how to access the parameters for desired main 
effects via the drop down lists. Those lists will only include variables that have 
been included in the model as main effects. 
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The choices of std deviation for confidence interval calculations are the same as 
for the “Calculated Dose” options. 

Warning  
In this example, and any other example where product terms involving 
either concentration or time are included in the model, the ratio of the 
parameters for the main effects of concentration and time will not have the 
interpretation given above (i.e., it will not be the slope of the contours on a 
log-log plot), even if the logarithmic transformation has been chosen for 
those variables. In fact, with product (interaction) terms, those contours 
would, in general, not be straight lines. 

Once a Concentration x Time modeling option screen has been completed, it 
may be saved using the “Save” or “Save As . . .” buttons on the screen. The 
extension for a Concentration x Time model run is “.ten” and should be used for 
all such saves. If the user wants to revisit a saved Concentration x Time model 
analysis, the “Open” option under the File menu item can be used to do so (see 
How to Use BMDS/Concentration x Time Data). 

WORKING WITH SESSION AND OPTION FILE TEMPLATES 

Versions 2.1 and higher of BMDS come with templates for sessions and option 
files that the user may find helpful for facilitating the creation of sessions suitable 
for analyzing his or her data. The user can “swap in” any data (.dax) file for use 
with these templates as long as the data file is structured correctly. 

The following sections describe those templates and the types of analyses for 
which they may be most useful. 

In the SessionFiles folder (located at C:\Usepa\BMDS230\Data\SessionFiles for 
BMDS 2.3.1), the user will find several templates with the following naming 
convention: 

XXX[-other descriptive information].ssn 

Within that convention, XXX is one of the following: 

XXX = Dichotomous, 
Cancer, 
Continuous, 
NestedSample, or 
Dichotomous_AlternativeSample 

corresponding to the 5 main categories of dose-response models included in 
BMDS (excluding Concentration x Time models and Repeated Response 
Measures models, which differ in that they are designed for analyses of multiple 
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explanatory variables or multiple observed responses per experimental unit, 
respectively). 

The second part of the template naming conventions, “-other descriptive 
information,” describes more specific characteristics of the templates, as 
explained in the next sections 

DICHOTOMOUS MODEL SESSION TEMPLATES 

The templates for the Dichotomous model sessions include every dichotomous 
model, including the Dichotomous Hill model, but excluding the multistage-cancer 
model (because it is a special case of the multistage model and is included in its 
own templates—see the “Cancer” template description below) and all the 
Dichotomous_Alternative models (which also have their own template). The 
template names for the Dichotomous models include two further identifiers and 
so have the form Dichotomous-YYY-ZZZ.ssn. 

The “YYY” part of the name specifies the BMR level. For example, “BMR01” 
designates that all the model options for that session are set up to estimate the 
BMD and BMDL corresponding to 1% extra risk. Templates with “BMR05” and 
“BMR10” are set up to calculate BMDs and BMDLs corresponding to 5% and 
10% extra risk, respectively. 

The “ZZZ” part of the name is either “Restrict” or “Unrestrict” and specifies 
whether estimated parameters in the models (e.g., slope, power or polynomial 
coefficients) are restricted or unrestricted, respectively. In some instances, the 
restrictions avoid numerical computation problems. In all but one case where the 
option to restrict exists, restricting model parameters is the EPA default 
approach. This typically keeps the estimated models from assuming biologically 
unrealistic patterns (e.g., such as infinite slopes for very low doses or 
nonmonotonicity). The one exception is the LogProbit model, which has a slope 
parameter that can become very steep, but does not approach infinity, at very 
low doses. 

Note  For this reason, a risk assessor should report the results of an unrestricted 
LogProbit model run along with the results from a session of restricted 
models. 

CANCER MODEL SESSION TEMPLATES 

The templates available for running a session on a cancer endpoint have the 
naming convention “Cancer-BMRxx.ssn.” The “xx” is one of “01,” “05,” or “10,” 
indicating that the BMD and its bounds are calculated for extra risks of 1%, 5% or 
10%, respectively. 
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There are no restrictions to specify with the cancer model because, by definition, 
the multistage-cancer model has the coefficients restricted to be non-negative. 
These sessions fit the multistage cancer model with three different polynomial 
degrees (first degree through third degree). 

There is a session template named “Cancer-AlternativeSample.ssn” that fits the 
multistage-cancer-BgDose (background dose) model to a dataset. Like the 
“Cancer-BMRxx.ssn” templates, it fits a first degree, second degree, and third 
degree polynomial model to a dataset. The BMR is set to 10% extra risk. 

CONTINUOUS MODEL SESSION TEMPLATES 

There are several templates that are set up to run all of the continuous models in 
BMDS. The templates available for running a session of continuous models 
designate not only the definition of the BMR and restrictions, but also the form of 
the variance model and the direction of the change in mean response. In two 
instances, the names indicate that the data are entered in the form of individual 
responses (a value recorded for each experimental unit) as opposed to the more 
typical summary data (means and standard deviations) that are assumed for all 
the other templates. 

Thus, as an example, the session template 

Continuous-ModelVariance-BMR1Std-Up-Restrict.ssn 

specifies that all the models will be run with modeled variance (the other 
alternative is constant variance), with a BMR defined as a change in the mean 
equal to 1 (control group) standard deviation, with the assumption that the means 
are increasing as a function of dose, and with the parameters of the models 
restricted (when that applies for any given model). The template 

Continuous-ModelVariance-BMR1Std-Up-IndividualResponses-Restrict.ssn 

implements the same set of models with the same options, except that it would 
be used if the data were entered as individual (experimental-unit-specific) dose 
and response values. 

The other continuous model session templates allow estimation of the BMD 
corresponding to 10% or 5% change in the mean (“BMR10” or “BMR05” in the 
third part of the template name, respectively). There are also templates that 
accommodate data with decreasing means (“Down” in the fourth part of the 
name). 
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OTHER MODEL SESSION TEMPLATES 

The NestedSample.ssn and Dichotomous_AlternativeSample.ssn templates are 
set up to run all models within the type specified (Nested or 
Dichotomous_Alternative, respectively) on dataset(s) that the user may specify. 
As “sample files,” there are no variations with respect to restrictions or BMR 
definitions. All the option files used in those sessions restrict parameters (when 
that is relevant to the model in question) and calculate BMDs and BMDLs 
corresponding to 10% extra risk. The user may create sessions implementing 
other options (e.g., with respect to restrictions or BMR level) by making changes 
to the option files, analogous to the way in which the Dichotomous model 
template variations were defined above and modifying the Option files as 
described next. 

OPTION FILE TEMPLATES 

The session templates described above implement the options that are 
associated with them (e.g., BMR level) through specifications of the model 
options in the Option Files that are included in those session templates. The 
Option File templates are found in the “OptionFiles” folder in the “Data” folder 
within the folder in which BMDS was installed. 

Like the session templates, the Option File templates have names reflecting the 
options that have been selected. But, because the Option Files are model-
specific, the templates for the Option Files begin with a three-letter abbreviation 
designating the model to which the Option File corresponds. The list of model 
abbreviations can be found on the Model Abbreviations page. 

Thus, the Option file template names begin with the three-letter abbreviation 
appropriate to the model under consideration in lieu of the model type that begins 
the session template names. The other parts of the Option File template names 
correspond to the choices listed above for the session template names, 
specifying choices for the BMR, restriction of the parameters, variance model, 
etc. For example, the template 

Dhl-BMR10-Restrict.opt 

is for the dichotomous Hill model (“dhl” is the abbreviation for that model), with 
the benchmark response level set to 10 percent extra risk, and with the slope 
restricted (to be greater than or equal to 1 in the case of the dichotomous Hill 
model). It is one of the option files used in the Dichotomous-BMR10-Restrict.ssn 
template (i.e., the option file for the dichotomous Hill model run in that session). 
Similarly, 

Pow-ModelVariance-BMR05-Restrict.opt 
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is for the continuous Power model (“pow” is the abbreviation for that model), with 
the variances modeled, the benchmark response level set to 5% change in the 
mean, and the power parameter restricted to be greater than 1. 

USING THE TEMPLATES 

The user may use the templates as the basis for quickly setting up sessions to 
run some standard types of analyses. For example, if s/he wishes to run all the 
dichotomous models on some (dichotomous) noncancer endpoint, using the EPA 
defaults, s/he would open 

Dichotomous-BMR10-Restrict.ssn. 

Then s/he would choose or create the dataset of interest and change the entry in 
each row under the “Data File” column of the session screen so that that entry 
has the name of the dataset of interest. 

ALIGNING VARIABLE NAMES WITH DATA GRID COLUMN NAMES 

The Option File templates for Dichotomous, Dichotomous_Alternative, and 
Continuous model types are set up with standardized variable names for each 
model. If the user creates or uses a dataset with the following Data Grid column 
headers for each of those variables, then it is not necessary to edit the option 
files in the session templates. 

The default column headers for the variables used in the BMDS models are 
described in . 

Table 23: Default column headers for model variables 

Model Variable Column Header 

Dose (independent variable) Dose 

# Subjects in Dose Group (sample size) N 

Incidence (# responders) Effect [dichotomous models] 

Mean Mean [continuous models] 

Standard Deviation Std [continuous models] 

Individual Response Response [continuous models] 

It is also important to note that if other variable names (column headers) are 
used in the dataset or column headers renamed in the Data Grid, then the 
Option files will have to be edited (see Step 4: Specify Model Parameters) so 
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that the column assignments section of the Option screen shows the correct 
names (column headers). 

See also: 

 Step 3: Create or Import a Dataset 

 Step 4: Specify Model Parameters 

 Renaming Columns 

 Model Option Screens 

 Model Abbreviations 

WORKING WITH REPORTS AND OUTPUT 

After you have specified all the pre-requisites (models, data, parameters) for a 
session run, click the Run button in the bottom left of the Session Grid window. 
The Session Grid's status bar will display a “Please wait processing . . .” 
message and a progress bar as BMDS calculates the results. 

A result consists of a plotted graph for the model plus its Out File data display. 
The following screenshot shows an example of an individual graph and Out File 
data display. 
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You can choose whether to display each model's report and graph individually or 
to group them into Summary Reports and Summary Graphs windows. If you 
include several models in your session run, then viewing each model's run 
individually can lead to stacked windows, as shown in the following example. 
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Using the summary windows, you can review multiple results more easily from a 
single window display. The Summary Report Window collects the results into a 
single tabular format, while the Summary Graphs Window collects the graphs 
into a single window. 

SETTING REPORT PREFERENCES 

1. From the BMDS menu bar, select Tools>Preferences …>Report to display 
the following dialog box:  
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2. Choose from the options described in Table 24. 

Table 24: Report Preferences options  

Option Description 

Summary Report A checkmark to the right of this option (default) indicates a summary 
report and summary plots will be displayed after a session run. 

If unchecked, the summary report is not generated and plots are 
displayed in separate windows. 

Group By This option determines how session run results (summary reports 
and summary plots) are grouped together. Results can be grouped 
by end points (default) or by the data file name 

WORKING WITH THE SUMMARY REPORT WINDOW 

If the “Summary Report” option has been selected under the Tools > Options 
menu, the results will be displayed in two new windows: a textual Summary 
Report and a Summary Graph. 

The Summary Report window displays the variables set for each of the models 
run in a tabular format. Each lettered column corresponds to the models 
previously added in the Session Grid window. 
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Right-click in any lettered column to display a context menu with the options 
described in Table 25. 

Table 25: Summary Report Window context options  

Option Description 

Show Out/Graph Display individual graphs and Out File data for the selected 
model. 

Display Array  
Values 

To display array values, right-click on a cell containing the word 
“Array.” The following screenshot shows an example of an 
array values window. 

 

Open Data File Display the data file linked to the displayed results.  

Open Option File Display the option file linked to the displayed results.  

EXPORT SELECTED SUMMARY REPORT ROWS TO EXCEL 

If you want to perform more detailed analysis on specific results displayed in the 
Summary Report Window, you can easily export those rows to Excel. 

The Summary Report window pre-selects some rows for export, which you can 
easily change. 

Export to Excel can export results for sessions containing any number of models. 

1. In the Summary Report window, check the boxes in the Export to Excel? 
column to select those rows for export. 

2. From the Summary Report window's menu bar, select File>Export to 
Excel. 

An Excel window will open, create individual tabbed worksheets within a new 
Excel workbook, and enter and format the data. The new workbook contains 
data only from the rows selected. 

Individual worksheet tabs include Plots, Inputs+Estimates+Scaled Res., and 
other tabs, depending on the model type. 
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SUMMARY GRAPHS WINDOW 

The Summary Graphs window displays graphs corresponding to each model run. 
Right-click on individual graphs to copy them to the clipboard; you can then paste 
them into other files, such as Microsoft Word documents. 

 

VIEWING OUTPUT (.OUT) FILES 

The text output file has the extension “*.out”. Out files are saved to the BMDS 
application directory's Data subdirectory (for example, BMDS240\Data). 

The Out file is a simple text file you can open using Notepad or BMDS. 
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Displaying the output file 

1. From the BMDS menu bar, select Tools>View Output File …BMDS 
displays in the Open dialog box all the .out files in the Data subdirectory. 

2. Locate and select the .out file you wish to view and click Open. The Out 
File is displayed in the BMDS text window. 

 

VIEWING PLOTS 

The plot (*.plt) file that serves as the basis for the graph is located in the BMDS 
Data subdirectory (for example, BMDS240\Data). The .plt file will have the same 
filename as the *.emf and *.out files in the output window. 

So, for example, the *.plt file for pro_Dax_Setting.emf, would be 
pro_Dax_Setting.plt. 

Plot files are displayed using GnuPlot, an open-source application included as 
part of the BMDS install package. 
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Displaying plots 

1. From the BMDS menu bar, select Tools>View Plot File …BMDS displays 
in the Open dialog box all the .plt files in the Data subdirectory. 

2. Locate and select the .plt file you wish to view and click Open. The plot is 
displayed as a GnuPlot graph in its own window. 

 

 The BMD and BMDL are identified on the plot as black vertical lines and 
are associated with the response level associated with the user-selected 
BMR, the horizontal black line. 

 The BMD curve estimated by the model is represented by a red line. 

 Data points are shown in green with their individual group confidence 
intervals. 

See Also: 

Using GnuPlot 

USING GNUPLOT 

BMDS includes GnuPlot as part of the standard installation. GnuPlot is an open-
source, command-line driven graphing utility that can run on multiple operating 
systems. GnuPlot offers many editing and customization features you may find 
useful when transforming the plots for use in reports or other media. 

You can modify the graphic display features by using either GnuPlot’s edit 
features or copying the plot to the Windows clipboard and pasting it into another 
application capable of performing vector graphic editing (e.g., Microsoft 
PowerPoint). 
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You can access copy and edit features in GnuPlot by left-clicking on the small 
graphic icon at the top of the plot page or right-clicking on the graph. A menu will 
appear with options to modify the plot window in various ways. 

Among the options available are: 

 Copying to the clipboard 

 Changing the background color 

 Specifying different colors, line styles (solid, dash, line widths, etc.), and fonts 

 Specifying printing options, such as landscape or portrait 

For more information, please refer to the GnuPlot homepage. 

KEEPING BMDS UP TO DATE 

After you start BMDS, and assuming your computer has an Internet connection, 
the software will check the BMDS server for any updates. You can change the 
frequency of this check using the Tools>Preferences>Update dialog box: 

 

From this dialog box, you can select whether BMDS checks for a new update: 

 On startup 

 Weekly (the default) 

 Monthly 

You can also choose to manually check for updates by selecting Never and 
clicking the Check for updates now button. 

Note that BMDS must be running so it can check for and notify you of an 
update. 

http://www.gnuplot.info/
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WHEN AN UPDATE IS READY FOR DOWNLOAD 

When BMDS detects that an update is ready to download, it will display the 
following dialog: 

 

You can choose the following options: 

 To download the update and install it yourself later (the default) 

 To have BMDS download and automatically install the update. The dialog 
shows the Update File Location where BMDS will download the new update 
file and the Install Directory where the new BMDS directory will be created if 
automatically installed. These fields are read-only and cannot be edited; 
BMDS enforces this information to ensure a stable installation process. 

 To not download the update 

If you choose to download and install the software yourself, you can follow the 
instructions described in the BMDS readme file included with the install package. 
The manual installation process is unchanged from previous BMDS releases. 
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If you choose to have BMDS automatically download and install the update, then 
BMDS displays the following information box after installation: 

 

Note that this automatic install process is done under your user account and 
does not require a system administrator. 

Tick the box and click OK to view the BMDS readme file. Your computer will 
need a PDF reader to view the readme file. 

TO USE THE NEWLY INSTALLED BMDS SOFTWARE 

Following an automatic installation, the older BMDS version does not shut down; 
it remains open. 

To use the newly installed BMDS software: 

1. Close the old BMDS version. 

2. Review the readme file to learn about new features, bug fixes, or other 
need-to-know items regarding the new software. 

3. Follow the instructions in the readme file to: 

 Create a shortcut for the new BMDS version on your desktop 

 Determine that the new BMDS version works properly on your computer 

 Fix possible issues with displaying the help file 
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MANAGING YOUR EXISTING MODEL INPUT AND OUTPUT FILES 
AFTER AN AUTOMATIC UPDATE 

 The automatic BMDS install does not replace or displace your existing model 
input and output files. Your old version of BMDS and related data files remain 
in their current locations. Data files do not have to be moved from their 
current folder locations to work with the new version of BMDS. Follow your 
organization’s guidelines for locating and maintaining data files. 

 Session files contain embedded path names that must be updated if data files 
are moved or copied (e.g., for backup purposes). Session files containing 
invalid data file or output folder locations will not run correctly. 

TROUBLESHOOTING 

HELP FILE DOES NOT DISPLAY 

Some users have reported that clicking or double-clicking on a Help topic 
generates the message “Navigation to the web page was canceled.” 

Solution: change the security permission for the help file—BMDS*.chm—to “Full 
Control.” If you're unable to change the permission, then you will need to work 
with someone who has Administrator rights to make this change. 

To change the permission: 

1. Right-click on the BMDS*.CHM file in Windows Explorer and select 
“Properties” from the context menu. The Properties dialog box appears. 

2. Click the “Security” tab. 

3. In the Permissions box at the bottom, click to place a check mark in the 
“Allow” column for “Full control.” 

DECIMAL AND THOUSANDS SEPARATORS IN BMDS 

BMDS 2.6 supports regional settings for the decimal separator in the user 
interface and in spreadsheets created by the Export to Excel function. 

However, you should be aware of BMDS's treatment and presentation of decimal 
separators and thousands (or “digits”) separators in the user interface and in data 
files: 

 No “thousands separator” (regardless of regional setting) can be used in the 
data; that is, one thousand can only be written as 1000 rather than as 1,000. 
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 Files generated by BMDS (such as the .out files and .d files) will still show a 
period (“.”) as the decimal. 

 The Data Grid will convert/display an opened .dax file from “.” or “,” as the 
decimal separator to the specified decimal separator set by the Control 
Panel's Region and Language settings. 

 The Model Options screens will display and read values using the specified 
decimal separator. 

AVOID USING WINDOWS-RESERVED CHARACTERS IN FILE AND 
PATH NAMES 

BMDS allows any character, except for Windows reserved characters, to be used 
when naming files or directories that BMDS will access. 

However, the following Windows reserved characters are still disallowed and 
cannot be used: 

< (less than) 

> (greater than) 

| (vertical bar or pipe) 

? (question mark) 

* (asterisk) 

“ (double quote) 

Note The backslash (\) should be used when specifying network drive paths. 

PATH+FILENAMES SHOULD NOT EXCEED 255 CHARACTERS 

The combination of path and filename for BMDS data and output files cannot 
exceed 255 characters. 

BMDS can be installed either locally (on your workstation) or on a network drive. 

A local path is structured in the following order: drive letter, colon (:), backslash 
(\), and name components separated by backslashes. The total of all those 
characters should not exceed 255.  
Example: C:\usepa\BMDS260 

The path for UNC (network) path names can be structured as: 
\\ComputerName\ShareName\Path. The total of all those characters should not 
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exceed 255.  
Example: \\FileSrv1\Users\JDoe\USEPA\BMDS260 

When path names exceed the 255-character limit, BMDS may experience such 
problems as being unable to open a document, run a model, or terminate 
unexpectedly. 

Workarounds include shortening the name of the file or one or more directories 
containing the file, or moving the file to a directory with a shorter path. 

REQUEST SUPPORT WITH ETICKET 

For any technical problem related to running BMDS, please select Help>BMDS 
Support. This will display the eTicket site in your default web browser, where 
you can request help, ask a question, or check on the status of an existing issue. 

http://bmds.epa.gov/eticket/
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BMDS BEST PRACTICES 

The following sections describe various procedures or processes that will make 
your BMDS sessions more productive, accurate, and reliable for obtaining 
optimal model convergence. 

OPTIMIZATION CRITERIA 

The default optimization criteria (Relative Function Convergence and Parameter 
Convergence) are set to 1e-8, meaning that successful convergence is 
determined if the relative change in the function value and the change in the 
parameter values from one iteration to the next are less than 1e-8. It has been 
noted on a very few occasions that those criteria may not be adequate. 

So, when using BMDS, if you note a particularly poor model fit (especially when 
other models do seem to fit the data relatively well), you may want to try 
changing the convergence criteria to 1e-10. This is not guaranteed to solve the 
problem, nor is this option available for all models. If the option screen for the 
model in question has an “Optimizer Assignment” section, then the criteria can 
be modified. 

ALTERNATIVE DICHOTOMOUS MODELS 

A set of alternative dichotomous models (most of which are “background dose” 
models) is available to the user. 

When using BMDS, if the standard dichotomous models fail to provide an 
adequate description of the observed dose-response relationship, the user may 
want to explore the alternative models to see if any of them provide a satisfactory 
fit to the data. 

RE-INITIALIZING PARAMETERS 

BMDS models have internal logic for determining initial values for the parameter 
estimation. However, in some small fraction of cases, those calculated initial 
values may fail to provide an adequate starting point for the (global) maximization 
of the likelihood. 

If the user suspects that the reported maximum-likelihood estimation (MLE) 
results are not satisfactory (e.g., the fit of the model is not good, while other 
models or user-supplied parameter estimates for the model in question appear to 
describe the data much better), then the user may find it useful to provide initial 
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values. The user-supplied initial values will supersede the model calculated 
values. 

In fact, if the user wishes to try optimization from several starting (initial) points, 
then that would serve to enhance confidence in the results (if they all converge to 
the same MLEs). 

The user can initialize parameters using the options in the Parameter 
Assignments section of the model option screens, changing the “Default” choice, 
under “Options,” to “Initialized.” If one parameter is initialized, all parameters 
must be initialized. 

LOGNORMAL RESPONSE OPTION 

When modeling continuous response data, the standard assumption for the 
BMDS continuous models is that the underlying distributions (one for each dose 
group) are Normal, with a mean given by the dose-response model and a 
variance as specified by the user (constant or a function of the mean response). 
An alternative assumption is that the responses are Lognormally distributed. 

Currently, only the Exponential models allow the user to choose between Normal 
and Lognormal distribution assumptions. If the user has access to the individual 
response data, those data can be log-transformed prior to analysis. If the user 
suspects that the responses are Lognormally distributed, the best practice for 
now is to only use the Exponential models, with the Lognormal option for 
underlying distribution. The set of Exponential models covers a wide range of 
dose-response shapes and will be adequate in many modeling contexts. 

Using log-transformed responses in the analysis is not recommended, for 
the following reasons: 

 If you choose to log-transform the data prior to analysis, then the 
interpretation of the BMD and BMDL estimates would have to be considered 
carefully (and perhaps in consultation with a statistician). Data interpretation 
when using log-transformed responses will not be the same as when using 
the natural-scale response values. Indeed, the models—when “transformed 
back” to the natural scale—will not correspond to any of the standard BMDS 
models. 

For example, if using the power model on log-transformed responses, the 
user is actually implicitly modeling the medians (on the natural-scale) with the 

function exp{background + slope*dosepower} which is not a standard BMDS 

model and whose characteristics (e.g., exponential increases in response) 
may not be those desired by the user. 
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 Similarly, the interpretation of the BMD will not correspond to simple 
expressions (e.g., if the BMR is set equal to a relative deviation of 10%, that 
relative deviation will be assessed on the log-scale and so will not yield BMD 
or BMDL estimates that correspond to a 10% change in the original mean 
responses). 

For these reasons, log-transforming the response values is not considered a 
“best practice” and, as stated, should only be applied and interpreted with 
supporting statistical expertise. 

See also: 

Continuous Model Descriptions 
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OTHER DATA OR ANALYSIS TYPES 

REPEATED RESPONSE MEASURES 

After a dataset has been created and saved with a name that is not “Untitled,” the 
user can initiate a repeated response measures analysis. 

From the Data Grid window's Model Type field, select “Rptd_Resp_Measures” 
from the dropdown list and click Proceed. Note that currently ToxicoDiffusion is 
the only model of this type, so no model selection needs to be done. The 
ToxicoDiffusion model includes graphical outputs showing the observed and 
model-predicted time-course data, residuals, and a summary of the bootstrap-
based BMDL calculations. 

An example dataset for use with the Repeated Response Measures model is 
shown in the following figure: 

 

The data for such an analysis will consist of one or more measurements from any 
given experimental unit (animal) at different times before or after the exposure. 
Thus, the dataset must include a column that identifies which animal the 
observations come from (the “ID” column in the above figure). Even though it is 
assumed that each animal is exposed to only one dose level, each row of data 
must include the dose value; the column assignment for that dose value is 
specified as shown above. The time of each observation (row) must be given (the 
“time” column) and the value of the response at that time must be recorded (in 
the “fore.grip” column). You will specify these columns in the Option Screen's 
Column Assignments section. 
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Selecting Proceed opens a special Option Screen specifically designed to 
facilitate modeling with the Repeated Response Measures model: 

 

This Option Screen is very similar to that for other BMDS models, so the 
following information will focus on its unique aspects. 
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Plotting Assignments 

Identify the properties of the resulting graphs here. 

Parameter Assignments 

This section allows the user to either: 

 Enable the program to find initial values for the optimization runs (the 
default values of “-9999” shown in the option screen are merely flags to 
pass to the input file that indicate this default option—they are not real 
initial values), or 

 Initialize the parameter values to values of the user's choice (the “Initialize” 
option). Currently, the Repeated Response Measures model does not 
allow users to specify values of the model parameters. 

Other Assignments 

This section lets the user define other important components for the analysis. 
The time at which exposure occurs (time zero in many experiments) must be 
specified. So too must the user specify the background degree, which is an 
integer between 0 and 2 that determines how the responses are assumed to 
vary over time in the absence of exposure. This background (without-
exposure) variation is defined by a polynomial of the specified degree 
(constant, linear, or quadratic for the choices 0, 1, or 2, respectively). 

Adverse responses can be defined in one of two ways. Either a background 
rate of adverse response is specified (e.g., a 5% rate of adverse response in 
the absence of exposure) or cut-off value(s) can be specified, with the 
assumption that values above or below (depending on the adverse direction) 
the cut-off(s) are adverse. The background rate of response need only be 
defined of the definition is in terms of background rate (probability) of 
response; the cut-off(s) need only be defined if the definition is in terms of cut 
point(s). 

“Other Assignments” also allows the user to specify the number of bootstrap 
iterations to run to estimate confidence bounds. As shown in the example 
screen above, those bounds can be one-sided or (if the “Use Two Sided CI?” 
box is checked) two-sided. 

The number of bootstrap iterations should be large enough to provide a stable 
estimate of the bounds. The Bootstrap Iteration value shown above (100) is 
almost certainly too low for a final, stable estimate of those bounds. Values on 
the order of 100 or more will probably be required in most cases; the user 
should perhaps do several runs to determine that the bound estimates have 
stabilized for the number of iterations chosen. Increasing the number of 
iterations will noticeably increase the time it takes to run the model. 
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Note  For “Confidence Level” the user must actually enter a p value such that 
the level of confidence is (1-p)*100%. For example, in the example screen 
above, the “Confidence Level” field has the value 0.05. This corresponds 
to requesting 95% confidence limits: (1—0.05)*100% = 95%. 

Study Description 

Here, the user can supply any additional experiment-specific information that 
s/he wished to have reported in the output files. 

Running the model 

Once all the options have been specified as desired, clicking the Run button 
will initiate the repeated measures analysis. The run will produce a set of five 
graphs that will flash momentarily on the screen. When the run is complete, 
the full set of five plots will be available in a summary plot screen. The 
individual plots can be copied and pasted into other files (such as a Word 
document file). 

See also: 

 Repeated Response Measures Model Options Fields 

 Repeated Response Measures Model Text Output 

 Repeated Response Measures Model Description 

CONCENTRATION X TIME DATA 

The Concentration x Time Data model allows for fitting of dichotomous response 
data sets having two or more explanatory variables (as in acute inhalation toxicity 
experiments). The explanatory variables can be entered as main effects or in 
interaction (cross-product) terms. The user can request the value (and its 
bounds) of one explanatory variable when a response rate is specified (fixing the 
other explanatory variables at some user-specified values) and/or conversely, the 
value (and its bounds) of the response rate, given specification of all explanatory 
variables. 

To start an analysis of Concentration x Time (CxT) data, open a new Data Grid 
window and enter or import the data, as you would for any other new dataset. 

Once a dataset has been created and saved with a name that is not “Untitled,” 
you can initiate an analysis of the data by selecting the Model Type as 
“Conc_x_Time” and clicking the Proceed button. 

Note that currently there is only one model of this type (the so-called ten Berge 
model), which is selected by default. Of course, a previously saved dataset can 
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be opened as usual (from the File menu or using the Open Dataset toolbar 
button) and the Conc x Time model type selected, as described above. 

The following screenshot shows the tenBerge.dax dataset included with BMDS. 

 

For accurate results, please ensure the ten Berge dataset’s structure conforms to 
the following sequence. 

 The first columns in the dataset should be the Main Effect columns (e.g., 
Dose and Time). These columns can be in any order but they must appear 
first. 

 The final columns in the dataset should be the # Subjects and Incidence 
columns, in that order. 

 Other columns (e.g., Age, Litter) can appear in any order following the Main 
Effect columns but before the # Subjects and Incidence. 

Selecting the Proceed button will open a special Model Option Screen 
specifically designed to facilitate modeling data with the Concentration x Time 
model. 
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Details on the specification of the option screen choices and running the model 
are provided in the section on Concentration x Time Option Screen. 

The screenshot above shows that the Concentration x Time analysis that will be 
specified using the option screen can be saved (Save or Save As buttons). 

A Concentration x Time analysis is saved with a “.ten” extension on the name of 
the user's choice. That extension should be used with all Concentration x Time 
analyses, so that they can be located and recalled for later use. Saved 
Concentration x Time analyses can be accessed through the File menu: 



Benchmark Dose Software (BMDS) User Guide  Other Data or Analysis Types 

BMDS version: 2.6.0.1 Page 116 of 310 Release Date: February 12, 2016 

 

Currently, this is the only access to saved Concentration x Time analyses. 

See also: 

 Concentration x Time Option Screen 

 Concentration x Time Model Description 

MULTIPLE TUMOR ANALYSIS 

ASSUMPTIONS AND RESULTS 

The analyses of multiple tumors have the following assumptions and results. 

 The tumors are independent of one another. 

 A multistage model is an appropriate model for each of the tumors separately. 
(The individual multistage-cancer models fit to the individual tumors need not 
have the same degree, however.) 

 The user is interested in estimating the risk of getting one or more of the 
tumors being analyzed; the results indicate the BMD and BMDL associated 
with the user-defined benchmark response (BMR) level, where the BMD and 
BMDL are the maximum likelihood and lower bound estimates of the dose 
that is estimated to give an extra risk equal to the BMR for the “combination” 
(getting one or more of the tumors). 
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THE MULTIPLE TUMOR ANALYSIS SESSION SCREEN 

A multiple tumor analysis uses a session screen somewhat similar to that used to 
facilitate the analysis of a dataset using multiple models. An example of a 
multiple tumor analysis session screen is shown here: 

 

Note that in this case, there is no selection for Model Type (it is Dichotomous 
because the endpoints that are analyzed in these types of analyses are 
dichotomous, as in counts of animals with certain types of tumors). And there is 
no selection for Model Name; a Multiple Tumor Analysis will always run the 
Multistage-Cancer model (at present, only the Multistage-Cancer model is set up 
to analyze more than one dichotomous endpoint and combine the model fits to 
obtain a combined BMD and BMDL as described above). 

The Data File and the Option File selections are exactly the same as when 
running a regular dose-response session in BMDS. Note that the Option Screen 
will be the one associated with a Multistage-Cancer Model. The user should 
ensure that the degree of the polynomial and other selections for modeling 
parameters are as desired for the particular dataset(s) being analyzed. 

For example, if the user has previously analyzed a tumor using a 2nd degree 
model and found that to be the best choice for the tumor in question, s/he may 
want to set the degree of the polynomial for the analysis of the combination to the 
same degree—this can be ensured by using the same option file that was used, 
and saved, when the individual tumor was analyzed. In particular, the user 
should make sure that the risk levels (BMRs) selected in all the option files used 
in a multiple tumor analysis are the same and are at the level desired by the 
user. 

Rows can be added or deleted from the Multiple Tumor Analysis screen by 
selecting the corresponding choice from the screen's Tumor menu. 
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Note  There should be no empty or blank rows in the screen when the user 
clicks Run (e.g., no trailing empty rows at the bottom of the grid). Empty 
rows will cause the program to erroneously assume there is an additional 
tumor to be included in the analysis and result in an error. Empty rows can 
be eliminated by clicking on any cell in the row and then selecting 
Tumor>Delete from the screen's menu bar. 

OBTAINING THE COMBINED BMD 

Because of the form of the multistage-cancer model, the combined BMD is 
obtained in a relatively straightforward manner from the maximum likelihood 
parameter estimates from the models fit to the individual tumors. The combined 
maximum log-likelihood is the sum of the individual maximized likelihoods 
(summed over the individual tumor analyses). The combined BMD is the dose 
that is estimated to yield an extra risk of getting one or more of the tumors, where 
the extra risk is equal to the BMR. The calculation of the combined BMDL is a 
more complicated computation based on the profile-likelihood approach. As 
such, it gives the lowest value of the dose that satisfies the following conditions: 
there is a combination of parameters (across all models) for which the value of 
the BMDL gives a combined extra risk equal to the BMR and, using those 
parameter values, the combined log-likelihood is greater than or equal to a 
minimum log-likelihood defined by the maximum log-likelihood and the 
confidence level specified by the user (i.e., the parameters that give the desired 
extra risk when the dose is equal to the BMDL give a combined log-likelihood 
that is “close enough” to the maximum combined log-likelihood). 

SAVING SESSIONS 

Multiple Tumor Analysis sessions can be saved and opened at a later time (click 
the Save or Save As buttons at the bottom of the screen). 

RUNNING AN ANALYSIS AND VIEWING RESULTS 

Clicking the Run button will initiate the analysis and result in the creation of a 
single output file, the name and location of which can be set by the user by 
clicking Set To …  

That output file will include analysis results for each individual tumor considered 
by itself plus, at the end of the output, a short section that shows the estimated 
BMD and BMDL for the BMR and confidence levels specified by the user. No 
graphical output is produced; the plots for the individual multistage model runs 
can be obtained by running the individual tumors in a usual data analysis or from 
within a regular dose-response session. It is basically presumed here that the 
user has already run analyses of the individual tumors to identify the endpoints of 
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interest (and to determine the best form of the multistage-cancer model for those 
selected tumors) that then will be used for the combined analysis. Hence, no 
additional graphics are produced. 

TROUBLESHOOTING A TUMOR ANALYSIS 

If one or more of the tumors is estimated to have a BMD greater than three times 
the highest dose tested (for that tumor), then the multiple tumor analysis will stop 
at an intermediate point, i.e., after the fitting has been done for the tumor in 
question and the magnitude of that BMD has been determined. No tumors listed 
below that tumor will be analyzed and no combination will be completed. 

It is probably the case that the tumor in question will not add substantially to the 
estimation of a BMD for the combinations of tumors, assuming other tumors have 
BMDs less than three times the highest dose; that is because the magnitude of 
response for the tumor in question has not even reached the benchmark 
response level for such a high exposure and so its individual contribution to the 
risk of getting one or more of the tumors being analyzed will be small in 
comparison to that for the other tumors. The user might attempt a combination 
that does not include the tumor in question. 

The input file (.d file) for a multiple tumor analysis need not be edited by the user; 
the BMDS GUI automatically creates such a file to reflect the user specifications 
in the Analysis Session screen (see above). If such a file is examined, the user 
will see that it consists of a concatenation of t Multistage Dichotomous .d files 
(starting with the line that specifies the number of dose groups and the desired 
degree of the model), all specifying that the beta parameters are restricted to be 
greater than or equal to zero), where t is the number of tumors being combined. 
Preceding that concatenation will be three lines of text (which have no bearing on 
the model selections) and then a line that specifies the value of t. 

See also: 

 Multistage Model 

 Multistage Dichotomous Model Input File Format 

DATA WITH NEGATIVE MEANS 

Data with negative means should only be modeled with a constant variance 
model. 

It may occasionally be the case that, when modeling transformed data, you will 
need to model negative data. In this case, the transformation used should be a 
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variance-stabilizing transformation so that a constant-variance model would be 
appropriate. 

If a standard deviation-based BMR is used to define the BMD calculations, then a 
constant can be added to all the observations (or means) to make the values 
(means) positive. That will not change the standard deviations of the 
observations and would allow you to model the variance. 

TEST FOR COMBINING TWO DATA SETS FOR THE SAME 
ENDPOINT 

At this time, BMDS does not include a formal test for similarity of dose response 
across covariate values (e.g., across class variables like sex). 

However, the following procedure can be used if you have dose-response data 
for two experiments that you are considering combining (e.g., for the two sexes 
within a species, or two species, etc.). 

Test for combining two data sets for the same endpoint 

1. Choose a single model to consider for both runs. 

2. Model the two runs separately. For each run, record the following: 

 Maximum log-likelihood for each run. Add the numbers from each run 
to get the summed log-likelihood. 

 The number of unconstrained parameters for each run. Add the 
numbers from each run to get the summed unconstrained parameters. 

3. Combine the data from the two experiments and model them together. 
Record the following: 

 The maximum log-likelihood for the combined run. This will be the 
combined log-likelihood. 

 The number of unconstrained parameters for the combined run. This 
will be the combined unconstrained parameters. 

4. Subtract the combined log-likelihood from from the summed log-likelihood. 
Then, multiply the difference by 2. 

5. Compare the value from Step 4 to a chi-squared distribution. The degrees 
of freedom for that chi-squared distribution will be the difference between 
the summed unconstrained parameters (Step 2) and the combined 
unconstrained parameters (Step 3). 
 
If the value from Step 4 is in the tail (say, greater than the 95th percentile) 
of the chi-squared distribution in question, then reject the null hypothesis 
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that the two sets have the same dose-response relationship. If rejection 
occurs, then infer that it is not proper to combine the two data sets. 
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OUTPUT FROM MODELS 

TEXT OUTPUT FROM MODELS 

The purpose of the BMDS output pages is to provide the user with goodness-of-
fit criteria and model results to aid in determining the appropriateness of the 
subject model to the benchmark dose derivation. While BMDS will estimate 
parameters etc. for the user, it is the user's responsibility to interpret these results 
before making use of the BMDL. 

The BMDS model text output also provides information relevant to whether or not 
the function maximization problem was actually accomplished. That is, for each 
model, parameters are estimated using Maximum Likelihood procedures through 
an iterative routine. There is no guarantee that the model parameters will in fact 
achieve the true maximization, and by inspecting the output pages, the user 
should be able to obtain at least some idea as to whether or not it was achieved. 
While all models tend to follow a similar format, there are some differences in the 
output pages given by certain models. 

The output pages also give the user a quick verification of the options they had 
selected on the model option screen. For instance, when two users may be 
comparing results and obtained different answers, they may consult the output 
pages to make sure the settings were the same or if they had used the same (or 
most current) version of the software/models. 

See also: 

 Dichotomous Model Text Output 

 Continuous Model Text Output 

 Nested Model Text Output 

 Graphics Output from Models 

CONTINUOUS MODEL TEXT OUTPUT 

The continuous output file starts with a few explanatory lines that the user can 
reference quickly to check/verify the version number, the date and time of run, 
the input dataset used, that all the correct options were set, which model was 
used, the explicit form of the dose response function for the model run, and 
review basic data summaries (number of dose levels, etc). 

The output file is designed so that it will provide a reliable basis for reentering a 
BMDS dataset and accurately reproducing the results of a run (e.g., with an 
updated model) at a later date. The “form of the response function” is provided in 
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each model's text output file, and is the model function for which BMDS will 
estimate parameters in order to derive the Benchmark Dose. 

Default Initial Parameters: 

These are computer generated values that provide the starting point for the 
iterative maximization routine used by BMDS. This may give the user a basis 
for appropriate alternative initial parameter values should they want to rerun 
the program if a maximum wasn’t found, not believable, etc. 

Parameter Estimates: 

The parameter estimates are the actual estimates the program has found for 
the particular model run. This table includes both the estimates for the true 
parameter values as well as their estimated standard errors. The standard 
errors are given for two reasons: 

1. If standard errors are extraordinarily high, then the user may suspect that 
the probability function may not have reached a maximum, and they may 
want to use different starting points. There is not a guarantee if these are 
high that the function has not, in fact, been maximized. The user should 
use this in conjunction with other output to make a decision. 

2. To make inferences about the population parameters themselves. Under 
certain assumptions, the user may be able to formulate tests for the true 
value of the parameter. 

Asymptotic Correlation Matrix of Parameter Estimates 

This table provides the user with a matrix of correlation estimates between 
each of the parameters. Again, if these values seem to be high (in this case, 
very close to 1, in absolute value), there may have been a problem in the 
maximization. However, as stated before, high correlation does not confirm 
that the process of maximization did, in fact, fail. 

Note The parameter standard errors and the correlation matrix elements are 
based on a variance-covariance (VCV) matrix obtained by inverting the 
negative of the Hessian matrix (the Fisher-observed information matrix). 
That matrix is made up of second partial derivatives of the log-likelihood, 
with respect to the model parameters. For all the continuous models, the 
partials are derived using a finite difference approximation to those 
derivatives. 

Table of Data and Estimated Values of Interest 

This table gives a listing of the data as well as estimated means and standard 
deviations from the model. This is a good place for the user to look, along 
with the Tests of Fit and Maximum Likelihood below, to judge the 
appropriateness of the model. If a model fits well, the observed and estimated 
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means should be relatively close. The scaled residual values printed in the 
final column of the table are defined as follows: 

(Obs. Mean—Predicted Mean)/SE, 

where the Predicted Mean is from the model and SE equals the estimated 
standard deviation (square root of the estimated variance) divided by the 
square root of the sample size. 

The overall model should be called into question if the scaled residual value 
for any individual dose group, particularly a dose group close to the BMD 
estimate, is greater than 2 or less than -2. 

See also: 

 Text Output from Models—Introduction 

 Continuous Models Option Screens 

 Continuous Models—Description 

 Graphics Output from Models 

 Continuous Model Maximum Likelihood 

 Tests of Fit 

Continuous Model Maximum Likelihood 

The BMDS uses likelihood theory to estimate function parameters and ultimately 
to make inferences based on risk assessment data. Maximum likelihood is the 
process of estimating the model parameters; the likelihood function is as large as 
possible (maximized) given the form of the model under consideration and the 
data. In other words, parameter values are “chosen” such that the subject model 
(e.g., polynomial or power) obtains the best possible fit to the data, given the 
constraints of the model's parameter structure. For example, suppose one 
wishes to fit a second degree polynomial model with a constant variance to a 
dataset. The particular form of this model would be: 

Y = b0 + b1 * X + b2 * X^2 

The parameters we wish to estimate in this case would be b0, b1, and b2, as well 
as the constant variance parameter, call it Sigma^2. To estimate these 
parameters, BMDS uses maximum likelihood procedures, the end result being a 
vector of parameters that maximizes the likelihood function for the model 
specified. The “Log(likelihood)” value given on the BMDS output page is the 
maximum value of the natural logarithm of the likelihood function. Also note that 
there are an associated number of parameters for each likelihood calculated. The 
number of parameters reported for the model under consideration is the total 
number possible for the model minus any parameter estimates that have values 
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on the bounds set for their estimation (either bounds specified by the user or 
those inherent to the model). In the example above, if all 4 parameters were 
estimated, and did not equal a bound (e.g., did not equal 0 for the b parameters), 
the number of parameters reported for the fitted model likelihood is 4. 

The Akaike's Information Criterion (AIC) (Akaike, 1973; Linhart and Zucchini, 
1986; Stone, 1998) value given on the BMDS output page is -2L + 2p, where L is 
the log-likelihood at the maximum likelihood estimates for the parameters, and p 
is the number of model parameters estimated (and not on a boundary; see 
above). It can be used to compare different types of models which use a similar 
fitting method, as do all dichotomous, continuous and nested model types within 
BMDS. The model with the lowest AIC would be presumed to be the better model 
under this method. Although such methods are not exact, they can provide useful 
guidance in model selection. 

The BMDS output file gives five likelihood and AIC values that may be of interest 
to the user. These values are later used in asymptotic Chi-Square tests of fit. 
Each of these likelihood values represents a model a user may consider in the 
analysis of the data. The five models are described in Table 26. 

Table 26: Models Automatically Fit by BMDS 

Model Description 

A1: “Full” Constant Variance Model Y(i,j) = Mu(i) + e(i,j), 

Var{e(ij)} = Sigma^2 

A2: “Fullest” Model Y(i,j) = Mu(i) + e(i,j), 

Var{e(ij)} = Sigma(i)^2 

A3: “Full” Model with variance structure 
specified by the user 

Y(i,j) = Mu(i) + e(i,j), 

Var{e(ij)} = alpha*(Mu(i))^rho 

R: “Reduced” Model Y(i,j) = Mu + e(i,j), 

Var{e(i)} = Sigma^2 

Fitted Model The user-specified model 

Model A1 estimates separate and independent means for the observed dose 
groups (it is “full” or “saturated” in that respect) but posits a constant variance 
over those groups. 

Model A2 is the “fullest” model in that it estimates separate and independent 
means for the observed dose groups (as in Model A1) and it also estimates 
separate and independent variances for those groups. There is no assumed 
functional relationship among the means or among the variances across dose 
groups. This model is often referred to as the “saturated” model (it has as many 
mean and variance parameters as there are dose groups). The log-likelihood 
obtained for this model is the maximum attainable, for the data under 
consideration. 
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Model A3 is similar to model A2, and may only differ with respect to its variance 
parameters. Model A2 estimates separate and independent means for the 
observed dose groups (like A1). If the user specifies a constant variance for the 
fitted model, then model A3 will also assume that and it becomes identical to 
Model A1. If the user assumes a non-constant variance for the fitted model, then 
Model A3 will also assume the same functional form for the variance. 

The reduced model (R) is the model that implies no difference in mean or 
variance over the dose levels. In other words, it posits a constant mean response 
level with the same variance around that mean at every dose level. 

The last model, the fitted model, is the user-specified model (e.g., power or 
polynomial, among others). A user may have reason to believe that a certain 
model may describe the data well, and thus uses it to calculate the BMD and 
BMDL. 

See Tests of Fit for a description of how these models are used to test certain 
hypotheses about the data. 

See also: 

 Text Output from Models 

 Dichotomous Model Text Output 

 Continuous Model Text Output 

 Nested Model Text Output 

 Graphics Output from Models 

 Tests of Fit 

Tests of Fit 

The BMDS software provides four different Tests of Fit that the user may use to 
determine an appropriate model for fitting their data. These Tests of Fit are 
based on asymptotic theories of the likelihood ratio. Without getting too technical, 
the likelihood ratio is just the ratio of two likelihood values, many of which are 
given in the BMDS output. Statistical theory proves that -2*log(likelihood ratio) 
converges to a Chi-Square random variable as the sample size gets large and 
the number of dose levels gets large. These values can in turn be used to obtain 
approximate probabilities to make inferences about model fit. Chi-Square tables 
can be found in almost any statistical book. 

Each of the five models, described in the section on likelihood, has a likelihood 
value. The BMDS program uses these values to create ratios from two models 
that form a meaningful test. Suppose the user wishes to test two models, A and 
B, for fit. One assumption that is made for these tests is that model A is “nested 
within” Model B, i.e., that Model B can be simplified (via restriction of some 
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parameters in Model B) in such a way that the simplified model is Model A. This 
implies that Model A has fewer varying parameters. As an example, consider that 
the linear model is a “simpler” or “nested” model relative to the power model 
because the linear model has the power parameter restricted to be equal to 1. 

Note  The model with a higher number of parameters is always in the 
denominator of this ratio. 

Now, using the theory, -2*log{ L(A)/L(B)} approaches a Chi-Square random 
variable. This can be simplified by using the fact that the log of a ratio is equal to 
the difference of the logs, or simply put, 

-2*log{ L(A)/L(B)} = -2*( log{L(A)} - log{L(B)} ) = 2*log{L(B)} - 2*log{L(A)}. 

The likelihood values given by BMDS are in fact the log-likelihoods, log{L(B)} and 
log{L(A)}, so this likelihood ratio calculation becomes just a subtraction problem. 
This value can then in turn be compared to a Chi-Square random variable with a 
specified number of degrees of freedom. 

As mentioned in the section on likelihood, each log likelihood value has an 
associated number of parameters. The number of degrees of freedom for the 
Chi-Square test statistic is merely the difference between the two model 
parameter counts. In the mini-example above, suppose Model A has 5 fitted 
parameters, and that Model B has 8. In this case, the Chi-Square value you 
would compare this to would be a Chi-Square with 8-5 = 3 degrees of freedom. 

In the A vs B example, what is exactly being tested? In terms of hypotheses, it 
would be: 

H0: A models the data as well as B 

H1: B models the data better than A 

Keeping these tests in mind, suppose 2*log{L(B)} - 2*log{L(A)} = 4.89 based on 3 
degrees of freedom. Also, suppose the rejection criteria is a Chi-Square 
probability of less than .05. Looking on a Chi-Square table, 4.89 has a p-value 
somewhere between .10 and .25. In this case, H0 would not be rejected, and it 
would seem to be appropriate to model the data using Model A. BMDS 
automatically does the “table look-up” for the user, and provides the p-value 
associated with the calculated log-likelihood ratio having degrees of freedom as 
described above. 

The BMDS software provides four default tests. BMDS provides interpretation of 
the test results, based on p-values that have been selected by EPA. However, 
the computed p-values are presented so that the user is free to use any rejection 
criteria they want. Each of the four default tests provided for any of the 
continuous models is discussed in some detail below. 
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Test 1 (A2 vs R): Tests the null hypothesis that responses and variances 
don't differ among dose levels. If this test fails to reject the null hypothesis, 
there may not be a dose-response. 

This test compares Model R (the simpler model) to Model A2. Model R is a 
simpler A2 (or nested within A2) since R can be obtained from A2 by 
restricting all the mean parameters to be equal to one another and restricting 
all the variance parameters to be equal to one another. If this test fails to 
reject the null hypothesis, then there may not be a dose-response, as the 
inference would be that the simpler model (R) is not much worse than the 
saturated model. The default p-value for the test (as reported in the Tests of 
Interest section of the output) is 0.05. A p-value less than 0.05 is associated 
with the statement that “There appears to be a difference between response 
and/or variances among the dose levels. It seems appropriate to model the 
data.” A p-value greater than 0.05 is associated with the statement that the 
data may not be suitable for dose-response modeling. 

Test 2 (A1 vs A2): Tests the null hypothesis that variances are 
homogeneous. If this test fails to reject the null hypothesis, the simpler 
constant variance model may be appropriate. 

This test compares A1 (the simpler model) to Model A2. Model A1 is a 
simpler A2 (or nested within A2) since A1 can be obtained from A2 by 
restricting all the variance parameters to be equal to one another. If this test 
rejects the null hypothesis, the inference is that the constant variance 
assumption is incorrect and a modeled variance is necessary to adequately 
represent the data. The default p-value for the test (as reported in the Tests of 
Interest section of the output) is 0.1. A p-value less than 0.1 is associated with 
the statement that the user should “Consider running a non-homogeneous 
variance model. A p-value greater than 0.1 is associated with the statement 
that a constant variance assumption is suitable for the dose-response 
modeling. 

Test 3 (A3 vs A2): Tests the null hypothesis that the variances are 
adequately modeled. If this test fails to reject the null hypothesis, it may be 
inferred that the variances have been modeled appropriately. 

Here, the test is one to see whether or not the user-specified variance model, 
is appropriate. If the user-specified variance model is “constant variance,” 
then Models A1 and A3 are identical; this test is the same as Test 2, with the 
same interpretation. If the user-specified variance model is nonconstant 
(Sigma(i)^2 = alpha*Mu(i)^rho), this test determines if that particular equation 
appears adequate to describe the variance across dose groups. Model A3 is 
the simpler version of Model A2 obtained by constraining the variances to fit 
the nonconstant variance equation. The default p-value for the test (as 
reported in the Tests of Interest section of the output) is 0.1. A p-value less 
than 0.1 is associated with the statement that “You may want to consider a 
different variance model.” [Unfortunately BMDS has no further way to model 
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variance. Look for different variance models in future releases of BMDS.] A p-
value greater than 0.1 is associated with the statement that the modeled 
variance appears to be suitable for the dose-response modeling. 

Test 4 (Fitted vs A3): Tests the null hypothesis that the model for the mean 
fits the data. If this tests fails to reject the null hypothesis, the user has 
support for the selected model. 

This test compares the Fitted Model to Model A3. The Fitted Model is as 
simpler Model A3 (or nested within Model A3) because it can be obtained by 
restricting the means (unrestricted in A3) to be described by the dose-
response function under consideration. If this test fails to reject the null 
hypothesis, the inference is that the fitted model is adequate to describe the 
dose-related changes in the means (conditional on the form of the variance 
model; the form of the variance model is the same for the Fitted Model and 
Model A3). Failure to reject the null hypothesis is associated with the 
inference that the restriction of the means to the shape of the dose-response 
function under consideration is adequate. The default p-value for the test (as 
reported in the Tests of Interest section of the output) is 0.1. A p-value less 
than 0.1 is associated with the statement that “You may want to try a different 
model.” I.e., the fit of the Fitted Model is not good enough. A p-value greater 
than 0.1 is associated with a statement that the Fitted Model appears to be 
suitable for dose-response modeling. 

See also: 

 Text Output from Models 

 Dichotomous Model Text Output 

 Continuous Model Text Output 

 Nested Model Text Output 

 Graphics Output from Models 

 Continuous Model Maximum Likelihood Help 

DICHOTOMOUS MODEL TEXT OUTPUT 

The dichotomous output page starts with a few explanatory lines that the user 
can reference quickly to: check the version number, the date and time of run, the 
input dataset used, check which model was used, see the explicit form of the 
response function, verify that all the correct options were set and get some basic 
data summaries (number of dose levels, etc). The output page is designed so 
that it will provide a reliable basis for reentering BMDS and accurately 
reproducing the results of a run (e.g., with an updated model) at a later date. The 
“form of the response function” is provided on each model's text output page, and 
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is the model function that BMDS will estimate parameters for in order to derive 
the Benchmark Dose. 

Default Initial Parameters 

These are computer generated values that provide the starting point for the 
iterative maximization routine used by BMDS. This may give the user a basis 
for appropriate parameter values should they want to rerun the program if a 
maximum wasn’t found, they just don’t believe the answer, etc. 

Parameter Estimates 

The parameter estimates are the actual estimates the program routine has 
found for the particular model run. This table includes both the estimates for 
the true parameter values as well as their estimated standard errors. The 
standard errors are given for two reasons: 

1. If standard errors are extraordinarily high, then the user should suspect 
that the probability function may not have reached a maximum, and they 
may want to use different starting points. There is not a guarantee if these 
are high that the function has not, in fact, been maximized. The user 
should use this in conjunction with other output to make a decision. 

2. To make inferences about the population parameters themselves. Under 
certain assumptions, the user may be able to formulate tests for the true 
value of the parameter. 

Asymptotic Correlation Matrix of Parameter Estimates 

This table provides the user with a matrix of correlation estimates between 
each of the parameters. Again, if these values seem to be high (in this case, 
very close to 1), there may have been a problem in the maximization. Also, as 
stated before, high correlation does not confirm that the problem of 
maximization in fact failed. The Weibull model, for instance, tends to give high 
correlation between the slope and power parameters, even when the 
likelihood was maximized. 

Note The parameter standard errors and the correlation matrix elements are 
based on a variance-covariance (VCV) matrix obtained by inverting the 
negative of the Hessian matrix (the Fisher-observed information matrix). 
That matrix is made up of second partial derivatives of the log-likelihood, 
with respect to the model parameters.  
 
For all the dichotomous models, except for the multistage and multistage 
cancer models, the partials are derived using a finite difference 
approximation to those derivatives.  
 
For the multistage and multistage cancer models, the partial derivatives 
are computed analytically (i.e., without approximating their values through 
the finite-difference method). 
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Analysis of Deviance Table 

The analysis of deviance table lists three maximum likelihood values. The first 
is the “full model”. The full model would be any model that would perfectly fit 
all the positive response proportions at the dose levels specified by the user. 
The second model is the “fitted model” maximum likelihood value. This is the 
value of the maximum likelihood function for the particular model selected and 
using the estimated parameter values. The last likelihood value is the 
“reduced model” value, which would be the value of the likelihood function if 
all data points where assumed to come from the same population with the 
same population parameter. That is, for each dose level, the actual probability 
of an adverse effect would be the same. These values are just the likelihood 
functions evaluated according to the assumptions made at each step (i.e., the 
model assumption for the fitted model). 

Next to the likelihood values there are three values: Deviance, degrees of 
freedom (DF), and P-value. The Deviance is the difference between the fitted 
or reduced model and the full model likelihood values. This deviance 
measures whether or not the smaller model (i.e., the fitted or reduced model) 
describe the data as well as the full model does. This deviance is then used 
to formulate a Chi-Square random variable that tests exactly that. The user 
may choose a rejection level ( .05 is common) to test whether or not the 
model fit is appropriate. The p-value for testing whether or not the fitted model 
adequately describes the data is given next to the fitted model likelihood, and 
the user can reject or not reject a hypothesis according to the p-value given . 
The reduced model p-value would be used in the same way, but here the 
user would be testing whether or not there is in fact a dose/response 
relationship where the true population proportion is a function of dose, as 
opposed to a single population with one parameter (the proportion of affected 
animals). 

It will often happen that several models provide an adequate fit to a given 
dataset. These models may be essentially unrelated to each other (for 
example a logistic model and a probit model often do about as well at fitting 
dichotomous data) or they may be related to each other in the sense that they 
are members of the same family that differ in which parameters are fixed at 
some default value. One can consider the log-logistic, the log-logistic with 
non-zero background, and the log-logistic with threshold and non-zero 
background to all be members of the same family of models. Generally, within 
a family of models, as additional parameters are introduced the fit will appear 
to improve. Goodness-of fit statistics presented in the main body of the 
Analysis of Deviance Table can be used to compare such related models, but 
are not designed to compare unrelated models. Alternative approaches are 
need for selecting between models that are not related (not in the same 
family). 
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The Akaike's Information Criterion (AIC; Akaike, 1973; Linhart and Zucchini, 
1986; Stone, 1998) is defined as -2L + 2p, where L is the log-likelihood at the 
maximum likelihood estimates for the parameters, and p is the number of 
model parameters estimated. The AICs for the model run are provided at the 
bottom of the Analysis of Deviance Table. They can be used to compare 
different types of models which use a similar fitting method (for example, least 
squares or a binomial maximum likelihood), as do all dichotomous, 
continuous and nested model types within BMDS. The model with the lowest 
AIC would be presumed to be the better model under this method. Although 
such methods are not exact, they can provide useful guidance in model 
selection. 

Goodness of Fit 

This table gives both a listing of the data as well as residual and overall Chi-
Square Goodness of Fit tests. This is a good place for the user to look outside 
of the Analysis of Deviance table to judge the appropriateness of the model. 
The table lists estimated probabilities, the expected and observed number of 
affected animals and scaled residuals for each dose group. If a model fits 
well, the observed and expected number of affected animals should be 
relatively close. The overall scaled residual value, and it corresponding p-
value are indications of that “closeness”. If the p-value is larger than some 
predetermined critical p-value, then the user may be able to conclude that the 
model is appropriate to model the data. 

The scaled residual values printed at the end of the table are defined as 
follows: 

(Obs.—Expected)/SE 

where “Expected” is the predicted number of responders from the model and 
SE equals the estimated standard error of that predicted number. For these 
models, the estimated standard error is equal to sqrt[n*p*(1-p)], where n is the 
sample size and p is the model-predicted probability of response.” 

n is the sample (litter) size, and 

p is the model-predicted probability of response. 

The overall model should be called into question if the scaled residual value 
for any dose group, particularly a low dose group, is greater than 2 or less 
than -2. 

Slope at ED(10)—Cancer Model Only 

Some additional assessment tools are imparted by the Cancer model at this 
time. The output page for the cancer model includes an estimate of the slope 
of the BMD curve at the ED(10) (the 10 percent extra risk response level) and 
the two sided 95.0% confidence interval for the slope at the ED(10). The two 
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sided 95.0% confidence interval for the linear term of the model is also 
provided. Finally, scaled residuals are reported to aid in determining how well 
the model fits the data at low doses. 

Benchmark Dose Computation 

This is the ultimate goal of the BMDS software (see Overview). The BMD or 
BMDL is the value that the user will use when determining the RfD or RfC for 
the particular toxicant being studied. The user should investigate all the 
output to this point, and then make the decision to accept this as a valid 
BMDL. 

See also: 

 Text Output from Models—Introduction 

 Dichotomous Model Option Screens 

 Dichotomous Model Descriptions 

 Graphics Output from Models 

Nested Model Text Output 

The nested model output page starts with a few explanatory lines that the user 
can reference quickly to: check the version number, the date and time of run, the 
input dataset used, verify that all the correct options were set, check which model 
was used, see the explicit form of the mean function for the model run, and get 
some basic data summaries (number of dose levels, etc). The output page is 
designed so that it will provide a reliable basis for reentering BMDS and 
accurately reproducing the results of a run (e.g., with an updated model) at a 
later date. The “form of the response function” is provided on each model's text 
output page, and is the model function that BMDS will estimate parameters for in 
order to derive the Benchmark Dose. 

Default Initial Parameters 

These are computer generated values that provide the starting point for the 
iterative maximization routine used by BMDS. This may give the user a basis 
for appropriate parameter values should they want to rerun the program if a 
maximum wasn’t found, they just don’t believe the answer, etc. 

Parameter Estimates 

The parameter estimates are the actual estimates the program routine has 
found for the particular model run. This table includes both the estimates for 
the true parameter values as well as their estimated standard errors. The 
standard errors are given for two reasons: 
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1. If standard errors are extraordinarily high, then the user should suspect 
that the probability function may not have reached a maximum, and they 
may want to use different starting points. There is not a guarantee if these 
are high that the function has not, in fact, been maximized. The user 
should use this in conjunction with other output to make a decision. 

2. To make inferences about the population parameters themselves. Under 
certain assumptions, the user may be able to formulate tests for the true 
value of the parameter. 

Note The parameter standard errors are based on a variance-covariance (VCV) 
matrix obtained by inverting the negative of the Hessian matrix (the 
Fisher-observed information matrix). That matrix is made up of second 
partial derivatives of the log-likelihood, with respect to the model 
parameters. For all the nested models, the partials are derived using a 
finite difference approximation to those derivatives. 

Analysis of Deviance Table 

The analysis of deviance table lists three maximum likelihood values. 

 The first is the “full model”. The full model would be any model that would 
perfectly fit all the positive response proportions at the dose levels 
specified by the user. 

 The second model is the “fitted model” maximum likelihood value. This is 
the value of the maximum likelihood function for the particular model 
selected and using the estimated parameter values. 

 The last likelihood value is the “reduced model” value, which would be the 
value of the likelihood function if all data points where assumed to come 
from the same population with the same population parameter. That is, for 
each dose level, the actual probability of an adverse effect would be the 
same. 

These values are the likelihood functions evaluated according to the 
assumptions made at each step (i.e., the model assumption for the fitted 
model). 

Next to the likelihood values there are three values: Deviance, degrees of 
freedom (DF), and P-value. These are asymptotic Chi-Square tests that 
investigate the appropriateness of the model fit, as well the reduced model. 

 The Deviance is the difference between the fitted or reduced model and 
the full model likelihood values. This deviance measures whether or not 
the smaller model (i.e., the fitted or reduced model) describe the data as 
well as the full model does. This deviance is then used to formulate a Chi-
Square random variable that tests exactly that. The user may choose a 
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rejection level ( .05 is common) to test whether or not the model fit is 
appropriate. 

 The p-value for testing whether or not the fitted model adequately 
describes the data is given next to the fitted model likelihood, and the user 
can reject or not reject a hypothesis according to the p-value given . 

 The reduced model p-value would be used in the same way, but here the 
user would be testing whether or not there is in fact a dose/response 
relationship where the true population proportion is a function of dose, as 
opposed to a single population with one parameter (the proportion of 
affected animals). 

Goodness of Fit Information—Litter Data and Grouped Data 

Both of these tables provide a listing of the data, expected and observed 
responses and scaled residuals (observed—expected). 

The “Litter Data” table contains this information for each litter. 

To obtain the “Group Data” table, the Litter Data were sorted on Dose (first), 
and by Litter Specific Covariate within Dose. Within dose, litters adjacent to 
each other with respect to Litter Specific Covariate were grouped together 
until the expected number of affected pups was at least one. This grouping 
was done prior to the estimation of an overall Chi-Square and p-value to 
improve the validity of the Chi-Square approximation for the goodness of fit 
statistic. Goodness of Fit statistics. Both tables list estimated probabilities, the 
expected and observed number of affected animals and scaled residuals for 
each dose group. If a model fits well, the observed and expected number of 
affected animals should be relatively close. The overall Chi-Square value and 
its corresponding p-value are an indication of that “closeness”. If the p-value 
is larger than some predetermined critical p-value, then the user may be able 
to conclude that the model is appropriate to model the data. 

The scaled residual values printed at the end of the table are defined as 
follows: 

(Obs. - Expected)/SE 

where “Expected” is the predicted number of responders from the model and 
SE equals the estimated standard error of that predicted number. For these 

models, the estimated standard error is equal to sqrt[n*p*(1-p)*(*(n-1)+1)], 
where 

n is the sample (litter) size, 

p is the model-predicted probability of response, and 

 is the model-predicted intra-litter correlation coefficient. 
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The overall model should be called into question if the scaled residual value 
for any individual dose and litter-specific covariate combination, particularly 
for a low dose group, is greater than 2 or less than -2. 

Benchmark Dose Computation 

This is the ultimate goal of the BMDS software (see Overview). The BMD or 
BMDL is the value that the user will use when determining the RfD or RfC for 
the particular toxicant being studied. The user should investigate all the 
output to this point, and then make the decision to accept this as a valid 
BMDL. 

See also: 

 Text Output from Models—Introduction 

 Nested Models Option Screens 

 Nested Models—Description 

 Graphics Output from Models 

REPEATED RESPONSE MEASURES MODEL TEXT OUTPUT 

The Repeated Response Measures Model output file begins with a section that 
echoes user-specified information (e.g. Study Name and Study Description) as 
well as some information about the contents of the dataset: what the dose levels 
are, at what times observations were available, and the sample size (i.e., the 
number of distinct combinations of experimental unit ID and time). The user 
should verify that these values are correct; if they are not, then the data file 
should be checked for data entry errors. 

In addition, this section shows the form of the model. 

Likelihood-Related Estimates 

The AIC and BIC as well as the log-likelihood for the model fit to the data 
being analyzed are shown here. 

Random Effects 

This section shows which parameters were selected to have random effects 
around the main (fixed) effect. At this time, the only parameter for which 
random effects are specified is the parameter A0 (the constant term in the 
background response polynomial). So, in this section there will be a standard 
deviation reflecting the variability of the random effects around the 
corresponding fixed effect. There will also be a “Residual” standard deviation 
reflecting the remaining variability that is not part of the random effect 
(reflecting the remaining lack of fit of the model to the data and therefore 
associated with residuals). The distributions of the random effects and of the 
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residuals are assumed to be independent of one another. [At a later time, 
when more than one random effect is allowed, the distributions of the random 
effects will not be assumed to be independent of one another, though they all 
will still be assumed independent of the residual distribution. In the case of 
more than one random effect, pair-wise correlation estimates will be provided 
as well. When those correlations are close to 1 or -1, that may be a strong 
indication that the data cannot support that many random effects and 
alternative assumptions should be tried by the user.] 

Parameter Estimates 

In this section, the additional results related to the model fitting are provided. 
Parameter estimates for the fixed effects are shown with their standard errors. 
In addition the degrees of freedom, t-test statistic value, and associated p-
value for that test are shown, in order to facilitate evaluation of the 
significance of the parameters. 

In addition, parameter correlations and a summary of the within-group 
residuals are shown. 

Initial Values 

In this section one finds the set of initial values that were used when the 
model apparently converged to an acceptable answer. Below that is the list of 
the initial values that the model was scheduled to try; it starts with the first set 
listed and continues until it uses a set that resulted in apparent convergence. 

BMD Estimation 

In this section the summary BMD results are presented. First, the user-
specified choices for risk type, spontaneous risk level (adverse level; if a Cut 
Point was used instead of Background Rate, then the value of the cut point 
would be printed here), the area of adverse effects (Adverse Direction), and 
the BMR level are shown. If these are not the choices the user wants to have, 
the option file should be revisited and correct values entered for these fields. 
The same is true of the number of bootstrap iteration which is shown next. 

The minimum BMD is what is shown (the BMD, as a rule, varies as a function 
of time). The time at which that minimum BMD was obtained is also given. 
The value shown for “Confidence Level” is (1-α)*100% (where α is what was 
entered on the option screen). The lower limit presented is based on the user-
specified number of bootstrap iterations. As discussed elsewhere, the user 
should test for stability of that estimate if the accuracy of the BMDL (or BMDU 
if that too is estimated) needs to be assured to some desired number of 
significant digits. 

In addition to the text output file, five plots are produced with each run. 
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See also: 

Repeated Response Measures Option Screen 

CONCENTRATION X TIME MODEL TEXT OUTPUT 

The Concentration x Time model output file begins with a section giving 
information about the version number and build date of the program, as well as 
identifying the input dataset used to create the output and the name of the file 
that has the information needed to later produce graphics. [Currently, BMDS 
does not produce graphics for the Concentration x Time model.] 

Model Specifications 

This section provides the overview of the framework for the model, including 
the reference for Finney (1971) from which Wil ten Berge identified the probit 
analysis approach. The general form of the model as it is now implemented is 
presented here as is a basic summary of the number of input parameters 
(possible explanatory variables) and the number of observations in the 
dataset. 

Input dataset Echo 

This section should contain exactly the data that the user has included in the 
input file. If there are any errors here, the user should go back to the input file 
and correct the input values, and then rerun the analysis. 

Modeling Choices 

In this section, the following information is provided: the choices for the range 
of observations to analyze, the transformations of the input parameters to 
use, the link function (logit or probit), and the variable identifier numbers 
associated with the selected explanatory variables (single input parameters or 
products of pairs of input parameters). If any of this information does not 
correspond to the desired analysis, the user must go back to the input file to 
make corrections to the coding in the modeling section. 

Fit and Parameter Estimates 

The chi-square evaluation of fit and the degrees of freedom associated with 
the model fit to the selected data are given. The fit is assessed in relation to 
the “saturated” model having as many parameters as observations. The 
maximum likelihood estimates of the Bi coefficients are shown as is a Student 
t value that can be used to determine whether each of those terms is 
“statistically significant.” Variance and covariance estimates for each of the Bi 
terms are provided. 

When the model fails, one or more of the parameter values may have a value 
of the form “-1.#J” or a similar non-number. This is an indication that the 
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model has not converged to an answer. The user should check the input file 
(also reflected in the data echo section of the output file) to see if some data 
entry errors are contributing to that problem. 

If there are no errors in the input data, it is entirely possible that there is no 
solution for some data; this happens, for example, when there are only 
groups with either 0% or 100% response. In such cases, the model cannot 
determine a maximum likelihood and returns values for one or more of the 
parameters (and estimates depending on those parameters) that are of the 
form “-1.#IOe+000,” “1.#R,” “1.#QOe+000,” “1.#QNAN0,” or similar 
indications that no numerical answer was available. It is known, for example, 
that probit slope estimates can be infinite in some situations where 
concentrations with and without response are not suitably intermingled. A 
sufficient (but not necessary) condition to avoid this is to have two distinct 
doses with partial response. 

“Dose” Estimation 

In this section one finds the estimate of an input variable value that, for a 
given response and for specified values of the other input parameters, gives 
that response rate. Confidence limits are estimated if requested. Some 
reviewers have strongly suggested that the Student T-based deviates always 
be used and (confidence intervals obtained when a standard normal deviate 
is used are “too tight”) and so one might want to obtain from statistical tables 
the deviate for a T-distribution having degrees of freedom equal to the 
number of observations minus the number of estimated parameters (e.g., the 
95th percentile from such a T-distribution). These same comments also apply 
to the next two sections giving estimates and confidence intervals for 
response rates and for the ratios of model parameters. 
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Notes The use of the terminology “probability of correct model” in the output file 
is not a good choice for describing the results of the chi-squared 
goodness-of-fit test that is the basis for the reported p-value. Subsequent 
versions of this software will replace that terminology with a statement like 
“The p-value associated with the chi-square goodness of fit test equals x” 
where x is the calculated p-value.  
 
The terminology as shown in the example output file has been retained so 
that comparisons between the new version and the original version of the 
ten Berge software could be more easily made (the same description has 
been retained in both cases).  
 
Similarly, the statement that the “prediction of the model is not sufficient” 
will be modified to simply indicate whether or not the p-value is greater 
than or less than 0.05, with the appropriate statement regarding adequate 
fit of the model or not (similar to the evaluations of fit in other BMDS 
models) and a suggestion that (if the model is not fitting the data well) the 
correction factor be applied to the variance and covariance estimates as 
well as selecting the deviate from the Student T distribution rather than the 
standard normal distribution.  
 
Currently, neither the variance-covariance correction nor the choice of the 
deviate are done automatically for the calculation of confidence limits. 

Response Estimation 

Much like the previous section, this section provides estimates of the 
response associated with specified values of the input variables used in the 
model. When a deviate is given, the corresponding confidence interval is also 
calculated for that estimate. Note that the deviate supplied need not be the 
same as the one provided for the “dose” estimation, in case different 
confidence levels may be desired for dose and response estimates. 

See notes in previous section about terminology related to the model fit. 

Ratio Estimation 

In this section the ratio of the Bi coefficients request by the user will be 
reported. As in the previous sections the confidence interval is also shown, if 
requested, at a level consistent with the specified deviate. 

See notes in previous section about terminology related to the model fit. 

See also: 

 Concentration x Time Data 

 Concentration x Time Model Option Screen 
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GRAPHIC OUTPUT FROM MODELS 

The graphic output plot should display along with the text output file after each 
model run. 

 

 The BMD and BMDL are identified on the plot as black vertical lines and are 
associated with the response level associated with the user-selected BMR, 
the horizontal black line. 

 The BMD curve estimated by the model is represented by a red line and the 
BMDL curve (which is basically connecting five BMDL estimates) is 
represented by the blue line. 

 Data points are shown in green with their individual group confidence 
intervals (see the section Error Bar Calculations for more information). 

The graphic display features can be modified by either using GnuPlot edit 
features or copying the plot to your computer's clipboard and pasting it into 
another application capable of performing vector graphic editing (e.g., Microsoft 
PowerPoint). These copy and edit features are accessible by left-clicking on the 
small graphic icon at the top of the plot page or right-clicking on the graph. A 
menu will appear that enables you to modify the plot window in various ways. 

Among the options available are: 

 Copying to the clipboard 

 Changing background 
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 Color and font specifications 

 Printing options, including printing landscape or portrait. 

ERROR BAR CALCULATIONS 

Continuous Models 

BMDS uses a single error bar plotting routine for all continuous models. 

 The plotting routine calculates the standard error of the mean (SEM) for each 
group. The routine divides the group-specific observed variance (obs 
standard deviation squared) by the group-specific sample size. 

 The routine then multiplies the SEM by the Student-T percentiles (2.5th 
percentile or 97.5th percentile for the lower and upper bound, respectively) 
appropriate for the group-specific sample size (i.e., having degrees of 
freedom one less than that sample size). The routine adds the products to the 
observed means to define the lower and upper ends of the error bar. 

Dichotomous Models 

The error bars shown on the plots of dichotomous data are derived using a 
method discussed in J. Fleiss, “Statistical Methods for Rates and Proportions” 
(Third Edition, 1973), pp. 26–29. That method is a modification of the Wilson 
interval (based on the score statistic) but with a continuity correction. For the 
upper bound, the calculation finds the proportion, pi, such that 

(|p—pi|—1/(2n)) / sqrt(pi * (1—pi) / n) = z 

where 

p is the observed proportion 

n is the total number in the group in question 

z = Z(1-alpha/2) is the inverse standard normal cumulative distribution 
function evaluated at 1-alpha/2 

This leads to equations for the lower and upper bounds of: 

LL = {(2np + z2 - 1) - z * sqrt[ z2 - (2 + 1/n) + 4p(nq + 1)]} / [2(n + z2)] 

UL = {(2np + z2 + 1) + z * sqrt[z2 + (2 - 1/n) + 4p(nq -1)]} / [2(n + z2)] 

where q = 1-p. 
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The error bars shown in BMDS plots use alpha = 0.05 and so represent the 95% 
confidence intervals on the observed proportions (independent of model). 

Nested Models 

The error bars shown for the plots of nested data are calculated in the same way 
as those for dichotomous data. However, a Rao-Scott transformation is applied 
prior to the calculations in order to express the observations in terms of an 
“effective” number of affected divided by the total number in each group (the 
format required for the confidence intervals of simple dichotomous responses). 
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MODEL DESCRIPTIONS  

MODELS INCLUDED IN BMDS 2.6.0.1 

The following list details the models, their filenames, and version numbers 
contained in this BMDS version. 

DICHOTOMOUS MODELS 

Filename Version (Date) Model(s) Included 

Cancer.exe 3.4 (05/02/2014) Multistage Cancer Model 

Gamma.exe 2.16 (02/28/2013) Gamma Model 

Logist.exe 2.14 (02/28/2013) Logistic and Log-Logistic Models 

Multistage.exe 3.4 (05/02/2014) Multistage Model 

Probit.exe 3.3 (02/28/2013) Probit and Log Probit Models 

Weibull.exe 2.16 (02/28/2013) Weibull and Quantal Linear 
Models 

CONTINUOUS MODELS 

Filename Version (Date) Model(s) Included 

Exponential.exe 1.10 (01/12/2015) Exponential Model 

Hill.exe 2.17 (01/28/2013) Hill Model 

Poly.exe 2.20 (10/22/2014) Polynomial and Linear Models 

Power.exe 2.18 (05/19/2014) Power Model 

NESTED DICHOTOMOUS MODELS 

Filename Version (Date) Model(s) Included 

NCTR.exe 2.13 (04/27/2015) NCTR Model 

Nlogist.exe 2.20 (04/27/2015) Nlogistic Model 

Raivr.exe 2.12 (04/27/2015) RaiVR Model 
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DICHOTOMOUS ALTERNATIVE MODELS 

Filename Version (Date) Model(s) Included 

Cancer_BG_Dose.exe 3.1 (12/10/2014) Cancer Model with Background 
Dose 

DichoHill.exe 1.3 (02/28/2013) Dichotomous Hill Model 

Gamma_BGDose.exe 1.4 (01/12/2015) Gamma Model with Background 
Dose 

Log_Probit_BG_Dose.exe 1.4 (01/12/2015) Log Probit Model with Background 
Dose 

Logist_BG_Response.exe 3.1 (01/12/2015) Logistic Model with Background 
Response 

Multistage_BG_Dose.exe 3.1 (12/10/2014) Multistage Model with Background 
Dose 

Probit_BG_Response.exe 2.9 (01/12/2015) Probit Model with Background 
Response 

Weibull_BG_Dose.exe 1.2 (01/12/2015) Weibull Model with Background 
Dose 

REPEATED RESPONSE MEASUREMENTS 

Filename Version (Date) Model(s) Included 

ToxicoDiffFunction.R, 
ToxicoDiffProgram.R 

1.1 (09/23/2008) Toxicodiffusion Model 

CONCENTRATION X TIME 

Filename Version (Date) Model(s) Included 

TENBERGE.EXE 1.0 (12/26/2006)  ten Berge CxT Model 

MULTIPLE TUMOR ANALYSIS 

Filename Version (Date) Model(s) Included 

MS_COMBO.EXE 1.8 (04/30/2014) Multiple tumor analysis; combining 
multistage-cancer model runs over 
different tumors 
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OUTPUT FILE NAMING CONVENTIONS 

BMDS automatically assigns an output file name for each model run (session row) 
corresponding to the following naming convention: 

[3 letter model abbreviation]-[name of data file]-[name of option 

file].out 

For example, an output file named “web_Dichotomous_Opt.out” signifies this is output 
from the Weibull background dose model.  

The following table presents the 3-letter model abbreviation for each BMDS model that 
generates an .out file.  

CONTINUOUS MODELS 

Model Type Abbreviation 

Exponential exp 

Hill hil 

Linear lin 

Polynomial ply 

Power pow 

DICHOTOMOUS MODELS 

Model Type Abbreviation 

Dichotomous Hill dhl 

Gamma gam 

Logistic log 

LogLogistic lnl 

LogProbit lnp 

Multistage mst 

Multistage-Cancer msc 

Probit pro 

Weibull wei 

Quantal Linear qln 
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DICHOTOMOUS ALTERNATIVE MODELS 

Model Type Abbreviation 

Gamma-BgDose gmb 

Logistic-BgResponse  

LogProbit-BgDose lpb 

Mutistage-BgDose msb 

Multistage-Cancer-BgDose mcb 

Probit-BgResponse prb 

Weibull-Bgdose web 

NESTED DICHOTOMOUS MODELS 

Model Type Abbreviation 

Nested Logistic nln 

NCTR nct 

Rai and van Ryzin rvr 

REPEATED RESPONSE MEASURES 

Model Type Abbreviation 

ToxicoDiffusion txd 

CONCENTRATION X TIME 

Model Type Abbreviation 

 ten Berge ten 

MULTIPLE TUMOR ANALYSIS 

Model Type Abbreviation 

MS_Combo multi 
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OPTIMIZATION ALGORITHMS USED IN BMDS 

Two subroutines are used for all the optimizations in BMDS. 

 DMNGB, written by David M. Gay, is used for all models that can be 
reparameterized so that BMD appears explicitly as a parameter. This routine 
is archived in Netlib. 

 DONLP2 was written by P. Spellucci to solve optimization problems with non-
linear constraints. It is used in cases where the model cannot be so 
reparameterized. DONLP2 is restricted to non-commercial use by the author's 
copyright. More information on the optimizer can be found at the author’s 
Web site. 

CONTINUOUS MODEL DESCRIPTIONS 

Special Considerations for Models for Continuous Endpoints in Simple 
Designs 

Models in this section are for continuous endpoints, such as weight or enzyme 
activity measures, in simple experimental designs that do not involve nesting or 

other complications. The models predict the mean value of the response,  
(dose), expected for a given dose. 

Models for continuous endpoints require consideration of more details than do 
those for dichotomous endpoints in similar designs. While for dichotomous 
models, we normally model the incidence of adversely affected individuals, and 
so expect the response to increase with increasing dose, in continuous models 
the change in a measure is modeled without regard for “adversity”, and the 
response may increase or decrease. Thus, just what constitutes an adverse 
change, and how to specify it, must be made explicit. The models in BMDS allow 
that specification to be made in several ways, which will be described below 
(BMD Computation). 

Another important contrast with dichotomous models is the nature of the 
probability distribution of response. In dichotomous models, the nature of the 
experimental design guarantees that the binomial probability distribution is 
appropriate. There are many more options for continuous distributions, however. 
In the current version of BMDS, the distribution of continuous measures is 
assumed to be normal, with the exception of the Exponential Models, for which 
the user may assume either a normal or a lognormal distribution (see the section 
on the Lognormal Distribution below). Moreover, for all models and normally 
distributed data, one may assume either a constant variance (that is, the 
variance is the same regardless of dose group), or a variance that changes as a 
power function of the mean value: 

http://www.netlib.org/
http://www.mathematik.tu-darmstadt.de/fbereiche/numerik/staff/spellucci/DONLP2/
http://www.mathematik.tu-darmstadt.de/fbereiche/numerik/staff/spellucci/DONLP2/
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𝜎𝑖
2 = 𝛼[𝜇(𝑑𝑜𝑠𝑒𝑖)]

𝜌 

which is the modeled variance for the ith dose group. the expression  (dosei) is 

the observed mean (from the model) for the ith dose group, and  (alpha) and  
(Rho) are estimated parameters. This formulation allows for several commonly 

encountered situations. For example, if = 2, then the coefficient of variation is 

constant, a common situation especially for biochemical measures; if  = 1, then 
the variance is proportional to the mean, which is sometimes appropriate for 
large counts (especially if the constant of proportionality, k, is 1.0). When a 
lognormal distribution is assumed, the Exponential Models assume a constant 
(log-scale) variance, equivalent to a constant coefficient of variation. 

Likelihood Function 

Suppose there are g doses, 

𝑑𝑜𝑠𝑒1, … , 𝑑𝑜𝑠𝑒𝑔 

with Ni subjects per dose group, and that yij is the measurement for the j
th

 

subject in the ith dose group. The form of the log-likelihood function depends 
upon whether the variance is assumed to be constant, or to vary among doses. 

For constant variance, the log-likelihood function is: 

𝐿 = −
𝑔

2
ln(2𝜋) − ∑[

𝑁𝑖
2
ln𝜎𝑖

2 +
(𝑁𝑖 − 1)𝑠𝑖

2

2𝜎𝑖
2 +

𝑁𝑖(𝑦̅𝑖 − 𝜇(𝑑𝑜𝑠𝑒𝑖))
2

2𝜎𝑖
2 ]

𝑔

𝑖=1

, 

where 

𝑠𝑖
2 =

∑ (𝑦𝑖𝑗 − 𝑦̅𝑖)
2𝑁𝑖

𝑗=1 

𝑁𝑖 − 1 
 

is the sample variance for the ith dose group, 

𝑦̅𝑖 =
∑𝑗 = 1𝑁𝑖𝑦𝑖𝑗

𝑁𝑖 − 1 
 

is the sample mean for the ith dose group, g is the number of doses, Ni is the 

number of subjects in the ith dose group, and σ
2
 the variance which is same in 

all dose groups. Generally, σ
2
 and the parameters hidden here in ( ) are to be 

estimated. 
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If the variance is allowed to be a power function of the mean, the log-likelihood 
function is: 

𝐿 = −∑[
𝑁𝑖
2
ln𝛼 +

𝑁𝑖𝜌

2
ln[𝜇(𝑥𝑖)] + 𝐻𝑖]

𝑔

𝑖=1

 

where 

𝐻𝑖 = 
𝐴𝑖

2𝛼[𝜇(𝑑𝑜𝑠𝑒𝑖)]𝜌
− 

𝐵𝑖
𝛼[𝜇(𝑑𝑜𝑠𝑒𝑖)]𝜌−1

+ 
𝑁𝑖

2𝛼[𝜇(𝑑𝑜𝑠𝑒𝑖)]𝜌−2 
 

with 

𝐴𝑖 = (𝑁𝑖 − 1)𝑠𝑖
2 + 𝑁𝑖𝑦̅𝑖

2 

𝐵𝑖 = 𝑁𝑖𝑦̅𝑖 . 

The upper bound for the power parameter in the Hill and power models has been 
(somewhat arbitrarily) set to 18. That value was selected because it represents a 
very high degree of curvature that should accommodate almost every dataset, 
even ones with very (or absolutely) flat dose-response at low doses followed by a 
very steep dose-response at higher doses. 

If the power parameter for the Hill or power model is reported equal to 18 and the 
warning “ …hit a bound . . .” appears, the parameter estimates are maximum 
likelihood estimates only in the restricted sense that the power parameter has 
been assigned a value and the other parameters are MLEs conditional on that 
assigned value. Such model results are not strictly comparable with others in 
terms of AIC. In such a case, the BMD and BMDL could depend on the choice of 
power parameter; thus, sensitivity analysis is indicated if one intends to rely on 
the reported BMD or BMDL. 

BMD Computation 

In the continuous models, the benchmark dose is always the dose that results in 
a prespecified change in the mean response. The change can be expressed in 
several ways: 

 An absolute change in the mean (Abs. Dev.); 

 A change in the mean equal to a specified number of control standard 
deviations (Std. Dev); 

 A specified fraction of the control group mean (Rel. Dev.); 

 A specified value for the mean at the BMD (i.e., not a change, but a fixed 
value) (Point); 

 A change equal to a specified fraction of the range of the response, 
applicable only when the dose-response has an asymptote at high doses 
(Extra) [Hill and some Exponential models only]. 
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Symbolically, these are (where  represents the BMRF designated by the user): 

|𝜇(𝐵𝑀𝐷) −  𝜇(0)| = {

 𝛿  Abs. Dev.
𝛿 ⋅  𝜎̂1  Std. Dev.

𝛿 ⋅ 𝜇(0)  Rel. Dev.
 

𝜇(𝐵𝑀𝐷) = 𝛿 Point 

𝜇(𝐵𝑀𝐷) −  𝜇(0)

𝜇𝑚𝑎𝑥 −  𝜇(0)
= 𝛿 Extra 

BMDL Computation 

BMDS currently only calculates one-sided confidence intervals, in accordance 
with current BMD practice. The general approach to computing the confidence 
limit for the BMD (called the BMDL here) is the same for all the models in BMDS, 
and is based on the asymptotic distribution of the likelihood ratio (Crump and 
Howe, 1985). Two different approaches are followed in these models. In one, the 
equations that define the benchmark response in terms of the benchmark dose 
and the dose-response model are solved for one of the model parameters. The 
resulting expression is substituted back into the model equations, with the effect 
of reparameterizing the model so that BMD appears explicitly as a parameter. A 
value for BMD is then found such that, when the remaining parameters are 
varied to maximize the likelihood, the resulting log-likelihood is less than that at 
the maximum likelihood estimates by exactly 

𝜒1,1−2𝛼
2

2
 

In the polynomial exponential models, it is impractical or impossible to explicitly 
reparameterize the dose-response model function to allow BMD to appear as an 
explicit parameter. For this model, the BMR equation is used as a non-linear 
constraint, and the minimum value of BMD is determined such that the log-
likelihood is equal to the log-likelihood at the maximum likelihood estimates less 

𝜒1,1−2𝛼
2

2
 

Lognormal Distributions 

In previous versions of BMDS, continuous data were always assumed to be 
normally distributed. In the current version of BMDS, for the exponential models 
only, the user has the option of specifying that the continuous data being 
analyzed are lognormally distributed. Lognormal distributions are appropriate 
only for data that are strictly positive and may be preferable for such data (since 
the normal distribution allows, in theory, both positive and negative values, no 
matter what the mean and standard deviation). When a lognormal distribution is 
specified, the models assume a constant log-scale variance, which is equivalent 
to an assumption of a constant coefficient of variation (CV). 
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The likelihood function shown above is then correct for data on the log scale (log-
transformed) and is the basis for fitting the log-transformed version of the model 
in question. That is, if μL(dose) is the log-scale mean as a function of dose, the 
model being fit is μL(dose) = ln{m(dose)}, where m(dose) is the specified model 
(e.g., one of the exponential models parameterized as shown in the section on 
Exponential Models). Therefore, m(dose) will then be a description of the change 
in the median response as a function of dose since the anti-log of the log-scale 
mean is the median. 

When the input data are summarized in terms of the sample mean and sample 
standard deviation (or standard error or variance), the exact likelihood of the data 
cannot be determined if the data are lognormally distributed. In such cases, 
BMDS gives an approximate MLE solution by estimating the log-scale sample 
mean and log-scale sample standard deviation for each dose group as follows: 

estimated log-scale sample standard deviation (sL): sqrt{ln[1 + s2/m2]} 

estimated log-scale sample mean (mL): ln[m]—sL2/2 

where m and s are the reported sample mean and sample standard deviation. 
When individual responses are available, the user may input those values (where 
the input dax file will have two columns reporting the dose and the response for 
each experimental unit) and may request that the exact MLE solution be obtained 
(which the software does by first log-transforming the individual responses) or 
that the approximate solution using the estimates shown above be obtained 
(which the software does by first computing sample means and sample standard 
deviations). This option allows the user to compare estimates and determine the 
impact of the approximation or to provide consistency across data sets if some 
data sets have individual responses while others do not. 

See also: 

 Continuous Model Option Screens 

 Continuous Models—Text Output 

 Linear Continuous Model—Description 

 Polynomial Continuous Model—Description 

 Power Continuous Model—Description 

 Hill Model—Description 

 Exponential Continuous Models—Description 

 Optimization Algorithms Used In BMDS 

 Lognormal Response Option (Best Practices for Obtaining Optimal Model 
Convergence) 
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LINEAR CONTINUOUS MODEL 

Model Form 

The Linear model is a form of the polynomial model. The formula for the 
polynomial model is 

𝜇(𝑑𝑜𝑠𝑒) = 𝛽 + 𝛽1𝑑𝑜𝑠𝑒 + 𝛽2𝑑𝑜𝑠𝑒
2 +⋯+ 𝛽𝑛𝑑𝑜𝑠𝑒

𝑛 

The linear model is a special case of the polynomial model, with n restricted to 1. 

Parameters 

 Alpha is  from the variance model (see Continuous Model Description) 

 Rho is  from the variance model (see Continuous Model Description) 

 Beta0…Betan is 1…n; polynomial coefficients. 

Special Options 

Degree Poly 

Degree of polynomial. 

Restriction 

One of “None”, “Non-Positive”, “Non-Negative”. Determines restrictions on the 
polynomial coefficients. Restricting them to be either non-positive or non-
negative guarantees that the resulting function will be strictly decreasing, 
strictly increasing, or perfectly flat (when all the coefficients are zero). If the 
coefficients are unrestricted, more complicated shapes are possible, and, 
particularly as the degree of the polynomial approaches the number of dose 
groups minus one, the polynomial will often be quite “wavy”. When the 
coefficients are unrestricted and the degree is one less than the number of 
dose groups (for example, if there are four dose groups, including control, if 
the degree of the polynomial is three), then the model will exactly reproduce 
the means of the dose groups. 

BMD Computation 

The appropriate relationship for the BMR is solved (see Continuous Models: 
BMD Computation) using numerical methods. 

BMDL Computation 

The BMR equation (see Continuous Models: BMDL Computation) is used as a 
non-linear constraint, and the minimum value of BMD is determined such that the 
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log-likelihood is equal to the log-likelihood at the maximum likelihood estimates 
less 

𝜒1,1−2𝛼
2

2
 

See also: 

 Continuous Models in General 

 Linear Model Input File 

POLYNOMIAL CONTINUOUS MODEL 

Model Form 

The formula for the polynomial model is 

𝜇(𝑑𝑜𝑠𝑒) = 𝛽0 + 𝛽1𝑑𝑜𝑠𝑒 + 𝛽2𝑑𝑜𝑠𝑒
2 +⋯+ 𝛽𝑛𝑑𝑜𝑠𝑒

𝑛 

Here n is the degree of the polynomial (labeled “Degree Poly.” on the model 
option screen), and is specified by the user. The degree must be a positive 
integer (typically less than the number of dose groups). 

The linear model is a special case of the polynomial model, with n restricted to 1. 

Parameters 

 Alpha is  from the variance model (see Continuous Model Description) 

 Rho is  from the variance model (see Continuous Model Description) 

 Beta0…Betan is 1…n; polynomial coefficients. 

Special Options 

Degree Poly 

Degree of polynomial (maximum = 21). 

Restriction 

One of “None”, “Non-Positive”, “Non-Negative”. Determines restrictions on the 
polynomial coefficients. Restricting them to be either non-positive or non-
negative guarantees that the resulting function will be strictly decreasing, 
strictly increasing, or perfectly flat (when all the coefficients are zero). If the 
coefficients are unrestricted, more complicated shapes are possible, and, 
particularly as the degree of the polynomial approaches the number of dose 
groups minus one, the polynomial will often be quite “wavy”. When the 
coefficients are unrestricted and the degree is one less than the number of 
dose groups (for example, if there are four dose groups, including control, if 
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the degree of the polynomial is three), then the model will exactly reproduce 
the means of the dose groups. 

BMD Computation 

The appropriate relationship for the BMR is solved (see the Continuous Models 
section on BMD Computation) using numerical methods. 

BMDL Computation 

The BMR equation (see the Continuous Models section on BMDL Computation) 
is used as a non-linear constraint, and the minimum value of BMD is determined 
such that the log-likelihood is equal to the log-likelihood at the maximum 
likelihood estimates less 

𝜒1,1−2𝛼
2

2
 

See also: 

 Continuous Model Descriptions 

 Polynomial Model Input File 

POWER CONTINUOUS MODEL 

Model Form 

The form of the Power model is: 

𝜇(𝑑𝑜𝑠𝑒) = 𝛾 + 𝛽 ⋅ (𝑑𝑜𝑠𝑒)𝛿 

Here, 0 <  < 1,   0, and 18   > 0 with an option to restrict   1. 

Parameters 

 Alpha is  from the variance model (see Continuous Model Description) 

 Rho is  from the variance model (see Continuous Model Description) 

 Control = 

 Slope = 

 Power =  (The Power parameter must be a positive number  18. If Power is 
restricted, the number must be > 1.) 

Special Options 

Restrict power  1 

Restrict   1. If  < 1, then the slope of the dose-response curve becomes 
infinite at the control dose. This is biologically unrealistic, and can lead to 
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numerical problems when computing confidence limits, so several authors 

have recommended restricting   1. 

BMD Computation 

The appropriate relationship for the BMR is solved (see Continuous Models: 
BMD Computation) analytically. 

BMDL Computation 

The equations that define the benchmark response in terms of the benchmark 
dose and the dose-response model are solved for the slope. The resulting 
expression is substituted back into the model equations, with the effect of 
reparameterizing the model so that BMD appears explicitly as a parameter. A 
value for BMD is then found such that, when the remaining parameters are 
varied to maximize the likelihood, the resulting log-likelihood is less than that at 
the maximum likelihood estimates by exactly 

𝜒1,1−2𝛼
2

2
 

See also: 

 Continuous Models in General 

 Power Model Input File 

HILL CONTINUOUS MODEL 

Model Form 

The form of the Hill model is: 

𝛾 +
𝑣 ⋅ 𝑑𝑛

𝑘𝑛 + 𝑑𝑛
 

Parameters 

 Intercept (Control) =  

 Dose with half-maximal change = k (must be positive number) 

 Power = n (must be a positive number  18. If n is restricted, the number must 
be > 1.) 

 Maximum change = v 

Special Options 

 Restriction: When the “Restrict n > 1” box is checked, the power parameter 
will be estimated to be greater than or equal to 1. 
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BMD Computation 

The appropriate relationship for the BMR is solved analytically. 

BMDL Computation 

The BMR equation is used as a non-linear constraint, and the minimum value of 
BMD is determined such that the log-likelihood is equal to the log-likelihood at 
the maximum likelihood estimates less 

𝜒1,1−2𝛼
2

2
 

Warning  
BMDL estimates from models that have an asymptote parameter 
(including the Hill model) can be unstable when a wide range of parameter 
values can give nearly identical likelihoods. One indicator of that problem 
is that the estimated asymptotic response is far outside the range of the 
observed responses. The user should consult a statistician if this behavior 
is seen or suspected. 

See also: 

 Continuous Models in General 

 Hill Model Input File 

EXPONENTIAL CONTINUOUS MODEL 

Introduction 

Dr. Wout Slob of RIVM in The Netherlands has proposed a set of nested models 
known as the exponential models. Currently, these models should be fit only to 
data having positive (mean) values. 

There are four exponential models fit by BMDS and they are defined and labeled 
as follows. 

Model Form 

 Model 2: m(dose) = a*exp{sign*b*dose} 

 Model 3: m(dose) = a*exp{sign*(b*dose)d } 

 Model 4: m(dose) = a*(c-(c-1)*exp{-1*b*dose}) 

 Model 5: m(dose) = a*(c—(c-1)*exp{-1*(b*dose)d }) 

[Model 1, as defined by Dr. Slob, is the constant-mean model, called R in BMDS, 
which is estimated for every continuous data run.] 
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The parameter “sign” is the indicator of the direction of change: +1 for data 
trending up, -1 for data trending down. It is very important that the user correctly 
specify the direction of change in the data—for the Exponential Models the 
“automatic” choice of adverse direction has not been included. Some indicators 
that the wrong direction has been used for any given run include the observation 
that one or more models result in a flat curve fit, that optimal solutions for MLE 
parameters or BMDLs have not been obtained, and/or that the likelihoods 
associated with the models are much worse than models A1 to A3 (and are more 
like model R). 

Parameters 

For all the exponential models the following restrictions apply: 

 Background Response: a (> 0) 

 Slope: b (> 0) 

 Asymptote Parameter: c [Models 4 and 5 only] 

 c >1 for increasing data 

 0 < c < 1 for decreasing data 
 Power: d (> 1) [Models 3 and 5 only] 

Restrictions 

There are no restrictions beyond the parameter constraints shown above for 
each model. 

BMD Computation 

The appropriate relationship for the BMR is solved (see Continuous Models: 
BMD Computation) analytically. 

BMDL Computation 

The BMR equation (see Continuous Models: BMDL Computation) is used as a 
non-linear constraint, and the minimum value of BMD is determined such that the 
log-likelihood is equal to the log-likelihood at the maximum likelihood estimates 
less 

𝜒1,1−2𝛼
2

2
 

Warning  
BMDL estimates from models that have an asymptote parameter 
(including Exponential models 4 and 5) can be unstable when a wide 
range of parameter values can give nearly identical likelihoods. One 
indicator of that problem is that the estimated asymptotic response is far 
outside the range of the observed responses. The user should consult a 
statistician if this behavior is seen or suspected. 
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See also: 

 Continuous Models in General 

 Exponential Model Input File 

 Unique Options for Exponential Models 

DICHOTOMOUS MODEL DESCRIPTIONS 

Special Considerations for Models for Dichotomous Endpoints in Simple 
Designs 

BMDS includes in this category models for dichotomous endpoints in which the 
observations are independent of each other. In these models, the dose-response 
model provides the probability that an animal will have an adverse response at a 
given dose. The actual number of animals that have an adverse response is 
assumed to be binomially distributed. 

An example of such a dataset is a study in which adult animals are exposed to 
different concentrations of a toxicant and then evaluated for the presence of liver 
toxicity. For models for dichotomous endpoints in which the responses are 
nested (for example, pups in litters, and litters nested within doses), see the 
section Nested Model Descriptions. 

BMDS contains ten models for dichotomous endpoints (the Probit, Log-Probit, 
Logistic, Log-Logistic, Weibull, Quantal Linear, Gamma, Multistage, and 
Multistage-Cancer models). They may all be written in the form: 

Prob{response} =  + (1—)F(dose; , , …) 

Here F(dose; , , …) is a cumulative distribution function and , , , …, are 
parameters to be estimated using maximum likelihood methods. Sometimes 

Prob{response} is written as P[dose; , , , …] to indicate the relationship 
between the response probability and the dose as well as parameters. When the 

function F(dose; , , …) approaches zero as dose approach zero, the 

parameter  represents the background incidence. In the Logistic and Probit 
models, F(0) is not zero, unlike in the Log-Logistic and Log-Probit models. In 

these models,  is set to 0. 

Special Options for Models 

In addition to the options that are available to all dichotomous models, there may 
be model-specific options. Generally, these are options to restrict the legal range 
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of a parameter or set of parameters. The range of a parameter may be restricted 
for two reasons: 

 the slope of the dose-response curve becomes infinite at a dose of 0 if the 
parameter falls below 1, so that the default is to restrain that parameter to be 
at least 1, or 

 the quantal polynomial dose-response curve can become non-monotonic if 
the coefficients are allowed to be negative, often resulting in the curve looking 
“wavy”, so the default is to restrict the coefficients to be non-negative. 

The applicable special options are listed in the sections for the specific models. 

Likelihood Function 

All models in the current version of BMDS are fit using maximum likelihood 
methods. This section describes the likelihood function used to fit the 
dichotomous models. 

Suppose we employ k doses: 

𝑑𝑜𝑠𝑒1, 𝑑𝑜𝑠𝑒2, … 𝑑𝑜𝑠𝑒𝑘 

and the total number of s and number of responding s in each dose group are 

𝑁1, 𝑁2, …𝑁𝑘 

and, respectively, 

𝑛1, 𝑛2, … 𝑛𝑘 

The distribution of ni is assumed to be binomial with probability 

𝑝𝑖 = 𝑝(𝑑𝑜𝑠𝑒𝑖; Θ), 𝑖 = 1, 2, … , 𝑘 

where ϴ is a vector of parameters. Then the log-likelihood function L can be 
written as 

𝐿 =∑𝐿𝑖(𝑁𝑖, 𝑛𝑖 , 𝑑𝑜𝑠𝑒𝑖;  Θ)

𝑘

𝑖=1

 

where 

𝐿𝑖 = 𝑛𝑖 ln(𝑝𝑖) + (𝑁𝑖 − 𝑛𝑖) ln(1 − 𝑝𝑖) , 𝑖 = 1,2, … , 𝑘. 

The upper bound for the power parameter in the gamma and Weibull models, 
and the slope parameter for the log-probit and log-logistic models, has been 
(somewhat arbitrarily) set to 18. That value was selected because it represents a 
very high degree of curvature that should accommodate almost every data set, 
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even ones with very (or absolutely) flat dose-response at low doses followed by a 
very steep dose-response at higher doses. 

If the power parameter for the gamma or Weibull model, or the slope parameter 
for the log-probit or log-logistic model, is reported equal to 18 and the warning 
“…hit a bound…” appears, the parameter estimates are maximum likelihood 
estimates only in the restricted sense that the power parameter has been 
assigned a value and the other parameters are MLEs conditional on that 
assigned value. Such model results are not strictly comparable with others in 
terms of AIC. In such a case, the BMD and BMDL could depend on the choice of 
power parameter; thus, sensitivity analysis is indicated if one intends to rely on 
the reported BMD or BMDL. 

BMD Computation 

The BMD is computed as a function of the parameters of the model, which must 
have already been estimated. The BMDs for dichotomous models are expressed 
as the dose that would give an (estimated) increase in incidence of x% above the 
control incidence (where x is often in the range of 1 to 10 percent). This increase 
in incidence is referred to here as the “BMRF”, for benchmark response factor. 
Note that, although the word “response” is used here, we are really talking about 
an increase of the incidence over the control incidence (added risk). The actual 
response associated with the BMR, will only be the same as the BMR when P(0) 
= 0. This is because to obtain the actual response associated with the BMR one 
must solve for P(d) in the equation for added or extra risk. 

Two formulations for computing the excess over background are in common use, 
the extra risk model and the additional risk model. In the extra risk model, 

𝐵𝑀𝑅 =
𝑝(𝐵𝑀𝐷; 𝛾, 𝛼, 𝛽, … ) − 𝑝(0;  𝛾, 𝛼, 𝛽, … )

1 − 𝑝(0;  𝛾, 𝛼, 𝛽, … )
 

while in the additional risk model, 

𝐵𝑀𝑅 =  𝑝(𝐵𝑀𝐷; 𝛾, 𝛼, 𝛽, … ) − 𝑝(0;  𝛾, 𝛼, 𝛽, … ). 

The equation appropriate to the risk type formulation that the user requests is 
solved to get the BMD for a specific model and dataset. Details of this 
computation are included in the descriptions of the models. 

BMDL Computation 

BMDS currently calculates one-sided confidence intervals, in accordance with 
current BMD practice. 

Note  The Multistage and Multistage-Cancer models also calculate one-sided 
upper confidence limits. 
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The general approach to computing the confidence limit for the BMD (called the 
BMDL here) is the same for all the models in BMDS, and is based on the 
asymptotic distribution of the likelihood ratio (Crump and Howe, 1985). Two 
different approaches are followed in these models. In one, the equations that 
define the benchmark response in terms of the benchmark dose and the dose-
response model are solved for one of the model parameters. The resulting 
expression is substituted back into the model equations, with the effect of 
reparameterizing the model so that BMD appears explicitly as a parameter. A 
value for BMD is then found such that, when the remaining parameters are 
varied to maximize the likelihood, the resulting log-likelihood is less than that at 
the maximum likelihood estimates by exactly 

𝜒1,1−2𝛼
2

2
 

In a few models, it is impractical or impossible to explicitly reparameterize the 
dose-response model function to allow BMD to appear as an explicit parameter. 
For these models, the BMR equation is used as a non-linear constraint, and the 
minimum value of BMD is determined such that the log-likelihood is equal to the 
log-likelihood at the maximum likelihood estimates less 

𝜒1,1−2𝛼
2

2
 

See also: 

 Dichotomous Model Option Screens 

 Dichotomous—Text Output 

 Gamma Model—Description 

 Logistic Model—Description 

 Log-Logistic Model—Description 

 Multistage and Multistage-Cancer Model—Description 

 Probit Model—Description 

 Log-Probit Model—Description 

 Quantal Linear Model—Description 

 Weibull Model—Description 

 Optimization Algorithms Used In BMDS 
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GAMMA MODEL 

Model Form 

The Gamma Model formula is: 

Prob{𝑟𝑒𝑠𝑝𝑜𝑛𝑠𝑒} = 𝑝(𝑑𝑜𝑠𝑒; 𝛾, 𝛼, 𝛽) = 𝛾 + (1 − 𝛾) ⋅
1

Γ(α)
∫ 𝑡𝛼−1e−𝑡𝑑𝑡
𝛽𝑑𝑜𝑠𝑒

0

 

Here, 0 <  < 1,   0, and 18   > 0 with an option to restrict   1. 

Parameters 

 “background” is  (If specified or initialized, the background parameter must 
be a number > 0 and < 1.) 

 “power” is  (If specified or initialized, the Power parameter must be a positive 
number < 18. If Power is restricted, the number must be > 1.) 

 “slope” is  (If specified or initialized, the Slope parameter must be a number 
> 0. If Slope is restricted, the number must be > 1.) 

Restrict power  1 

Restrict   1. If  < 1, then the slope of the dose-response curve becomes 
infinite at the control dose. This is biologically unrealistic, and can lead to 
numerical problems when computing confidence limits, so several authors have 

recommended restricting   1 

BMD Computation 

Let 

𝐺(𝑥; 𝛼) =  
1

Γ(α)
∫ 𝑡𝛼−1e−𝑡𝑑𝑡
𝑥

0

 

be the incomplete Gamma function and 

𝐺−1(⋅; 𝛼) 

be its inverse function. Then 

𝐵𝑀𝐷 =

{
 
 

 
 
𝐺−1(𝐵𝑀𝑅; 𝛼)

𝛽
 extra risk

𝐺−1 (
𝐵𝑀𝑅
1 − 𝛾 ; 𝛼)

𝛽
  additional 
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BMDL Computation 

To calculate the BMDL, the defining equations for the BMD are solved for the 

slope parameter , which is then replaced in the original model equations. This 
makes BMD appear in the model equations as a parameter. See the section on 
Dichotomous Models' BMDL Computation for further details. 

See also: 

 Dichotomous Models Description 

 Gamma-hit Model Input File 

LOGISTIC MODEL 

Model Form 

The form of the probability function for the Logistic model is 

Prob{𝑟𝑒𝑠𝑝𝑜𝑛𝑠𝑒} = 𝑝(𝑑𝑜𝑠𝑒; 𝛼, 𝛽) =
1

1 + e−(𝛼+𝛽𝑑𝑜𝑠𝑒)
 

Parameters 

 “intercept” is  

 “slope” is  (If specified or initialized, the Slope parameter must be a number 
> 0. If Slope is restricted, the number must be > 1.) 

Special Options 

 None. 

BMD Computation 

The BMD estimate for the Logistic model is defined implicitly by the following 
equation. An iterative numerical method is used to determine the value of BMD: 

𝐵𝑀𝐷 = −
ln (

1 − 𝑍
1 + 𝑍𝑒−𝛼)

𝛽
 

where 

𝑍 = {
𝐵𝑀𝑅 x 

1 + 𝑒−𝛼

𝑒−𝛼 added risk 

𝐵𝑀𝑅 extra risk
 

BMDL Computation 

To calculate the BMDL, the defining equations for the BMD are solved for the 

intercept parameter , which is then replaced in the original model equations. 
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This makes BMD appear in the model equations as a parameter. See the section 
on Dichotomous Models' BMDL Computation for further details. 

Notes 

Occasionally, the following error message may appear for this model: “BMDL 
computation is at best imprecise for these data.” This is a flag that convergence 
for the BMDL was not “successful” in the sense that the required level of 
convergence (< 1e-3 relative change in the target function by the time the 
optimizer terminates) has not been achieved. 

See also: 

 Dichotomous Model Descriptions 

 Logistic and Log-Logistic Models Input File Format 

LOG-LOGISTIC MODEL 

Model Form 

The form of the probability function for the Log-Logistic model is 

if dose > 0: 

Prob{𝑟𝑒𝑠𝑝𝑜𝑛𝑠𝑒} = 𝑝(𝑑𝑜𝑠𝑒; 𝛾, 𝛼, 𝛽) = 𝛾 +
1 − 𝛾

1 + e−(𝛼+𝛽ln (𝑑𝑜𝑠𝑒))
, 

and if dose = 0: 

Prob{𝑟𝑒𝑠𝑝𝑜𝑛𝑠𝑒} = 𝑝(𝑑𝑜𝑠𝑒; 𝛾, 𝛼, 𝛽) = 𝛾; 

Here, 0 <  < 1,   0, and 18   > 0 (with an option to restrict   1). 

Parameters 

 “background” is  (If specified or initialized, the background parameter must 

be a number > 0 and  1.) 

 “intercept” is  

 “slope” is  (If specified or initialized, the Slope parameter must be a number 
> 0. If Slope is restricted, the number must be > 1.) 

Special Options 

 Restrict slope > 1: If the slope is allowed to be less than 1, the slope of the 
dose-response curve is infinite at zero dose. 

BMD Computation 

The BMD estimate for the Log-Logistic model is: 
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ln (𝐵𝑀𝐷) =

{
 
 

 
 ln (

𝐵𝑀𝑅
1 − 𝐵𝑀𝑅) − 𝛼

𝛽
 extra risk

ln (
𝐵𝑀𝑅

1 − 𝛾 − 𝐵𝑀𝑅) − 𝛼

𝛽
  added risk.

 

BMDL Computation 

To calculate the BMDL, the defining equations for the BMD are solved for the 

intercept parameter , which is then replaced in the original model equations. 
This makes BMD appear in the model equations as a parameter. See the section 
on Dichotomous Models' BMDL Computation for further details. 

See also: 

 Dichotomous Model Descriptions 

 Logistic and Log-Logistic Models Input File Format 

MULTISTAGE AND MULTISTAGE-CANCER MODEL 

Model Form 

The Multistage and Multistage-Cancer Model formula is: 

Prob{𝑟𝑒𝑠𝑝𝑜𝑛𝑠𝑒} = 𝑝(𝑑𝑜𝑠𝑒; 𝛾, 𝛽1, … , 𝛽𝑛) = 𝛾 + (1 − 𝛾) ⋅ (1 − 𝑒 −∑ 𝛽𝑗𝑑𝑜𝑠𝑒
𝑗

𝑛

𝑗=1
) 

Here, 0 <  < 1, and there is an option to restrict i > 0 for all is. The degree of 

the polynomial is n. The Multistage-Cancer model is exactly the same as the 

Multistage model except that the  parameters are always restricted to be 
positive (the Multistage model allows them to be positive or negative). 

Parameters 

 “Background” is  (If specified or initialized, the background parameter must 
be a number > 0 and < 1.) 

 Dose Coefficients (Beta1 …Betan) are >sub>1 …n 

Special Options 

 Degree Poly: The maximum degree polynomial to fit (maximum = 23). The 
degree must be a positive integer (typically less than the number of dose 
groups). 

 Restrict Betas >= 0: When this box is checked, the polynomial coefficients 
are restricted to be non-negative. This guarantees that the dose-response 
function will either be perfectly flat or always increasing, with no “bumps”. This 



Benchmark Dose Software (BMDS) User Guide  Model Descriptions 

BMDS version: 2.6.0.1 Page 167 of 310 Release Date: February 12, 2016 

restriction option is not available for the Multistage-Cancer model because it 
is always implemented for that model. 

BMD Computation 

There is no general analytic form for the BMD in terms of the BMR and the 
estimated model parameters for the multistage model. Instead, BMD is the root 
of the equation 

𝛽1𝐵𝑀𝐷 +⋯+ 𝛽𝑛𝐵𝑀𝐷
𝑛 + ln(1 − 𝐴) = 0 

where 

𝐴 = {
𝐵𝑀𝑅 extra risk

𝐵𝑀𝑅
1 − 𝛾  additional risk

 

BMDL Computation 

The BMR equation is used as a non-linear constraint, and the minimum value of 
BMD is determined such that the log-likelihood is equal to the log-likelihood at 
the maximum likelihood estimates less 

𝜒1,1−2𝛼
2

2
 

See also: 

 Dichotomous Model Descriptions 

 Multistage (Polynomial) Model Input File 

PROBIT MODEL 

Model Form 

The form of the probability function for the Probit model is 

Prob{𝑟𝑒𝑠𝑝𝑜𝑛𝑠𝑒} = 𝑝(𝑑𝑜𝑠𝑒, 𝛼, 𝛽) = Φ(𝛼 + 𝛽𝑑𝑜𝑠𝑒), 

where 

Φ(𝑥) = ∫ 𝜙(𝑡)𝑑𝑡
𝑥

−∞

 

and 

𝜙(𝑡) =
1

√2𝜋
𝑒−𝑡

2/2 
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(that is, ø is the standard normal density function, and  is the normal distribution 

function), 18    0 (with an option to restrict   1). 

Parameters 

 “intercept” is  

 “slope” is  (If specified or initialized, the Slope parameter must be a number 
> 0. If Slope is restricted, the number must be > 1.) 

Special Options 

 Log of Dose: This results in the Log-Probit model. 

 Restrict slope > 1 (Log-Probit only): if the slope is allowed to be less than 1, 
the slope of the dose-response curve is infinite at zero dose. 

 BMD Computation 

The BMD estimate for the Probit model is defined implicitly by the following 
equation. An iterative numerical method is used to determine the value of BMD: 

𝐵𝑀𝐷 =

{
 
 

 
 Φ

−1(𝐵𝑀𝑅[1 − Φ(𝛼)] + Φ(𝛼)) − 𝛼
𝛽

 extra risk

Φ−1(𝐵𝑀𝑅 +Φ(𝛼)) − 𝛼
𝛽

 added risk

 

BMDL Computation 

To calculate the BMDL, the defining equations for the BMD are solved for the 

intercept parameter , which is then replaced in the original model equations. 
This makes BMD appear in the model equations as a parameter. See the section 
on Dichotomous Models' BMDL Computation for further details. 

See also: 

 Dichotomous Model Descriptions 

 Probit and Log-Probit Models Input Files 

LOG-PROBIT MODEL 

Model Form 

The form of the probability function for the Log-Probit model is, if dose > 0: 

Prob{𝑟𝑒𝑠𝑝𝑜𝑛𝑠𝑒} = 𝑝(𝑑𝑜𝑠𝑒; 𝛾, 𝛼, 𝛽) = 𝛾 + (1 − 𝛾)Φ(𝛼 + 𝛽ln (𝑑𝑜𝑠𝑒)), 

and if dose = 0: 

Prob{𝑟𝑒𝑠𝑝𝑜𝑛𝑠𝑒} = 𝑝(𝑑𝑜𝑠𝑒; 𝛾, 𝛼, 𝛽) = 𝛾; 
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where 

Φ(𝑥) = ∫ 𝜙(𝑡)𝑑𝑡
𝑥

−∞

 

and 

𝜙(𝑡) =
1

√2𝜋
𝑒−𝑡

2/2 

(that is, ø is the standard normal density function, and  is the normal distribution 

function), 0 <  < 1, 18    0 (with an option to restrict   1). 

Parameters 

 “background” is  (If specified or initialized, the background parameter must 
be a number > 0 and < 1.) 

 “intercept” is  

 “slope” is  (If specified or initialized, the Slope parameter must be a number 
> 0. If Slope is restricted, the number must be > 1.) 

Special Options 

For the log-probit model, the slope of the model will approach zero as dose 
approaches zero. However, depending on the data and parameter estimates, the 
slope for the log-probit model, for some relatively low doses perhaps less than 
those corresponding to the BMR, the slope can be quite steep, which may be 
manifested in terms of a relatively low value for the BMDL (or perhaps an “NA” 
result for the BMDL if this causes convergence problems because the steepness 
entails BMDL estimates that get very small). 

BMD Computation 

The BMD estimate for the Log-Probit model is: 

ln(𝐵𝑀𝐷) =

{
 
 

 
 
Φ−1(𝐵𝑀𝑅) − 𝛼

𝛽
 extra risk

Φ−1 (
𝐵𝑀𝑅
1 − 𝛾) − 𝛼

𝛽
  added risk.

 

BMDL Computation 

To calculate the BMDL, the defining equations for the BMD are solved for the 

intercept parameter , which is then replaced in the original model equations. 
This makes BMD appear in the model equations as a parameter. See the section 
on Dichotomous Models' BMDL Computation for further details. 
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See also: 

 Dichotomous Model Descriptions 

 Probit and Log-Probit Models Input Files 

QUANTAL LINEAR MODEL 

Model Form 

The Quantal Linear model is a form of the Weibull model. The Weibull Model 
formula is: 

Prob{𝑟𝑒𝑠𝑝𝑜𝑛𝑠𝑒} = 𝑝(𝑑𝑜𝑠𝑒; 𝛾, 𝛼, 𝛽) = 𝛾 + (1 − 𝛾)(1 − 𝑒−𝛽𝑑𝑜𝑠𝑒
𝛼
 

The Quantal Linear model results from setting  equal to 1 in the Weibull Model. 

Parameters 

 “Background” is  (If specified or initialized, the background parameter must 
be a number > 0 and < 1.) 

 “Slope” is  (If specified or initialized, the Slope parameter must be a number 
> 0. If Slope is restricted, the number must be > 1.) 

 “Power” is  = 1 

Special Options 

None 

BMD Computation 

The BMD estimate for the Weibull model is: 

𝐵𝑀𝐷 =

{
 
 
 

 
 
 

[
−ln (1 − 𝐵𝑀𝑅)

𝛽
]

1
𝛼
 extra risk

[
−ln (1 −

𝐵𝑀𝑅
1 − 𝛾

𝛽
]

1
𝛼

 additional risk

 

BMD estimates for the quantal linear model is found by substituting 1 for α. 

BMDL Computation 

To calculate the BMDL, the defining equations for the BMD are solved for the 

slope parameter , which is then replaced in the original model equations. This 
makes BMD appear in the model equations as a parameter. See the section on 
Dichotomous Models' BMDL Computation for further details. 
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See also: 

 Dichotomous Model Descriptions 

 Quantal Linear Model Input File 

WEIBULL MODEL 

Model Form 

The Weibull Model formula is: 

Prob{𝑟𝑒𝑠𝑝𝑜𝑛𝑠𝑒} = 𝑝(𝑑𝑜𝑠𝑒; 𝛾, 𝛼, 𝛽) = 𝛾 + (1 − 𝛾)(1 − 𝑒−𝛽𝑑𝑜𝑠𝑒
𝛼
 

Here, 0 <  < 1,   0, and 18   > 0 with an option to restrict   1. 

Note  The Quantal Linear model results from setting  equal to 1 in the Weibull 
Model. 

Parameters 

 “Background” is  (If specified or initialized, the background parameter must 
be a number > 0 and < 1.) 

 “Slope” is  (If specified or initialized, the Slope parameter must be a number 
> 0.) 

 “Power” is  (If specified or initialized, the Power parameter must be a non-

negative number < 18. If Power is restricted, the number must be  1. If 
Power is unrestricted, the number must be greater than or equal to the value 
entered for the Lower Bound on Power (strictly greater than that bound if it is 
0). 

Special Options 

 Restrict power  1: Restrict   1. If  < 1, then the slope of the dose-
response curve becomes infinite at the control dose. This is biologically 
unrealistic, and can lead to numerical problems when computing confidence 

limits, so several authors have recommended restricting   1. 

BMD Computation 

The BMD estimate for the Weibull model is: 

𝐵𝑀𝐷 =

{
 
 
 

 
 
 

[
−ln (1 − 𝐵𝑀𝑅)

𝛽
]

1
𝛼
 extra risk

[
−ln (1 −

𝐵𝑀𝑅
1 − 𝛾

𝛽
]

1
𝛼

 additional risk
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BMDL Computation 

To calculate the BMDL, the defining equations for the BMD are solved for the 

slope parameter , which is then replaced in the original model equations. This 
makes BMD appear in the model equations as a parameter. See the section on 
Dichotomous Models' BMDL Computation for further details. 

See also: 

 Dichotomous Model Descriptions 

 Weibull Model Input File 

DICHOTOMOUS ALTERNATIVE MODEL DESCRIPTIONS 

Model Form 

The form of the probability function for the Dichotomous Hill model is: 

when d = 0, P[0, v, g, a, b] = v * g 

Parameter constraints: 

 0 < g < 1 

 0 < v < 1 

 b > 0 

Parameters 

  “v” is the maximum probability of response predicted by the model 

 “g” multiplied by v (v*g) is the background estimate of the maximum 
probability of response 

 “intercept” is a 

 “slope” is b (If specified or initialized, the Slope parameter must be a number 
> 0. If Slope is restricted, the number must be > 1.) 

 BMR must be a number > 0 and < 1 

Special Options 

  Restrict Slope ≥ 1: if the slope is allowed to be less than 1, the slope of the 
dose-response curve is infinite at zero dose. 

BMD Computation 

The BMD estimate for the Dichotomous Hill model is defined by the following 
equation. 
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Added risk: 

𝐵𝑀𝐷 = 𝑒
−𝑎 − 𝐿𝑜𝑔 [−

𝐵𝑀𝑅 − 𝑣 + 𝑔 ∗ 𝑣
𝐵𝑀 ]

𝑏
 

Extra risk: 

𝐵𝑀𝐷 = 𝑒
−𝑎 − 𝐿𝑜𝑔 [−

𝐵𝑀𝑅 − 𝑣 + 𝑔 ∗ 𝑣 − 𝐵𝑀𝑅 ∗ 𝑔 ∗ 𝑣
𝐵𝑀𝑅(−1 + 𝑔 ∗ 𝑣)

]

𝑏
 

BMDL Computation 

To calculate the BMDL, the defining equations for the BMD are solved for the 
intercept parameter. 

DICHOTOMOUS HILL MODEL 

Model Form 

The form of the probability function for the Dichotomous Hill model is: 

Prob{𝑟𝑒𝑠𝑝𝑜𝑛𝑠𝑒} = 𝑣 ∗ 𝑔 + (𝑣 − 𝑣 ∗ 𝑔)/[1 + exp (−𝑎 − 𝑏 ∗ ln(𝑑𝑜𝑠𝑒))] 

when d = 0, Prob{response} = v * g 

Parameters 

 “v” is the maximum probability of response predicted by the model (0 < v  1) 

 “g” multiplied by v (v*g) is the background estimate of the probability of 
response (the parameter g must be a number > 0 and < 1) 

 “intercept” is a 

 “slope” is b (If specified or initialized, the Slope parameter must be a number 
> 0. If Slope is restricted, the number must be > 1.) 

Special Options 

 Restrict Slope > 1: if the slope is allowed to be less than 1, the slope of the 
dose-response curve is infinite at zero dose. 

BMD Computation 

The BMD estimate for the Dichotomous Hill model is defined by the following 
equation. 
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Added risk: 

𝐵𝑀𝐷 = 𝑒
−𝑎 − log [−

𝐵𝑀𝑅 − 𝑣 + 𝑔 ∗ 𝑣
𝐵𝑀 ]

𝑏
 

Extra risk: 

𝐵𝑀𝐷 = 𝑒
−𝑎 − log [−

𝐵𝑀𝑅 − 𝑣 + 𝑔 ∗ 𝑣 − 𝐵𝑀𝑅 ∗ 𝑔 ∗ 𝑣
𝐵𝑀𝑅(−1 + 𝑔 ∗ 𝑣)

]

𝑏
 

BMDL Computation 

To calculate the BMDL, the defining equations for the BMD are solved for the 
intercept parameter α, which is then replaced in the original model equations. 
This makes BMD appear in the model equations as a parameter. See the section 
on Dichotomous Models' BMDL Computation for further details. 

Notes 

Occasionally, the following error message may appear for this model: “BMDL 
computation is at best imprecise for these data.” This is a flag that convergence 
for the BMDL was not “successful” in the sense that the required level of 
convergence (< 1e-3 relative change in the target function by the time the 
optimizer terminates) has not been achieved. 

QUANTAL MODELS WITH BACKGROUND DOSE PARAMETER 

Users should consult the Help file or this user guide for a specific model for 
details on that model. With a few obvious changes, those details apply also to 
models with a background dose parameter. 

Two Forms of Each Quantal Model 

For each of four 'traditional' quantal models in BMDS (multistage, log probit, 
gamma, and Weibull), alternative models were developed that incorporate a 
background dose parameter in place of a background response parameter. Such 
a model was also developed for the log logistic function but is not included in this 
release for technical reasons1. 

The “cancer model” is a version of the multistage model for which the user 
cannot relax the restriction on coefficients that requires them to be non-negative, 

                                                      
1 The log-logistic model with background dose parameter has an especially “flat” log-likelihood surface, 
making it difficult, for some datasets, for the software to converge to a maximum likelihood solution and 
especially difficult to solve the BMDL. In general, that model often fails to converge on a BMDL solution 
when the control response is larger than approximately 0.2—0.4. 
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and which reports the “cancer slope factor” (calculated as BMR/BMDL). A new 
version of this model is provided with a background dose parameter. 

The original logistic and probit models (without log-transformation of the dose) 
implicitly allow for a background dose effect, although a background dose 
parameter is not explicitly estimated. These models do not have a background 
response parameter. Thus, new versions of these models are provided which 

add an explicit background response parameter , increasing the number of 
parameters from two to three for these new models. 

Thus, for each type of quantal model in BMDS, there are now two alternative 
versions available, one with a background dose parameter and another with a 
background response parameter. 

The alternative forms of model can be represented as follows: 

Background response parameter, 𝛾: P(𝛽, x, 𝛾) = 𝛾 + (1 − 𝛾) ∗ F{𝛽, x} 

Background dose parameter, 𝜂: P(𝛽, x, 𝜂) = F{𝛽, (x + η)} 

Here, F{, x} represents the functional form specific to each model (multistage, 

logistic, etc.). F{, x} is a probability distribution function taking values between 0 
and 1 for positive dose values. For more details, see Table 27. In the background 

dose version of a model, parameter  is dropped and the parameter  is added. 

Table 27: Comparison of current BMDS quantal models with new models allowing a 
background dose or background response parameter. 

Model Name1 Functional Form of the Model Explicit  
Background 
Parameter 

Low Dose 
Linearity? 

#  
Parameter

s 

Multistage2 
𝛾 + (1 − 𝛾)[1 − exp {−∑𝛽𝑗𝑋

𝑗

𝑘

𝑓=1

}] 
 Yes, if 𝛽1 > 0 

No if 𝛽1 = 0 

1+k 

multistage_bgd 

1 − exp {−∑𝛽𝑗(𝑋 + 𝜂)
𝑗

𝑘

𝑓=1

} 
 Yes 1+k 

Logistic [1 + exp {−(𝛼 + βX)}]−1 None Yes 2 

logistic_bgr 𝛾 + (1 − 𝛾)[1 + exp {−(𝛼 + βX)}]−1  Yes 3 

Probit Φ {𝛼 + βX} None Yes 2 

probit_bgr 𝛾 + (1 − 𝛾) Φ {𝛼 + βX}  Yes 3 

Log_logistic 𝛾 + (1 − 𝛾)[1 + exp {−(𝛼 + βlog {X})}]−1  No 3 

log_logistic_bgd [1 + exp {−(𝛼 + βlog {X + η})}]−1  Yes 3 

Log_probit 𝛾 + (1 − 𝛾) Φ {𝛼 + βlog {X}}  No 3 
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Model Name1 Functional Form of the Model Explicit  
Background 
Parameter 

Low Dose 
Linearity? 

#  
Parameter

s 

log_probit_bgd Φ{𝛼 + β log{X + η}}  Yes 3 

Gamma 
𝛾 + (1 − 𝛾) [∫ 𝑡𝛼−1𝑒𝑡𝑑𝑡

𝛽x

−0

] / Γ(𝛼) 
 No3 3 

gamma_bgd G(𝛽(d + 𝜂), 𝛼)/Γ(𝛼) 

G is the incomplete gamma 
function 

 Yes 3 

Weibull 𝛾 + (1 − 𝛾)[1 − exp{−βX𝛼}]  No3 3 

weibull_bgd [1 − exp{−β(X + 𝜂)𝛼}]  Yes 3 

1 Names in regular type denote modules (i.e., *.exe files) that currently exist 

within BMDS. Names in italics denote alternative forms of the models with a new 
background parameter. 

2 The cancer model is identical to the multistage model except that   0 is 

enforced and the cancer slope factor is reported. 

3 If power parameter is > 1, slope  0 as dose  0; if power parameter is < 1, 

slope   as dose  0. 

Confidence Limits for the Benchmark Dose (BMD) 

The new models report both lower and upper confidence limits for the benchmark 
dose, that is, BMDL and BMDU. The confidence level selected by the user 
applies to a one-sided confidence limit (as for all the quantal models). Thus, if the 
user selects a 95% confidence level, “Confidence level = 0.95” is reported in the 
*.out file with the BMD, BMDL, and BMDU. This confidence level applies to a 
one-sided interval for BMD, e.g., [BMDL, ∞]. If the user reports the two-sided 
interval [BMDL, BMDU], the appropriate confidence level in this example is 90%; 
in general, if the user selects a confidence level 1-α, the two-sided interval has 
confidence level 1–2α.2

 

Parameter Constraints 

This section applies to BMDS quantal models generally and is not specific to the 
new versions of those models. Two sorts of constraints are applicable to the 
quantal models: natural constraints, which limit parameters to those values 

permitting 0 ≤ P(dose; , ) ≤ 1, and user-selectable constraints. The latter will 

                                                      
2  In some cases, the 2-sided confidence limits may have coverage larger than stated (e.g., greater than 
95%), because in some cases they may bound a collection of confidence regions rather than an unbroken 
interval. 
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default to standard settings in BMDS with no need for user actions. Examples of 
user-selectable constraints are restrictions on the multistage coefficients, which 
normally are required to be non-negative in order to provide a monotonically 
increasing dose response function, and a restriction on the power parameter of 
the gamma and Weibull models, which BMDS requires by default to be no 
smaller than 1. Natural parameter constraints are shown in the following table. 
Advice and observations on user-selectable constraints are provided in the 
Benchmark Dose Technical Guidance document. 

http://www.epa.gov/risk/benchmark-dose-technical-guidance
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Table 28: Natural parameter constraints in BMDS quantal models 

Model Name1 Functional Form of the Model Parameter Constraints 

Multistage2 
𝛾 + (1 − 𝛾)[1 − exp {−∑𝛽𝑗𝑋

𝑗

𝑘

𝑓=1

}] 
0 ≤ 𝛾 ≤ 1 

multistage_bgd2 

1 − exp {−∑𝛽𝑗(𝑋 + 𝜂)
𝑗

𝑘

𝑓=1

} 
𝜂 ≥ 0 

Logistic [1 + exp {−(𝛼 + βX)}]−1 −∞ < 𝛼 < +∞ , 𝛽 ≥ 0 

logistic_bgr 𝛾 + (1 − 𝛾)[1 + exp {−(𝛼 + βX)}]−1 −∞ < 𝛼 < +∞ , 𝛽 ≥ 0 

0 ≤ 𝛾 ≤ 1  

Probit Φ {𝛼 + βX} −∞ < 𝛼 < +∞ , 𝛽 ≥ 0 

probit_bgr 𝛾 + (1 − 𝛾) Φ {𝛼 + βX} −∞ < 𝛼 < +∞ , 𝛽 ≥ 0 

0 ≤ 𝛾 ≤ 1  

Log_logistic 𝛾 + (1 − 𝛾)[1 + exp {−(𝛼 + βlog {X})}]−1 −∞ < 𝛼 < +∞ , 𝛽 ≥ 0 

0 ≤ 𝛾 ≤ 1  

log_logistic_bgd [1 + exp {−(𝛼 + βlog {X + η})}]−1 −∞ < 𝛼 < +∞ , 𝛽 ≥ 0 

𝜂 ≥ 0  

Log_probit 𝛾 + (1 − 𝛾) Φ {𝛼 + βlog {X}} −∞ < 𝛼 < +∞ , 𝛽 ≥ 0 

0 ≤ 𝛾 ≤ 1  

log_probit_bgd Φ{𝛼 + β log{X + η}} −∞ < 𝛼 < +∞ , 𝛽 ≥ 0 

𝜂 ≥ 0  

Gamma 
𝛾 + (1 − 𝛾) [∫ 𝑡𝛼−1𝑒𝑡𝑑𝑡

𝛽x

−0

] / Γ(𝛼) 
𝛼 > 0 , 𝛽 ≥ 0 

0 ≤ 𝛾 ≤ 1  

gamma_bgd G(𝛽(d + 𝜂), 𝛼)/Γ(𝛼) 

G is the incomplete gamma function 

𝛼 > 0 , 𝛽 ≥ 0 

𝜂 ≥ 0  

Weibull 𝛾 + (1 − 𝛾)[1 − exp{−βX𝛼}] 𝛼 > 0 , 𝛽 ≥ 0 

0 ≤ 𝛾 ≤ 1 

weibull_bgd [1 − exp{−β(X + 𝜂)𝛼}] 𝛼 > 0 , 𝛽 ≥ 0 

𝜂 ≥ 0 

1 Names in regular type denote modules (i.e., *.exe files) that currently exist 

within BMDS. Names in italics denote modules that are new to BMDS and 
represent alternative forms of the models with a new background parameter. 

2 The cancer model is identical to the multistage model except that j  0 is 

enforced and the cancer slope factor is reported. 

In some cases, BMDS software will report that a parameter has “… hit a bound 
implied by some inequality constraint and thus has no standard error.” In that 
case, the printed parameter estimate will equal some natural or user-selectable 
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constraint (for example,  = 0 for multistage, or power =1 for gamma3). In such 
cases, the Wald confidence intervals for the other parameters are not even 
asymptotically correct.4 The 2-sided profile-likelihood confidence intervals for the 
BMD and Extra or Added Risk are asymptotically correct in such cases5. 
(However, whether or not a boundary has been “hit”, a 1- sided profile-likelihood 
confidence interval may not have the nominal coverage—if the nominal coverage 

is 1-, the asymptotic coverage for BMDL could be anything between 1 and 1–

2.) 

The upper bound for the power parameter in the gamma and Weibull models has 
been (somewhat arbitrarily) set to 18. That value was selected because it 
represents a very high degree of curvature that should accommodate almost 
every data set, even ones with very (or absolutely) flat dose-response at low 
doses followed by a very steep dose-response at higher doses. 

If the power parameter for the gamma or Weibull models is reported equal to 18 
and the warning “… hit a bound …” appears, the parameter estimates are 
maximum likelihood estimates only in the restricted sense that the power 
parameter has been assigned a value and the other parameters are MLEs 
conditional on that assigned value. Such model results are not strictly 
comparable with others in terms of AIC. In such a case, the BMD and BMDL 
could depend on the choice of power parameter; thus, sensitivity analysis is 
indicated if one intends to rely on the reported BMD or BMDL. 

Origin and Properties of Background Parameters 

The background response parameter has been said to represent “… independent 
action between the chemical and the background.” (NRC, 1980), or, in the case 
of cancer, “… carcinogens that cause a response of cancer in a way that is 
completely independent of the mechanisms by which the primary carcinogen 
causes a response.” (Crump et al., 1976). Thus, it has also been called an 
independent background (Crump et al., 1976; Hoel, 1980). The background dose 
parameter has been said to represent additivity between the applied dose of a 
chemical and the background (NRC, 1980), or to represent “… carcinogens 
(including spontaneous biochemical accidents) that somehow act in conjunction 
with the primary carcinogen …” (Crump et al., 1976). Thus, it has also been 
termed an additive background (Crump et al., 1976; Hoel, 1980). 

                                                      
3 There is also an arbitrary upper bound of 18 for the power parameter for the gamma and Weibull 
models. 
4 See G. Molenberghs and G. Verbeke (2007) American Statistician 61: 22–27; B. Sinha et al. technical 
report at http://www.math.umbc.edu/~kogan/technical_papers/index2007.html.; Self, S.S. and K-Y. Liang 
(1987) Asymptotic properties of maximum likelihood estimators and likelihood ratio tests under 
nonstandard conditions, J.Am. Stat. Assoc. 82: 605–610. 
5 B. Sinha et al. technical report at http://www.math.umbc.edu/~kogan/technical_papers/index2007.html. 
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Models with a background dose parameter will have an approximately linear 
response to dose at very low doses (Crump et al., 1976). Only some of the 
original quantal models will behave in this way (see Table 27). The specification 
of the background term can have a substantial influence over risk estimates 
made well below the range of experimental doses (Krewski and van Ryzin, 1981; 
NRC, 1980). The original logistic and probit models (without log-transformation of 
the dose) implicitly allow for a background dose effect, although a background 
dose parameter is not explicitly estimated, and these models exhibit low-dose 
linearity. The new versions of these models provide an explicit background 
response parameter, and also exhibit low-dose linearity. 

Model Behavior in Relation to Background Parameter 

The effects of the two sorts of background parameters,  and , are illustrated for 
the log-probit models: 

P(dose;  𝛾, 𝛼, 𝛽) = 𝛾 + (1 − 𝛾)Φ(𝛼 + 𝛽 log{X}) 

P(dose; 𝜂, 𝛼, 𝛽) = Φ(𝛼 + 𝛽 log{X + η}) 

Models with a background response parameter can represent the functional 

shape of F(dose; ) starting from a “floor” at P(0) =  (Figure 1). The response 
curve may appear sigmoidal, concave (“supralinear”), convex (“sublinear”) or 
nearly linear, depending on the values of the other parameters. 
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Figure 1.—Log-probit model with background response term, P(dose; , , ) =  + (1-) 

{ + *log(X)}. Here  = 2,  = 2, and  is varied from 0 to 0.4. 

Models with a background parameter additive to dose () can shift the response 

curve left or right (Figure 2), for fixed  (intercept) and  (slope). The background 
dose model can successfully fit datasets that appear concave (“supralinear”), 
appearing as if the response had been truncated on the left. Figure 2 also 
suggests that the background dose model may have difficulty fitting a convex or 
sigmoidal data pattern that begins with a high control response, but may be 
successful in fitting a linear to concave (supralinear) response that begins with a 
high response at zero dose. (In Figure 2, the other two parameters are fixed; 
however, experience with maximum likelihood fitting of various datasets suggests 
that these qualitative generalizations are correct). 
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Figure 2.—Log-probit model with background dose term. 

The background-dose parameter (η) was varied, taking values of 3 to 0 from left 

to right. For this plot,  = -0.1 and  = 1. This illustrates how increasing the 
background dose parameter shifts the response curve leftward (observed doses 
would of course be non-negative; the horizontal axis was extended to negative 
doses to illustrate the functional forms of these models). 

Figure 3 shows an example of fitting an artificial dataset generated using a 
known log-probit function. In this case, the two log-probit models fit equally well. 
They differ almost two-fold in BMDL, and of course one is linear at low doses and 
the other is sublinear. Figure 4 shows an example of fitting log-probit models to 
data generated using a log-logistic function, illustrating how the two models, 
differing in background parameter, will differ in the low-dose region. 
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Figure 3.—Log-probit model with background dose term fitted to data. 

The model P = ( + *(log(dose + )), with parameters  = 0.75,  = 0.1,  = 1, 
was used to generate probabilities for doses 0, 0.5, 1.0, 1.5, and 2.0. Expected 
numbers out of 50 animals were rounded to the nearest integer, giving numbers 
affected of 21, 31, 37, 41, and 43. The model was fitted to these artificial data, 

yielding estimated parameters  = 0.727918, a = 0.108666, b = 0.982273. The 
solid line shows the exact model used to generate the data, and the dashed line 
shows the estimated model. Circles show the data as observed proportions of 50 
animals affected. Goodness of fit statistics: Chi-square(2) = 0.01, P-value = 
0.9929. The log-probit model with background response was also fitted (Chi- 
square(2) = 0.01, P-value = 0.9942). These models predicted BMDL values of 
0.0216005 and 0.0126529, respectively, for extra risk 0.1 at the 95% level. 
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Figure 4.—Log-probit model with background dose term fitted to data. 

The log-logistic model P = 1/(- - *(log(dose + )), with parameters  = 1.5,  = 

-5,  = 10, was used to generate probabilities for doses 0, 0.25, 0.5, 0.75, and 
1.0. Expected numbers out of 50 animals were rounded to the nearest integer, 
giving numbers affected of 14, 32, 44, 48, and 49. The log-probit model with 
background dose was fitted to these artificial data, yielding estimated parameters 

 = 0.567585, a = 0.946006, and b = 2.71885. The solid line shows the log-
logistic model which generated the data. The dashed line shows the estimated 
log-probit model with background dose. The dotted line shows the estimated log-
probit model with background response. Circles show the data as observed 
proportions of 50 animals affected. Both log-probit models fit well (Chi-square 
goodness of fit statistic 0.21 and 0.03, resp.); they estimated BMDs of 0.044 and 
0.10, and BMDLs of 0.025 and 0.047, resp. 

Application 

The primary reason to apply and compare models differing in the background 
parameter is to better appraise model uncertainty and its implications, including 
uncertainty about low-dose linearity. Also, for users interested in the maximum 
likelihood estimate of a response at low doses and its confidence limits, it will be 
informative to compare these two types of models. Models with and without low-
dose linearity can differ greatly in the relative risk predicted at low doses (Krewski 
and van Ryzin, 1981; NRC, 1980). 

Some of the models with a background dose parameter may not fit data well, or 
may have trouble converging on a solution for the BMD or BMDL, when the 
observed response at zero dose is large (e.g., 20% to 50% of subjects or more) 
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and the dose-response pattern is unusual (either “flat” or non-monotonic at two or 
more doses). In other cases, especially when the control response probability is 
low, the two forms of model may fit a dataset almost equally well. In general, 
then, users are advised always to review the AIC and goodness-of-fit statistics 
(including the goodness-of-fit residuals) and to examine plots of the fitted model 
and data, before deciding whether any model, including a background dose 
model, fits the data adequately. 

Model Fitting and Model Selection Issues 

Some of the models with background dose parameter (gamma, Weibull, and log-
probit models) may fail to converge on a BMDL solution in one of two situations: 
(1) when the response data are not strictly increasing, and (2) when the response 
at zero dose is positive (especially when it is large, e.g., over 20%). 

When the response is not strictly increasing, most or all models may not fit well, 
and the following questions need to be considered: 

 Is the response lower at a high dose because a competing risk is removing 
animals before the response can occur? If so, should responses be adjusted 
to account for this?6 

 Is it reasonable to remove the high-dose group and fit a model to the reduced 
dataset? 

 Is the response inherently non-monotonic, requiring a different type of model? 

Advice on these questions is provided in the Benchmark Dose Technical 
Guidance document (on EPA's website: http://www.epa.gov/risk/benchmark-
dose-technical-guidance). 

When the response at zero dose is zero or very small, the models with 
background dose parameter are expected to produce a BMDL. Most cancers in 
rodent bioassays have zero or very low incidence in the control group.7 With 
such data, models with a background dose parameter provide a useful 
alternative to those background-response models (i.e., the log-probit, loglogistic, 
gamma and Weibull quantal models) that can have extreme slopes (zero or 

                                                      
6 Piegorsch, W.W. and A.J. Bailer (1997) Statistics for Environmental Biology and Toxicology, London: 
Chapman & Hall. Gart, J.J., K.C. Chu and R.E. Tarone (1979) Statistical issues in interpretation of chronic 
bioassay tests for carcinogenicity, J. Natl. Cancer Inst. 62: 957–974. Portier, C.J. and A.J. Bailer (1989) 
Testing for increased carcinogenicity using a survival-adjusted quantal response test, Fund. Appl. Toxicol. 
12: 731–737. Bailer, A.J. and C.J. Portier (1988) An illustration of dangers of ignoring survival differences 
in carcinogenic data, J. Appl. Toxicol. 8: 185–189. Kodell, R.L., D.W. Gaylor and J.J. Chen (1986) 
Standardized tumor rates for chronic bioassays, Biometrics 42: 867–873. 
7 Portier, C.J., J.C. Hedges and D.G. Hoel (1986) Age-specific models of mortality and tumor onset for 
historical control animals in the National Toxicology Program's carcinogenicity experiments, Cancer 
Research. 46: 4372–4378. Gaylor, D.W. (1992) Relationship between the shape of dose-response curves 
and background tumor rates. Reg. Toxicol. Pharmacol. 16: 2–9. 
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infinite) as dose nears zero. However, when the response at zero dose is large, 
BMDL solutions may fail for some background dose models and parameter 
standard errors may be unusually large. These are signs of problems with near-
non-identifiability of parameters and/or a very 'flat' and difficult-to solve 
likelihood.8 These should be taken as warning signs that the model is probably 
not suitable and that the model estimates should not be relied upon. 

A question of model selection could arise in comparing the traditional 2-
parameter probit or logistic to the new, 3-parameter, background response 
versions of these models. That is, the chi-square goodness of fit may be 
enhanced merely by the addition of a parameter. Two considerations are 
pertinent. First, if either the chi-square value or the AIC value is substantially 
smaller for one model, it is to be preferred. Second, if the model versions differ 
only slightly in this respect, the generally accepted practice is to prefer the model 
with fewer parameters, but if the models predict substantially different BMDLs, it 
seems best to acknowledge the uncertainty about the true model and its BMDL. 
It is possible to fit a 2-parameter version of the new background response logistic 
and probit models by specifying that the intercept parameter be set to zero. 
However, this is appropriate only when the data are consistent with a response 

probability of 0.5 or greater for the control (because F{=0,} ≥ 0.5 for dose ≥ 0). 
This 2-parameter model could be compared to the traditional logistic or probit 
model with 2 parameters, and the new background response model with 3 
parameters. 

Interpretation 

In some cases, similar models differing only in the type of background parameter 
(dose vs. response) may fit data almost equally well; even when they do not, 
there is no way to infer from mere curve-fitting which model is truer to reality. It is 
possible to invent even more models that might fit the data adequately but could 
suggest other interpretations. 

The motivation for the background dose parameter was to represent an external 
dose or internal process acting additively to the applied dose. The background 
dose parameter may, but does not necessarily, represent a background 
exposure to the chemical applied in a bioassay or its metabolites (e.g., possible 
exposure from food, water or air in addition to the experimental exposure). It 
could also represent the outcome of biological processes generating natural 
metabolites that act by the same mechanism or that interfere with natural 
mechanisms which inhibit the mechanism; still more hypotheses could be 
adduced. Thus, the background dose parameter should not be interpreted 

                                                      
8 One useful (but not infallible) diagnostic is to plot a suitable transformation of the empirical probabilities 
(p = y/n) against the dose metric. If the pattern can be fit well by a linear function, then problems with 
near-nonidentifiability (Seber and Wild 1989) may be anticipated when fitting the corresponding model 
with background dose. Transformations: for the log-probit or log-logistic model with background dose, the 
probits or logits of p; for the Weibull model with background dose, log(-log(1-p)). 
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literally as support for a particular mechanism unless there is independent 
evidence to support the particular mechanistic interpretation. Nevertheless, it 
seems natural to evaluate the fit of background dose models when there is 
independent evidence about pre-existing or ongoing background exposure. 

The background response parameter usually provides a close fit to the response 
of control animals if the overall model fit is good. As with the background dose 
parameter, one should beware of too literal an interpretation. The model could be 
interpreted literally to mean that a proportion γ of animals will have cancers of 

'natural' origin at every dose and that a proportion (1-) F(dose; ) of animals will 
have cancers attributable to the carcinogen. This clearly goes beyond the data 
and its support would require experiments especially designed to test this 
interpretation. 
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NESTED MODEL DESCRIPTIONS 

Special Considerations for Models for Nested Dichotomous Endpoints 

The most common application of the models in this section will be to 
developmental toxicology studies of organisms that have multiple offspring per 
litter, as do rodents. In these study designs, pregnant females (“dams”) are given 
one or several doses of a toxicant, and the fetuses, embryos, or term offspring 
(“pups”) are examined for signs of abnormal development. In such studies, it is 
usual for the responses of pups in the same litter to be more similar to each other 
than to the responses of pups in different litters (“intra-litter correlation”, or “litter 
effect”). Another way to describe the same phenomenon is that the variance 
among the proportion of pups affected in litters is greater than would be expected 
if the pups were responding completely independently of each other. 

The models in this section make available two approaches to this feature of 
developmental toxicology studies: they use a probability model that provides for 
extra inter-litter variance of the proportion of pups affected (the beta-binomial 
probability model: see the “Likelihood Function” section below); and they 
incorporate a litter-specific covariate that is expected to account for at least some 
of the extra inter-litter variance. This latter approach was introduced by Rai and 
Van Ryzin (1985), who reasoned that a covariate that took into account the 
condition of the dam before dosing might explain much of the observed litter 
effect. Those authors suggested that litter size would be an appropriate 
covariate. For the reasoning to apply strictly, the measure of litter size should not 
be affected by treatment; thus, in a study in which dosing begins after 
implantation, the number of implantation sites would seem to be an appropriate 
measure. On the other hand, the number of live fetuses in the litter at term would 
not be an appropriate measure if there is any dose-related prenatal death or 
resorption (this has apparently been ignored in most of the literature). 

Carr and Portier (1991), in a simulation study, warn that in situations in which 
there is no effect of litter size, statistical models that incorporate a litter size 
parameter, as do the models in BMDS, will often erroneously indicate that there 
is a litter size effect. Thus, the user should use litter size parameters with caution. 
Unfortunately, there are currently no good diagnostics for determining whether a 
litter size effect actually exists. 

Likelihood Function 

Let g represent the number of dose groups. For the ith group, there are ni 

pregnant females administered dose dosei. In the jth litter of the ith dose group 

there are sij fetuses, xij affected fetuses, and, potentially, a litter-specific 

covariate rij which will often be a measure of potential litter size, such as number 

of implantation sites, though this is not a requirement of the models. In what 
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follows, the dose-response model, which gives the probability that a fetus in the 
jth litter of the ith dose group will be affected is represented by 

𝑝(𝑑𝑜𝑠𝑒𝑖 , 𝑟𝑖𝑗) 

The beta-binomial distribution can be thought of as resulting from sampling in two 

stages. First, each litter is assigned a probability, Pij from a beta distribution 

(beta distributions represent a two parameter family of probability distributions 
defined on the interval (0,1)). The parameters of the beta distribution are 

determined by the administered dose, the litter specific covariate rij and the 

degree of intra-litter correlation, vi . Note that the intra-litter correlation parameter 

varies among doses. It is well known (Williams et al., 1988) that when the true 
intra-litter correlation differs among doses, unbiased estimates of the other 
parameters in a dose-response model can only be obtained if dose-specific intra-

litter correlation parameters are estimated. As a special case, if vi =0, then this 

part of the process is completely deterministic, and 

𝑃𝑖𝑗 = 𝑝(𝑑𝑜𝑠𝑒𝑖, 𝑟𝑖𝑗) 

This allows for the possibility of no litter effect at all. 

In the second stage of sampling, sij fetuses are assigned to the litter, and the 

number of affected fetuses, xij is sampled from a binomial distribution with 

parameters Pij and sij . 

The log-likelihood function that results from this process is: 

L =∑{∑[∑ln(𝑝(𝑑𝑜𝑠𝑒𝑖, 𝑟𝑖𝑗) + (𝑘 − 1)𝜓𝑖) +

𝑥𝑖𝑗

𝑘=1

𝑛𝑖

𝑗=1

𝑔

𝑖=1

 

∑ ln(1 − 𝑝(𝑑𝑜𝑠𝑒𝑖, 𝑟𝑖𝑗) + (𝑘 − 1)𝜓𝑖) −

𝑠𝑖𝑗−𝑥𝑖𝑗

𝑘=1

 

∑ln(1 + (𝑘 − 1)𝜓𝑖),

𝑠𝑖𝑗

𝑘=1

 

where 

𝜓𝑖 =
𝜙𝑖

1 − 𝜙𝑖
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and 

∑(. ) = 0

𝑏

𝑎

 

if a > b by convention. 

Goodness of Fit Information—Litter Data 

The “Litter Data” table provides a listing of the data, expected and observed 
responses and scaled residuals, for each litter. 

The scaled residual values printed in the last column of the table are defined as 
follows: 

(Obs.—Expected)/SE 

where “Expected” is the predicted number of responders from the model and SE 
equals the estimated standard error of that predicted number. For these models, 

the estimated standard error is equal to sqrt[n*p*(1-p)*(*(n-1)+1)], where 

 n is the sample (litter) size, 

 p is the model-predicted probability of response, and 

 f is the model-predicted intra-litter correlation coefficient. 

The overall model should be called into question if the scaled residual values for 
several individual dose and litter-specific covariate combinations, particularly for 
a dose group near the BMD and for litter-specific covariate values close to the 
overall mean, are greater than 2 or less than -2. 

The goodness-of-fit p-values are calculated using a bootstrap approach. 

1. The MLE parameter values are used to generate B pseudo-datasets 
having the same design features (number of doses and number of litters 
per dose), litter-sizes, and, if necessary, litter-specific covariate values, as 
the original dataset. What varies from pseudo-dataset to pseudo-dataset 
are the number of responding “units” within litters, and those are 
generated, at random, as dictated by the values of the ML estimates. 

2. Once the B bootstrap iterations are generated, a statistic referred to as 
chi-square is calculated for each. The chi-square statistic is the sum of the 
squares of the scaled residuals for each litter, as described above. Higher 
values of that statistic are indicative of poorer match between the model 
predictions and the data. 
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Note The chi-square statistic is so called here because, in traditional testing 
situations, that statistic would be approximated by a chi-squared random 
variable have a certain degrees of freedom, and its “significance” (p-value) 
would be determined from the appropriate chi-squared distribution 
function. 

3. The chi-square statistic from the original data is computed and compared 
to the values from the B bootstrap iterations. The p-value is the proportion 
of chi-square values from the iterations that are greater than the original 
chi-square value.  
 
High p-values are indicative of adequate fit (i.e., there was a high 
proportion of chi-square values associated with pseudo-datasets obtained 
from data known to be consistent with the model and the ML estimates of 
the model parameters). 

That calculation is repeated three times, and various percentiles of the generated 
chi-square statistic are presented. This allows the user to determine if enough 
bootstrap iterations (B) have been specified. The default for B is 1000 and should 
probably not be reduced. The user may wish to increase the default (via the 
Nested Model Option Screen) if the percentiles for chi-square differ markedly 
across the three runs (in particular the median and lower percentiles), or if the p-
values calculated from the three runs differ markedly. This may only be an issue 
when the p-value is close to the value (e.g., 0.05 or 0.10) used as a critical value 
for deciding whether or not the fit of the model to the data is adequate. If there is 
some variability in the p-values, but they are all greater than 0.20, for example, 
then one probably need not worry about increasing the value for B. 

BMD Computation 

BMD computation is similar to that for dichotomous models with the added 
wrinkle that a value for the litter-specific covariate is required. The user has the 
option of specifying either the control group mean of the covariate, or the overall 
mean. In most cases, the overall mean should be preferred, if the covariate is not 
expected to be affected by dose. If the covariate is affected by dose, then it 
should probably not be used. 

BMDL Computation 

BMDS currently only calculates one-sided confidence intervals, in accordance 
with current BMD practice. The general approach to computing the confidence 
limit for the BMD (called the BMDL here) is the same for all the models in BMDS, 
and is based on the asymptotic distribution of the likelihood ratio (Crump and 
Howe, 1985). 

The approach used for all the nested dichotomous models is the same. The 
equations that define the benchmark response in terms of the benchmark dose 
and the dose-response model are solved for one of the model parameters, using 
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either the control group mean or the overall mean of the litter-specific covariate. 
The resulting expression is substituted back into the model equations, with the 
effect of re-parameterizing the model so that BMD appears explicitly as a 
parameter. A value for BMD is then found such that, when the remaining 
parameters are varied to maximize the likelihood, the resulting log-likelihood is 
less than that at the maximum likelihood estimates by exactly 

𝑥1,1−2𝛼
2

2
 

See also: 

 Nested Models Option Screens 

 Nested Model Options Fields 

 Nested Models—Text Output 

 Logistic Nested Model Description 

 NCTR Model Description 

 Rai and Van Ryzin Model Description 

 Optimization Algorithms Used In BMDS 

LOGISTIC NESTED MODEL 

Model Form 

The Nested Logistic Model is the log-logistic model, modified to include a litter-
specific covariate. The model form for the Nested Logistic Model is: 

Prob{𝑟𝑒𝑠𝑝𝑜𝑛𝑠𝑒} =  
𝛼 + 𝜃1𝑟𝑖𝑗 + (1 − 𝛼 − 𝜃1𝑟𝑖𝑗)

(1 + exp[−𝛽 − 𝜃2𝑟𝑖𝑗 − 𝜌 ∗ ln(𝑑𝑜𝑠𝑒)])
 

if dose > 0, and  + 1rij if dose = 0. 

In the above equation, rij is the litter-specific covariate for the jth litter in the ith 

dose group;   0,   0,  0 with an option to restrict  1; and 1>  + 1 rij  0 

for every rij . 

In addition there are g intra-litter correlation coefficients, 0  i  1 (i = 1, …, g). 

Parameters 

 Intercept =  
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 Power =  

 Slope =  

 First coefficient for litter-specific covariate = 1 

 Second coefficient for liter-specific covariate = 2 

 Intralitter correlation coefficients = 1…g (If  is specified or initialized,  

must be a number > 0 and < 1.) 

Special Options 

 Restriction: Power parameter  (rho) can be restricted to be  1 (Default) 

Risk Type 

Choices are “Extra” or “Added.” Additional risk is the additional expected 
proportion of total animals that respond in the presence of the dose, or the mean 
probability of response at dose d, P(d), minus the mean probability of response in 
the absence of exposure, P(0). Extra risk is the additional risk divided by the 
expected proportion of animals that will not respond in the absence of exposure, 
1—P(0). Thus, extra and additional risk are equal when the expected background 
rate is zero. 

BMD Computation 

If rm represents either the control mean value for the litter-specific covariate or its 

overall mean, then the BMD is computed as: 

𝐵𝑀𝐷 = exp{
ln (

𝐴
1 − 𝐴) − 𝛽 − 𝜃2𝑟𝑚

𝜌
} 

where 

A  = BMRF  for extra risk 

 = BMRF/(1—a—1rm ) for added risk 

BMDL Computation 

The parameter  is replaced with an expression derived from the BMD definition 
(above) in the dose-response function, with the effect of reparameterizing the 
model so that BMD appears explicitly as a parameter. A value for BMD is then 
found such that, when the remaining parameters are varied to maximize the 
likelihood, the resulting log-likelihood is less than that at the maximum likelihood 
estimates by exactly 

𝑥1,1−2𝛼
2

2
 



Benchmark Dose Software (BMDS) User Guide  Model Descriptions 

BMDS version: 2.6.0.1 Page 194 of 310 Release Date: February 12, 2016 

See also: 

 Nested Model Descriptions 

 Nested Model Options Fields 

 Nested Logistic Model Input File 

NCTR MODEL 

Model Form 

The NCTR model is a Weibull model modified to include a litter-specific 
covariate. The model form is: 

Prob{𝑟𝑒𝑠𝑝𝑜𝑛𝑠𝑒} = 1 − exp {−(𝛼 + 𝜃1(𝑟𝑖𝑗 − 𝑟𝑚))− (𝛽 + 𝜃2(𝑟𝑖𝑗 − 𝑟𝑚)) 𝑑𝑜𝑠𝑒
𝜌} 

where rij is the litter-specific covariate for the jth litter in the ith dose group, rm is 

the overall mean for the litter-specific covariate,   0,   0,   0 with an option 

to restrict   1, and 

𝜃1(𝑟𝑖𝑗 − 𝑟𝑚) ≥ 0 and 𝜃2(𝑟𝑖𝑗 − 𝑟𝑚) ≥ 0 

for every rij. 

In addition there are g intra-litter correlation coefficients, 0  i  1 (i = 1,…, g). 

Parameters

 Intercept =  

 Power =  

 Slope =  

 First coefficient for litter-specific covariate = 1 

 Second coefficient for liter-specific covariate = 2 

 Intralitter correlation coefficients = 1 …g (If  is specified or initialized,  

must be a number > 0 and < 1.) 

Special Options 

 Restriction: Power parameter  (rho) can be restricted to be > 1 (Default) 

Risk Type 

Choices are “Extra” or “Added.” Additional risk is the additional proportion of total 
animals that respond in the presence of the dose, or the probability of response 
at dose d, P(d), minus the probability of response in the absence of exposure, 
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P(0). Extra risk is the additional risk divided by the proportion of animals that will 
not respond in the absence of exposure, 1—P(0). Thus, extra and additional risk 
are equal when background rate is zero. 

BMD Computation 

𝐵𝑀𝐷 = [−
ln(1 − 𝐴)

𝛽 + 𝜃2𝛿𝑟
] (
1

𝜌
) 

where r is the average of (rij—rm ) over either the control group or over all 

observations, depending upon the option selected for “Fixed Litter Size” (when 

using the overall mean, r is always 0), and 

A  = BMRF for extra risk 

 = BMRF/(1-- 1 r ) for added risk 

BMDL Computation 

The parameter  is replaced with an expression derived from the BMD definition 
(above) in the dose-response function, with the effect of reparametrizing the 
model so that BMD appears explicitly as a parameter. A value for BMD is then 
found such that, when the remaining parameters are varied to maximize the 
likelihood, the resulting log-likelihood is less than that at the maximum likelihood 
estimates by exactly 

𝑥1,1−2𝛼
2

2
 

See also: 

 Nested Model Descriptions 

 NCTR Model Input File Format 

RAI AND VAN RYZIN MODEL 

Model Form 

The Rai and Van Ryzin model is a Weibull model modified to include a litter-
specific covariate. The model form is: 

Prob{𝑟𝑒𝑠𝑝𝑜𝑛𝑠𝑒} = [1 − exp{−𝛼 − 𝛽 ⋅ dose𝜌}] ⋅ exp{−(𝜃1 + 𝜃2dose) ⋅ 𝑟𝑖𝑗} 

where rij is the litter-specific covariate for the jth litter in the ith dose group,   

0,   0,   0 with an option to restrict   1, and 
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𝜃1 + 𝜃2𝑑𝑜𝑠𝑒𝑗 > 0, for all doses (i = 1, …, g). 

In addition there are g intra-litter correlation coefficients, 0 < i < 1 (i = 1, …, g). 

This is a generalization of the model described in Rai and Van Ryzin (1985) by 

the addition of the power parameter, . To get the conventional Rai and Van 
Ryzin model, fix the power parameter to 1. 

Parameters 

 Intercept =  

 Power =  

 Slope =  

 First coefficient of litter-specific covariate = 1 

 Second coefficient of litter-specific covariate =2 

 Intralitter correlation coefficients = 1 …g (If  is specified or initialized,  

must be a number > 0 and < 1.) 

Special Options 

 Restriction: Power parameter  (rho) can be restricted to be > 1 (Default) 

Risk Type 

Choices are “Extra” or “Added.” Additional risk is the additional proportion of total 
animals that respond in the presence of the dose, or the probability of response 
at dose d, P(d), minus the probability of response in the absence of exposure, 
P(0). Extra risk is the additional risk divided by the proportion of animals that will 
not respond in the absence of exposure, 1—P(0). Thus, extra and additional risk 
are equal when background rate is zero. 

BMD Computation 

The BMR formulas are solved numerically for the BMD. 

BMDL Computation 

The parameter  is replaced with an expression derived from the BMD definition 
in the dose-response function, with the effect of reparameterizing the model so 
that BMD appears explicitly as a parameter. A value for BMD is then found such 
that, when the remaining parameters are varied to maximize the likelihood, the 
resulting log-likelihood is less than that at the maximum likelihood estimates by 
exactly 

𝑥1,1−2𝛼
2

2
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See also: 

 Nested Model Descriptions 

 Ray and Van Ryzin Model Input File 

REPEATED RESPONSE MEASURES MODEL DESCRIPTION 

Model Form 

The Repeated Response Measures model has the following form for describing 
the time course of responses before and after an exposure to a dose: 

𝜂(𝑑, 𝑡) =
𝐴(𝑡) + 𝐵 ⋅ 𝑡 ⋅ 𝑑 ⋅ exp (−𝑘 ⋅ 𝑡)

(1 + 𝐶 ⋅ 𝑑 ⋅ 𝑡 ⋅ exp (−𝑘 ⋅ 𝑡))
 

where 

A(t) = A0 ,or 

A(t) = A0 + A1 t ,or 

A(t) = A0—A1 t + A2 t2 

depending on the “background degree” specified by the user. A(t) applies before 
exposure and for all times in the absence of exposure (or to “sham” exposures to 
dose=0). Thus the Repeated Response Measures model is applicable to data 
with the following characteristics: 

 An outcome (response variable) measured on a continuous scale. 

 Single exposure (or exposure interval), to several (4–5 recommended) “dose” 
levels. 

 Duration of the experiment (the time component) coded between 0 and a 
maximum positive value, with 0 being the beginning and the maximum 
positive value the last time point at which data are available. The time at 
which exposure took place must be known and coded by a value between 0 
and the maximum value. 

 The outcome is observed (and recorded) repeatedly over time on each study 
subject; the timing of the observation is given. It is not required, however, that 
each subject (experimental unit) yield an equal number of observations at the 
same time points. 

 Observations should not be aggregated over subject, and data must be 
identifiable with each subject. 

 Multiple subjects per dose group. 
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 Dose effects are preferably observed at more than one dose level. 

 Differences in dose effects are seen at some time points. 

The model fitting is accomplished by maximizing the likelihood of the data, 

assuming a random effects model for the parameter A0 (normally distributed 

across individuals) and a normal error distribution (observations are normally 
distributed around the model-predicted individual-, dose-, and time-specific 
means). 

Parameters 

 Background parameters = A0 , A1 , A2 

 Time-course parameters = B, C, k 

Special Options 

 None 

Risk Type 

Risk is defined in terms of added or extra risk. Because the Repeated Response 
Measures model is for continuous responses, this requires specification of 
response levels that are considered adverse. That is done in one of two ways. 
First, the assumed background rate (probability) of adverse response may be 
specified; in that case the cut-off(s) that yield that probability of response are 
determined from the fit of the model. Second, the cut-off value(s) may be 
specified directly; that yields an estimated background rate of response once the 
model is fit. In either case, the extra or added risk is calculated for any dose (and 
time) based on the model-predicted increase in the proportion of responses 
beyond the cut-off(s). 

BMD Computation 

The BMD output from a Repeated Response Measures model run is the lowest 
dose for which, at some time after exposure, the extra or added risk is equal to 
the BMR Risk Level specified by the user. Note that because the response rates 
vary over time, there will be several dose levels that yield the BMR response at 
various time points. The minimum of those doses is the reported minimum BMD. 

BMDL Computation 

The BMDL is estimated via bootstrap resampling of residuals and random 
effects. The residuals and random effects are estimated from the original fitting of 
the model. They are resampled (within or across dose groups) treating the vector 
of residuals for an individual as the sampling unit if need be. BMDs are 
calculated as discussed above for each set of bootstrapped observations. The 
percentiles over all the bootstrapped BMDs are used to define confidence 
bounds for the BMD (e.g., the 5th percentile would be reported as the 95% lower 
bound on the BMD). 
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References 

For more information, see Zhu, Y., Jia, Z., Wang, W., Gift, J., Moser, V.C., and 
B.J. Pierre-Louis (2005), “Data Analysis of Neurobehavioral Screening Data: 
Benchmark Dose Estimation.” Regulatory Toxicology and Pharmacology, pp 
190–201. 

See also: 

Repeated Response Measures 

CONCENTRATION X TIME MODEL DESCRIPTION 

Model Form 

There is only one Concentration x Time model currently in BMDS, which has the 
following form: 

Prob{𝑟𝑒𝑠𝑝𝑜𝑛𝑠𝑒} = ℎ(𝑧) 

where h() is either the logit or the probit function 

ℎ(𝑧) =
exp (𝑧)

(1+exp(𝑧))
   for Logit link function 

ℎ(𝑧) =  𝜑(𝑧 − 5)   for Probit link function. 

and () is the standard normal cumulative distribution function. The variable z is 
a linear function of the terms in the model as follows: 

𝑧 = 𝐵0 +𝐵1 ∗ 𝑓𝐶(𝐶) + 𝐵2 ∗ 𝑓𝑇(𝑇) + 𝐵3 ∗ 𝑓𝑥(𝑥) + 𝐵4 ∗ 𝑟4(𝐶, 𝑇, 𝑥) + 𝐵5 ∗ 𝑟5(𝐶, 𝑇, 𝑥) + ⋯ 

where 

fi (u) = transformation of concentration (i=C), time (i=T), or covariate (i=x); 

rj (C, T, x) = interactions (products) of the fC (C), fT (T), and fx (x) terms. 

The fi transformations that have been implemented are described in . 

Table 29: fi(u) transformations implemented in BMDS  

fi(u) = Transformation 

u Identity 

ln(u) Logarithmic 

1/u Reciprocal 
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Note that the covariable “x” is actually a place holder for any number of possible 
explanatory variables of interest (think of x as a vector of variables above and 
beyond the C and T variables). 

Parameters 

 Intercept = B0 

 Coefficients of the model terms = B1 , …, Bn 

Currently the BMDS version of the model allows up to five main effects variables 
and three product terms, so that n ≤ 8. 

Special Options 

None 

Risk Type 

There are no specific risk type choices. The model calculates a concentration (or 
the value of any other variable) given the values of the other variables in the 
model such that the probability of response is equal to some specified value. If 
the background probability is 0, as it would be if the logarithmic transformation is 
used for all the explanatory variables in the model, then the probability of 
response for a set of values for the model variables is equal to the added or extra 
risk for that set of values. 

BMD Computation 

The BMD (concentration yielding a specific probability of response, given the 
values of the other model variables) is computed numerically from the set of MLE 
parameter values. 

BMDL Computation 

A Wald-type confidence interval is determined for all model parameters (including 
the “BMD” as defined above). The confidence bounds determined in this manner 
for the BMD yield the BMDL (and a BMDU, an upper bound on the BMD). The 
user must specify a deviate value corresponding to the confidence level of 
interest; this deviate can be determined from the standard normal distribution or, 
perhaps more appropriately, from a T distribution with degrees of freedom 
determined from the number of observations and the number of fitted 
parameters. 

Graphics 

Note about model graphics: because the graphical representation of the 
Concentration x Time modeling results is quite different from that obtained from 
other BMDS models, the current version of BMDS does not include a direct 
graphical output for the Concentration x Time model. However, an Excel 
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spreadsheet tool is available that allows users desiring graphical outputs to 
create plots of: 

 Contours of response probabilities on the Concentration-Time plane: the 
contour for a chosen probability of response shows the curve for the 
combinations of concentration and time that yield the chosen probability or 
response (conditional on the values of other covariates in the model, set by 
the user). 

 The probability of response (y-axis) as a function of either concentration or 
time (x-axis), fixing the other variable (and the other covariates in the model) 
at values of the user's choice. 

See Also: 

 Concentration x Time Model Option Screen 

 Concentration x Time Data 

MULTITUMOR (MS_COMBO) MODEL DESCRIPTION 

The purpose of the MS_Combo program in BMDS is to allow the user to 
calculate BMDs and BMDLs for a combination of tumors (corresponding to a 
defined risk of getting one or more of those tumors) when the individual tumor 
dose-responses have been modeled using a Multistage-Cancer model. 

Thus, the output of an MS_Combo run will present the results of fitting each 
individual tumor (including the BMD and BMDL for that tumor) plus the combined 
log-likelihood, BMD and BMDL for the combination of specified tumor responses. 

In practice, the user should investigate each tumor individually and determine 
which degree of the Multistage-Cancer model is most appropriate for each 
individual tumor. That determination will involve all the usual considerations of fit, 
AIC, etc. 

Once a specific form of the Multistage-Cancer model is chosen for each of the 
tumors of interest (they need not have the same degree across all of the tumors 
in question), the user should specify those choices in the MS_Combo run. 

Note The following descriptions are valid only when the tumors are assumed to 
be independent of one another (conditional on dose level). 

Because of the form of the multistage model, the MLE estimates for the 
combined risk are a function of the parameter values obtained for the individual 
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tumor multistage model fits. In fact, the combined probability function has a 
multistage model form: 

𝑃(𝑑) = 1 − exp{−(𝛽0 + 𝛽1𝑑 + 𝛽2𝑑2 +⋯)} 

and the terms of the combined probability function (0, 1, …) are specified as 
follows 

𝛽0 =∑𝛽0𝑖 

𝛽1 =∑𝛽1𝑖 

𝛽2 =∑𝛽2𝑖 

etc. 

where the sums are over i = 1, …, t, with 

 t being the number of tumors under consideration, and 

 xj being the xth parameter (0, 1, …) for tumor j. 

The xj values are available directly from the Multistage-Cancer runs performed 

on the individual tumors, but MS_Combo performs the calculations for the user, 
completing the summations of the individual terms and computing the BMD 
based on the combined parameter values and the user-specified BMR. 

A profile-likelihood approach is used to derive the BMDL. 

 Given the BMD and the log-likelihood associated with the MLE solution, a 
target likelihood is defined based on the user-specified confidence level (e.g., 
95%). 

 That target likelihood is derived by computing the percentile of a chi-square (1 
degree of freedom) corresponding to the confidence level specified by the 
user (actually, the alpha associated with the confidence level, times 2). 

 That percentile is divided by 2 and subtracted from the maximum log-
likelihood. 

 That derivation is based on a likelihood ratio test with one degree of freedom; 
it can be shown that estimating the BMDL corresponds to losing one degree 
of freedom, regardless of the number of tumors being combined. 



Benchmark Dose Software (BMDS) User Guide  Model Descriptions 

BMDS version: 2.6.0.1 Page 203 of 310 Release Date: February 12, 2016 

The BMDL for the combined response (one or more of the tumors of interest) is 
defined as the smallest dose, D, for which the following two conditions are 
satisfied: 

 There is a set of parameters such that the combined log-likelihood using D 
and those parameters is greater than or equal to the target likelihood), and 

 For that set of parameters, the risk at D is equal to the user-specified BMR. 

Note that the combined log-likelihood is a function of the fits of the individual 
tumors (the sum of the individual log-likelihoods), obtained using their tumor-

specific  values. Thus, the search for the parameters of the combined 

Multistage-Cancer model varies the individual-tumor  values in such a way that 
the individual log-likelihoods add up to a combined likelihood within the range 
desired (greater than or equal to the target). However, in order to satisfy the 
second constraint, the sums of the individual-tumor parameters (shown above to 
be the parameters of the combined probability function) are used to evaluate the 
risk for any proposed BMDL, D. 

Note that the individual tumors need not be modeled with the same degree of the 
Multistage-Cancer model. Any terms not included for an individual tumor are 
assumed to be zero (and will remain at zero during BMDL optimization) in the 
summations shown above. The optimizer DONLP2 is used for the combined 
BMDL estimation. 

See also: 

 Multistage and Multistage-Cancer Model 

 MS_Combo Model Input File 

 Optimization Algorithms Used in BMDS 
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APPENDIX A: INPUT FILE FORMAT DESCRIPTIONS 

Note  All file formats are now created using data entry screens and options 
screens, 
 
The input file formats described in this section reflect earlier versions of 
BMDS (and its precursors) for which the users had to enter data and 
model options directly into the input file. As a result, the information in this 
section should be considered as historical reference and not required for 
use with current versions of BMDS (versions 2.2 and higher). 
 
Input file formats for the Repeated Response Measures and 
Concentration x Time models (which were not included in earlier versions 
of BMDS) are not described here. The Repeated Response Measures and 
Concentration x Time models cannot be run outside of the current BMDS 
GUI. For more information on creating datasets and modeling options for 
these models, refer to the model description (Repeated Response 
Measures Model Description, Concentration x Time Model Description ) 
and option screen sections (Repeated Response Measures Option 
Screen, Concentration x Time Model Option Screen ) of this 
documentation. 

Descriptions of Dichotomous Model Data Input Text Files 

 Gamma-hit Model Input File Format 

 Logistic and Log-Logistic Models Input File Format 

 Multistage (Polynomial) Model Input File Format 

 Probit and Log-Probit Models Input File Format 

 Quantal Linear Model Input File Format 

 Weibull Model Input File Format 

Descriptions of Dichotomous Alternative Model Data Input Text Files 

 Dichotomous Alternative Hill Model Input File 

 Weibull Dichotomous Alternative Model with Background Dose Input File 

Descriptions of Continuous Model Data Input Text Files 

 Linear Model Input File Format 

 Polynomial Model Input File Format 

 Power Model Input File Format 

 Hill Model Input File Format 

 Exponential Continuous Models Input File Format 
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Descriptions of Nested Model Data Input Text Files 

 Logistic Model Input File Format 

 NCTR Model Input File Format 

 Rai and Van Ryzin Model Input File Format 

Description of Multiple Tumor Model Data Input Text Files 

 MS_Combo Model Input File 

Each model listed above is a separate executable file that makes use of DOS 
text input files. The DOS text files provide the “instructions” for the model run. 
The BMDS interface software assists users in the creation of properly formatted 
input files for the model executables. The text file format for these data input files 
are model specific and can be obtained by following the above links. Each model 
can be run from the DOS command line of your computer by typing the model file 
name followed by the complete name (including directory location and extension) 
of an associate data input file (BMDS expects these files to be labeled with a .(d) 
extension, but the model executables will accept any extension). 

The model will generate both a text output (.out) and a graphic (.002) file with the 
same name prefix as the .(d) file. The .out file can be read with any text editor. 
The BMDS interface automatically creates a plot (.plt) file from the .002 file and 
displays it using the GNUPlot program you should have installed with BMDS. Plot 
files can also be created from the DOS command line of your computer by typing 
the name of the scripter file associated with the continuous (00*.exe), nested 
(05*.exe) or dichotomous (10*.exe) model that was used, followed by the 
complete name (including directory location and extension) of the .002 file 
associated with the model run. The wgnupl32.exe program included with the 
BMDS installation can then be used to view or edit the plot (.plt) file. 

BMDS operates in a Windows environment and automatically performs the DOS 
process commands when a session is run. 
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CANCER DICHOTOMOUS MODEL INPUT FILE 

[1] Model name, in this case, the string Multistage-Cancer 

[2] User notes 

[3] Input file name 

[4] Output file name 

[5] Number of Observations 

[6] Degree of Polynomial 

[7a] Maximum # of iterations 

= Default of 500 if user does not input a value 

= User input value otherwise 

[7b] Rel Function Convergence 

= Default of 2.22045e-16 if user does not input a value 

= User input value otherwise 

[7c] Parameter Convergence 

= Default of 1.49012e-8 if user does not input a value 

= User input value otherwise 

[8] BMDL Curve Calculation 

= 1 if BMDL Curve Calculation box is checked 

= 0 otherwise 

[9] Restrict Betas >= 0 

= 1 if Restrict Betas >= 0 box is checked 

= 0 otherwise 

Note In the cancer model, this parameter will always be set equal to 1. 

[10] BMD Calculation 

= 1 if BMD calculation box is checked 

= 0 otherwise 

[11] Append or Overwrite Output File 

= 1 if Append is selected 

= 0 if Overwrite is selected 

Note  This parameter is automatically set to 0 by the user interface and can only 
be changed by manually editing the .(d) file. 
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[12] Smooth Option 

= 0 if Unique 

= 1 if C-Spline 

[13] BMR (BMR level) 

= User input value (or default of .100) 

[14] Risk Type 

= 0 if Extra 

= 1 if Added 

[15] Confidence Level 

= User input value (or default of .950) 

[16] Background Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[17] Beta1 Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[18] Beta2 Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[18+] Etc. for Beta3, Beta4 . . . 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[19] Initialize Parameters 

= 1 if one or more parameters are set to initialized 

= 0 otherwise 

[20] Background Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected 

[21] Beta1 Parameter 

= User specified initial value if “initialized” is selected for this parameter 
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= -9999 if “initialized” is not selected 

[22] Beta2 Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected 

[22+] Etc. for Beta3, Beta4, …as necessary 

[23] Dose Name 

[24] Response Name 

[25] Constant String: NEGATIVE_RESPONSE 

Data 

Dose in first column 

Response in Second 

Total minus Response in third column 

Example Format 

[1] Multistage 

[2] BMDS MODEL RUN 

[3] EXAMPLE.SET 

[4] EXAMPLE 

[5] 4 

[6] 2 

[7-12]250 2.22045e-16 1.49012e-8 1 1 0 1 1 

[13-15] 0.10 0 0.95 

[16-18+]-9999 -9999 -9999 

[19] 0 

[20-22+]-9999 -9999 -9999 

[23-25]Dose Resp NEGATIVE_RESPONSE 

0 3 47 

50 6 44 

100 10 40 

150 19 31 

See also: 

Input File Format Descriptions 
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DICHOTOMOUS ALTERNATIVE HILL MODEL INPUT FILE 

[1] Model name, in this case, the string Dichotomous-Hill 

[2] User notes 

[3] Input file name 

[4] Output file name 

[5] Number of Observations 

[6a] Maximum # of iterations 

= Default of 500 if user does not input a value 

= User input value otherwise 

[6b] Rel Function Convergence 

= Default of 1.00E-08 if user does not input a value 

= User input value otherwise 

[6c] Parameter Convergence. 

= Default of 1.00E-08 if user does not input a value 

= User input value otherwise 

[7] BMDL Curve Calculation 

= 1 if BMDL Curve Calculation box is checked 

= 0 otherwise 

[8] Restrict Power >= 1 

= 1 if Restrict Power >= 1 box is checked 

= 0 otherwise 

[9] BMD Calculation 

= 1 if BMD calculation box is checked 

= 0 otherwise 

[10] Append or Overwrite Output File 

= 1 if Append is selected 

= 0 if Overwrite is selected 

Note  This parameter is automatically set to 0 by the user interface and can only 
be changed by manually editing the .(d) file. 

[11] Smooth Option 

= 0 if Unique 

= 1 if C-Spline 
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[12] BMR (BMR level) 

= User input value (or default of .100) 

[13] Risk Type 

= 0 if Extra 

= 1 if Added 

[14] Confidence Level 

= User input value (or default of .950) 

[15] v Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[16] g Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[17] Intercept Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[18] Slope Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[19] Initialize Parameters 

= 1 if one or more parameters are set to initialized 

= 0 otherwise 

[20] v Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[21] g Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 
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[22] Intercept Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[23] Slope Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[24] Dose Name 

[25] Response Name 

[26] Constant String: NEGATIVE_RESPONSE 

Data 

Dose in first column 

Response in Second 

Total minus Response in third column 

Example Format 

[1] Dichotomous-Hill 

[2] BMDS MODEL RUN 

[3] C:\usepa\BMDS260\Data\Dichotomous.dax 

[4] C:\usepa\BMDS260\Data\dhl_Dichotomous_Opt.out 

[5] 5 

[6-11]500 1.00E-08 1.00E-08 0 1 1 0 0 

[12-14]0.1000 0 0.95 

[15-18]-9999 -9999 -9999 -9999 

[19] 0 

[20-23]-9999 -9999 -9999 -9999 

[24-26] Dose Percent NEGATIVE_RESPONSE 

0 2.34 97.66 

50 4.58 95.42 

100 42.5 57.5 

150 60 40 

200 90.23 9.77 
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See also: 

Input File Format Descriptions 

Dichotomous Hill Model 

GAMMA DICHOTOMOUS MODEL INPUT FILE 

 [1] Model name, in this case, the string Gamma 

[2] User notes 

[3] Input file name 

[4] Output file name 

[5] Number of Observations 

[6a] Maximum # of iterations 

= Default of 500 if user does not input a value 

= User input value otherwise 

[6b] Rel Function Convergence 

= Default of 2.22045e-16 if user does not input a value 

= User input value otherwise 

[6c] Parameter Convergence. 

= Default of 1.49012e-8 if user does not input a value 

= User input value otherwise 

[7] BMDL Curve Calculation 

= 1 if BMDL Curve Calculation box is checked 

= 0 otherwise 

[8] Restrict Power >= 1 

= 1 if Restrict Power >= 1 box is checked 

= 0 otherwise 

[9] BMD Calculation 

= 1 if BMD calculation box is checked 

= 0 otherwise 

[10] Append or Overwrite Output File 

= 1 if Append is selected 

= 0 if Overwrite is selected 
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Note  This parameter is automatically set to 0 by the user interface and can only 
be changed by manually editing the .(d) file. 

[11] Smooth Option 

= 0 if Unique 

= 1 if C-Spline 

[12] BMR (BMR level) 

= User input value (or default of .100) 

[13] Risk Type 

= 0 if Extra 

= 1 if Added 

[14] Confidence Level 

= User input value (or default of .950) 

[15] Background Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[16] Slope Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[17] Power Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[18] Initialize Parameters 

= 1 if one or more parameters are set to initialized 

= 0 otherwise 

[19] Background Parameter. 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected 

[20] Slope Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected 
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[21] Power Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected 

[22] Dose Name 

[23] Response Name 

[24] Constant String: NEGATIVE_RESPONSE 

Data 

Dose in first column 

Response in Second 

Total minus Response in third column 

Example Format

[1] Gamma 

[2] BMDS MODEL RUN 

[3] EXAMPLE.SET 

[4] EXAMPLE 

[5] 4 

[6-11] 250 2.22045e-16 1.49012e-8 1 1 1 1 0 

[12-14] 0.10 0 0.95 

[15-17] -9999 -9999 -9999 

[18] 0 

[19-21] -9999 -9999 -9999 

[22-24] Dose Resp NEGATIVE_RESPONSE 

0 3 47 

50 6 44 

100 10 40 

150 19 31 

 

See also: 

Input File Format Descriptions 

Gamma-hit Model Description 
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EXPONENTIAL CONTINUOUS MODEL INPUT FILE 

 [1] Model Name, in this case, the constant string Exponential 

[2] User Notes 

[3] Input file name 

[4] Output data file name 

[5] Input Type 

= 0 if individual animal data (e.g., Dose, Response) are entered 

= 1 if entered as group data (e.g., Dose, N, Mean, Std.) 

[6]  A count of the number of observations 

[7] Adverse Direction 

= 0 if Automatic (adverse direction with increasing dose estimated by model) 

= 1 if Up (dose-response curve trends up with increasing dose) 

= -1 if Down (dose-response curve trends down with increasing dose) 

[8] Run Models 

One digit per model indicating whether it is included in the run. For example, “1000” 
runs only Model 2 and “1111” runs Models 2, 3, 4, and 5. 

= 0 if No 

= 1 if Yes 

[9] Span 

Two digits indicating first and last model to run. For example, “11” means that Model 
2 is first and last; “14” means that Model 2 is first and Model 5 is last. 

[10] Distribution Curve 

= 0 is Normal 

= 1 is Lognormal 

[11]  Maximum Likelihood Estimate (MLE) Solution 

= 0 is Approximate 

= 1 is Exact 

Note If Distribution Curve is 0, then MLE Solution should always be 1 (Exact). 
If Distribution Curve is 1 and Input Type (line 5) is 1, then MLE Solution 
should always be 0 (Approximate). 

[12] Maximum # of iterations 

= 500 

[13] Rel Function Convergence 
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= -1.00e-8 

[14] Parameter Convergence. 

= -1.00e-8 

[15]  BMDL Curve Calculation 

= 0 (BMDL Curve Calculation box is unchecked) 

[16] BMD Calculation 

= 1 (BMD calculation box is checked) 

[17] Append or Overwrite Output File 

= 0 if Overwrite is selected 

= 1 if Append is selected 

Note  This parameter is automatically set to 0 by the user interface and can only 
be changed by manually editing the .(d) file. 

[18] Smooth Option 

= 0 (Unique) 

[19] BMR Type 

= 0 if Absolute Dev. 

= 1 if Std. Dev. 

= 2 if Relative Dev. 

= 3 if Point 

[20] BMRF (BMR Level) 

= User input value (or default of 1.000) 

[21] Constant Variance 

= 0 if not checked (the variance is to be modeled as Var(i) = alpha*mean(i)^rho) 

= 1 if box is checked (rho is set to 0 in the above equation) 

[22] Confidence Level 

= User input value (or default of .950) 

[23] Alpha Parameter 

= -9999 

[24] Rho Parameter 

= -9999 

[25]  a Parameter 

= -9999 
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[26] b Parameter 

= -9999 

[27]  c Parameter 

= -9999 

[28] d Parameter 

= -9999 

[29] Initialize Parameters 

= 0 

[etc.] 

Note  In the Exponential software, no initial values may be specified by the user. 
Leave all these entries as is (with “-9999”). 

[30]-[33] In this order, by checking the column assignment pull down menus, these 
fields should contain: 

If Group data are entered: 

[30] Dose header 

[31] N header 

[32] Mean header 

[33] Std header 

If Individual data are entered: 

[30] Dose header 

[31] Response header 

[etc.] 

In the same column order as above, this should just be a data listing. 

Format Example 

[1] Exponential 

[2] Default settings but downward adversity 

[3] C:\software\EPA\BMDS250\Data\Continuous1.dax 

[4] C:\software\EPA\BMDS250\Data\exp_Continuous1_exptest.out 

[5-11] 1 5 -1 1111 14 0 1 

[12-18] 500 1.00E-08 1.00E-08 0 1 1 0 

[19-22] 1 1.00 1 0.95 

[23-28] -9999 -9999 -9999 -9999 -9999 -9999 

[29] 0 
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[23-28] -9999 -9999 -9999 -9999 -9999 -9999 

[23-28] -9999 -9999 -9999 -9999 -9999 -9999 

[29] 0 

[23-28] -9999 -9999 -9999 -9999 -9999 -9999 

[23-28] -9999 -9999 -9999 -9999 -9999 -9999 

[29] 0 

[23-28]-9999 -9999 -9999 -9999 -9999 -9999 

[23-28]-9999 -9999 -9999 -9999 -9999 -9999 

[29] 0 

[23-28]-9999 -9999 -9999 -9999 -9999 -9999 

[30-33] DOSE N MEAN STD 

0 20 6 1.2 

25 20 5.2 1.1 

50 19 2.4 0.81 

100 20 1.1 0.74 

200 20 0.75 0.66 

See also: 

Input File Format Descriptions 

Exponential Models Description 

Unique Options for Exponential Models 

Continuous Exponential Model Options Fields 

HILL CONTINUOUS MODEL INPUT FILE 

[1] Model Name, in this case, the constant string Hill 

[2] User Notes 

[3] Input file name 

[4] Output data file name 

[5] Input Type 

= 1 if entered as group data (e.g., Dose, N, Mean, Std.) 

= 0 if individual animal data (e.g., Dose, Response) is entered 

[6] A count of the number of observations 

[7] Adverse Direction 
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= 0 if Automatic (adverse direction with increasing dose estimated by model) 

= 1 if Up (dose-response curve trends up with increasing dose) 

= -1 if Down (dose-response curve trends down with increasing dose) 

[8a] Maximum # of iterations 

= Default of 500 if user does not input a value 

= User input value otherwise 

[8b] Rel Function Convergence 

= Default of 2.22045e-16 if user does not input a value 

= User input value otherwise 

[8c] Parameter Convergence. 

= Default of 1.49012e-8 if user does not input a value 

= User input value otherwise 

[9] BMDL Curve Calculation 

= 0 (BMDL Curve Calculation box is unchecked) 

[10] Restrict n > 1? 

= 1 if Restrict n > 1 box is checked 

= 0 otherwise 

[11] BMD Calculation 

= 1 if BMD calculation box is checked 

= 0 otherwise 

[12] Append or Overwrite Output File 

= 1 if Append is selected 

= 0 if Overwrite is selected 

Note  This parameter is automatically set to 0 by the user interface andcan only 
be changed by manually editing the .(d) file. 

[13] Smooth Option 

= 0 if Unique 

= 1 if C-Spline 

[14] BMR Type 

= 0 if Absolute Dev. 

= 1 if Std. Dev. 

= 2 if Relative Dev.(Default) 
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= 3 if Point 

= 4 if Extra 

[15] BMR (BMR Level) 

= User input value (Default = 0.1000) 

[16] Constant Variance 

= 0 if not (the variance is to be modeled as Var(i) = alpha*mean(i)^rho) 

= 1 if box is checked (rho is set to 0 in the above equation) 

[17] Confidence Level 

= User input value (or default of .950) 

[18] Alpha Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[19] Rho Parameter 

= 0 if Constant Variance box is checked 

If Constant Variance box not checked, 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[20] Intercept Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[21] v Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[22] n Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[23] k Parameter 

= User input value if Specified Option is selected 
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= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[24] Initialize Parameters 

= 1 if one or more parameters are set to initialized 

= 0 otherwise 

[25] Alpha Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[26] Rho Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[27] Intercept Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[28] v Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[29] n Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[30] k Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[31]-[34] 

IN THIS ORDER, by checking the column assignment pull down menus, these fields 
should contain: 

If Group data is entered: 

[31] 

Dose name 

[32] 

N name 

[33] 

Mean Name 

[34] 

Std Name 

If Individual data is entered: 

[31] 

Dose name 

[32] 

Response name etc. 
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In the same column order as above, this should just be a data listing. 

Example Format 

[1] Hill 

[2] BMDS MODEL RUN 

[3] HYBRID1.SET 

[4] HYBRID1 

[5-7] 1 6 1 

[8-13] 250 2.22045e-16 1.49012e-8 1 0 1 1 1 

[14-17] 1 1.00 1 095 

[18-23] -9999 -9999 -9999 -9999 -9999 -9999 

[24] 0 

[25-30] -9999 -9999 -9999 -9999 -9999 -9999 

[31-34] DOSE NI MEAN STD 

0 4 38.45 1.1683 

8 5 39.56 1.28218 

20 4 40.9 1.303 

30 4 41.95 1.418203 

40 4 42.725 1.438 

50 5 43.42 1.45932 

See also: 

Input File Format Descriptions 

Hill Model Description 

LINEAR CONTINUOUS MODEL INPUT FILE 

Use Polynomial Continuous Model Input File Format, but make sure the polynomial 
degree (Item 4a) is set to 1. 

LOGISTIC AND LOG-LOGISTIC DICHOTOMOUS MODEL 
INPUT FILES 

 [1] Model name, in this case, the string Logist 

[2] User notes 

[3] Input file name 

[4] Output file name 
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[5] Number of Observations 

[6a] Maximum # of iterations 

= Default of 500 if user does not input a value 

= User input value otherwise 

[6b] Rel Function Convergence 

= Default of 2.22045e-16 if user does not input a value 

= User input value otherwise 

[6c] Parameter Convergence 

= Default of 1.49012e-8 if user does not input a value 

= User input value otherwise 

[7] BMDL Curve Calculation 

= 1 if BMDL Curve Calculation box is checked 

= 0 otherwise 

[8] Log Transformation 

= 1 if Log transformation is to be used 

= 0 otherwise 

[9] Restrict Slope >= 1 

= 1 if Restrict Slope >= 1 box is checked (only appropriate for log-logistic model) 

= 0 otherwise 

[10] BMD Calculation 

= 1 if BMD calculation box is checked 

= 0 otherwise 

[11] Append or Overwrite Output File 

= 1 if Append is selected 

= 0 if Overwrite is selected 

Note  This parameter is automatically set to 0 by the user interface andcan only 
be changed by manually editing the .(d) file. 

[12] Smooth Option 

= 0 if Unique 

= 1 if C-Spline 

[13] BMR (BMR level) 

= User input value (or default of .100) 
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[14] Risk Type 

= 0 if Extra 

= 1 if Added 

[15] Confidence Level 

= User input value (or default of .950) 

[16] Background Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value or if Log transformation not selected 

[17] Slope Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[18] Intercept Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[19] Initialize Parameters 

= 1 if one or more parameters are set to initialized 

= 0 otherwise 

[20] Background Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected or if Log transformation not selected 

[21] Slope Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected 

[22] Intercept Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected 

[23] Dose Name 

[24] Response Name 

[25] Constant String: NEGATIVE_RESPONSE 
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Data 

Dose in first column 

Response in Second 

Total minus Response in third column 

Example Format 

[1] Logist 

[2] BMDS MODEL RUN 

[3] EXAMPLE.SET 

[4] EXAMPLE 

[5] 4 

[6-12] 250 2.22045e-16 1.49012e-8 1 0 0 1 1 0 

[13-15] 0.10 0 0.95 

[16-18] -9999 -9999 -9999 

[19] 0 

[20-22] -9999 -9999 -9999 

[23-25] Dose Resp NEGATIVE_RESPONSE 

0 3 47 

50 6 44 

100 10 40 

150 19 31 

 

See also: 

Input File Format Descriptions 

LOGISTIC NESTED MODEL INPUT FILE 

[1] Model name, in this case, the string Nlogist 

[2] User notes 

[3] Input file name 

[4] Output file name 

[5] Number of Observations 

[5a] Number of Dose groups 
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[6a] Maximum # of iterations 

= Default of 500 if user does not input a value 

= User input value otherwise 

[6b] Rel Function Convergence 

= Default of 1.00E-08 if user does not input a value 

= User input value otherwise 

[6c] Parameter Convergence. 

= Default of 1.00E-08 if user does not input a value 

= User input value otherwise 

[7] BMDL Curve Calculation 

= 1 if BMDL Curve Calculation box is checked 

= 0 otherwise 

[8] Restrict Power >= 1 (Note: Power = Rho parameter in model) 

= 1 if Restrict Power >= 1 box is checked 

= 0 otherwise 

[9] BMD Calculation 

= 1 if BMD calculation box is checked 

= 0 otherwise 

[10] Fixed Size 

= 1 if Ctrl Group Mean selected 

= 0 if overall mean selected 

[11] Append or Overwrite Output File 

= 1 if Append is selected 

= 0 if Overwrite is selected 

Note  This parameter is automatically set to 0 by the user interface and can only 
be changed by manually editing the .(d) file. 

[12] Smooth Option 

= 0 if Unique 

= 1 if C-Spline 

[13] BMR (BMR level) 

= User input value (or default of .100) 

[14] Risk Type 
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= 0 if Extra 

= 1 if Added 

[15] Confidence Level 

= User input value (or default of .950) 

[16] Bootstrap Iterations 

= User input value (or default of 1000) 

[17] Seed 

= If specified, user input value in decimal format (or default of 0) 

[18] Alpha Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[19] Rho Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[20] Beta Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[21] Theta1 Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[22] Theta2 Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[23] Phi1 Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[24] Phi2 Parameter 

= User input value if Specified Option is selected 
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= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[25] Phi3 Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[26+] Phi4 through Phi10 if necessary (as many Phi parameters as dose groups) 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[27] Initialize Parameters 

= 1 if one or more parameters are set to initialized 

= 0 otherwise 

[28] Alpha Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[29] Rho Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[30] Beta Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[31] Theta1 Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[32] Theta2 Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[33] Phi1 Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[34] Phi2 Parameter 

= User specified initial value if “initialized” is selected for this parameter 
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= -9999 if not checked 

[35] Phi3 Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[36+] Phi4 through Phi10 if necessary (as many Phi parameters as dose groups) 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[37] Dose Name 

[38] Response Name 

[39] Constant String: NEGATIVE_RESPONSE 

[40] Litter Size 

[41] Column 5 name 

Data 

Dose in first column 

Response in Second 

Total (Litter Size) minus Response in third column 

Litter Specific Covariate 

Group number, or any integers 

Example Format 

[1] Nlogistic 

[2] BMDS MODEL RUN 

[3] C:\usepa\BMDS260\Data\Nested.dax 

[4] C:\usepa\BMDS260\Data\nln_Nested_Opt.out 

[5-5a] 39 4  

[6-12] 500 1.00E-08 1.00E-08 1 0 1 1 0 0 

[13-17] 0.1000 0 0.95 1000 0 

[18-22] -9999 -9999 -9999 -9999 -9999 

[23-26+] -9999 -9999 -9999 -9999 

[27] 0 

[28-32] -9999 -9999 -9999 -9999 -9999 

[33-36+] -9999 -9999 -9999 -9999 

[37-41] Dose Resp Negative_Response Covariate Column 5 
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0 1 15 16 -9999 

0 1 8 9 -9999 

0 2 13 15 -9999 

0 3 11 14 -9999 

0 3 10 13 -9999 

0 0 9 9 -9999 

0 2 8 10 -9999 

0 2 12 14 -9999 

0 1 9 10 -9999 

0 2 9 11 -9999 

25 4 10 14 -9999 

25 5 4 9 -9999 

25 6 8 14 -9999 

25 2 7 9 -9999 

25 6 7 13 -9999 

25 3 9 12 -9999 

25 1 9 10 -9999 

25 2 8 10 -9999 

25 4 7 11 -9999 

25 3 11 14 -9999 

50 4 7 11 -9999 

50 5 6 11 -9999 

50 5 9 14 -9999 

50 4 7 11 -9999 

50 5 5 10 -9999 

50 4 7 11 -9999 

50 5 5 10 -9999 

50 6 9 15 -9999 

50 2 5 7 -9999 

50 4 10 14 -9999 

100 6 5 11 -9999 

100 6 8 14 -9999 

100 8 4 12 -9999 
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100 7 6 13 -9999 

100 8 4 12 -9999 

100 6 8 14 -9999 

100 6 5 11 -9999 

100 5 3 8 -9999 

100 4 6 10 -9999 

See also: 

Input File Format Description 

Logistic Nested Model Description 

MS_COMBO MODEL INPUT FILE 

[1] Model name, in this case, the string MS_Combo 

[2] User notes 

[3] Data file name (.dax) including path of first tumor (file names appear in output) 

[4] Number of tumors for combined BMDL. The number entered here determines the 
additional lines required following Line 11. 

[5–11] Info for first tumor 

[5] X Y Z where X=# dose groups, Y=degree of polynomial, Z=Input dax file name (sans 
path) 

[6a] Maximum # of iterations 

= Default of 500 if user does not input a value 

= User input value otherwise 

[6b] Rel Function Convergence 

= Default of 2.22045e-16 if user does not input a value 

= User input value otherwise 

[6c] Parameter Convergence. 

= Default of 1.49012e-8 if user does not input a value 

= User input value otherwise 

[6d] BMDL Curve Calculation 

= 1 if BMDL Curve Calculation box is checked 

= 0 otherwise 

[6e] Restrict Power >= 1 
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= 1 if Restrict Power >= 1 box is checked 

= 0 otherwise 

[6f] BMD Calculation 

= 1 if BMD calculation box is checked 

= 0 otherwise 

[6g] Append or Overwrite Output File 

= 1 if Append is selected 

= 0 if Overwrite is selected 

Note  This parameter is automatically set to 0 by the user interface and can only 
be changed by manually editing the .(d) file. 

[6h] Smooth Option 

= 0 if Unique 

= 1 if C-Spline 

[7a] BMR (BMR level) 

= User input value (or default of .100) 

[7b] Risk Type 

= 0 if Extra 

= 1 if Added 

[7c] Confidence Level 

= User input value (or default of .950) 

[8] Specified parameters (or default values); count = Y + 1 where Y is from line 5 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[9] Number of initialized parameters 

= 1 if one or more parameters are set to initialized 

= 0 otherwise 

[10] Initialized parameters (or default values); count = Y + 1 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[11] Header names for experimental data 

[12ff—line count depends on value from Line 5] Data 
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[Repeat lines 5–12ff for each dax file] 

Note  This format can be extended for up to 10 tumor files. 

Example Format 

The following example shows three .dax files represented in the MS_Combo model 
input file. 

[1] MS_Combo 

[2] BMDS_Model_Run 

[3] C:\USEPA\BMDS240\Data\Dichotomous.dax 

[4] 3 

[5] 5 2 Dichotomous.dax 

[6a-6h] 500 1.00E-08 1.00E-08 0 1 1 0 0 

[7a-7c] 0.01 0 0.95 

[8] -9999 -9999 -9999 

[9] 0 

[10] -9999 -9999 -9999 

[11] Dose Effect NEGATIVE_RESPONSE 

[12+] 0 0 100 

 50 5 95 

 100 30 70 

 150 65 35 

 200 90 10 

 

[5] 5 2 Dichotomous.dax 

[6a-6h] 500 1.00E-08 1.00E-08 0 1 1 0 0 

[7a-7c] 0.01 0 0.95 

[8] -9999 -9999 -9999 

[9] 0 

[10] -9999 -9999 -9999 

[11] Dose Effect2 NEGATIVE_RESPONSE 

[12+] 0 5 95 

 50 10 90 

 100 33 67 

 150 67 33 
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 200 93 7 

 

[5] 5 2 Dichotomous.dax 

[6a-6h] 500 1.00E-08 1.00E-08 0 1 1 0 0 

[7a-7c] 0.01 0 0.95 

[8] -9999 -9999 -9999 

[9] 0 

[10] -9999 -9999 -9999 

[11] Dose Effect3 NEGATIVE_RESPONSE 

[12+] 0 1 99 

 50 68 32 

 100 78 22 

 150 88 12 

 200 98 2 

 

MULTISTAGE DICHOTOMOUS MODEL INPUT FILE 

[1] Model name, in this case, the string Multistage 

[2] User notes 

[3] Input file name 

[4] Output file name 

[5] Number of Observations 

[6] Degree of Polynomial 

[7a] Maximum # of iterations 

= Default of 500 if user does not input a value 

= User input value otherwise 

[7b] Rel Function Convergence 

= Default of 2.22045e-16 if user does not input a value 

= User input value otherwise 

[7c] Parameter Convergence 

= Default of 1.49012e-8 if user does not input a value 

= User input value otherwise 
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[8] BMDL Curve Calculation 

= 1 if BMDL Curve Calculation box is checked 

= 0 otherwise 

[9] Restrict Betas >= 0 

= 1 if Restrict Betas >= 0 box is checked 

= 0 otherwise 

[10] BMD Calculation 

= 1 if BMD calculation box is checked 

= 0 otherwise 

[11] Append or Overwrite Output File 

= 1 if Append is selected 

= 0 if Overwrite is selected 

Note  This parameter is automatically set to 0 by the user interface and can only 
be changed by manually editing the .(d) file. 

[12] Smooth Option 

= 0 if Unique 

= 1 if C-Spline 

[13] BMR (BMR level) 

= User input value (or default of .100) 

[14] Risk Type 

= 0 if Extra 

= 1 if Added 

[15] Confidence Level 

= User input value (or default of .950) 

[16] Background Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[17] Beta1 Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[18] Beta2 Parameter 
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= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[18+] Etc. for Beta3, Beta4 . . . 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[19] Initialize Parameters 

= 1 if one or more parameters are set to initialized 

= 0 otherwise 

[20] Background Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected 

[21] Beta1 Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected 

[22] Beta2 Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected 

[22+] Etc. for Beta3, Beta4, …as necessary 

[23] Dose Name 

[24] Response Name 

[25] Constant String: NEGATIVE_RESPONSE 

Data 

Dose in first column 

Response in Second 

Total minus Response in third column 

Example Format 

[1] Multistage 

[2] BMDS MODEL RUN 

[3] EXAMPLE.SET 

[4] EXAMPLE 

[5-6] 4 2 
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[7-12] 250 2.22045e-16 1.49012e-8 1 0 0 1 1 

[13-15] 0.10 0 0.95 

[16-18+] -9999 -9999 -9999 … 

[19] 0 

[20-22+] -9999 -9999 -9999 … 

[23-25] Dose Resp NEGATIVE_RESPONSE 

0 3 47 

50 6 44 

100 10 40 

150 19 31 

See also: 

Input File Format Descriptions 

Multistage (Polynomial) Model Description 

NCTR NESTED MODEL INPUT FILE 

[1] Model name, in this case, the string NCTR 

[2] User notes 

[3] Input file name 

[4] Output file name 

[5] Number of Observations 

[5a] Number of Dose groups 

[6a] Maximum # of iterations 

= Default of 500 if user does not input a value 

= User input value otherwise 

[6b] Rel Function Convergence 

= Default of 1.00E-08 if user does not input a value 

= User input value otherwise 

[6c] Parameter Convergence 

= Default of 1.00E-08 if user does not input a value 

= User input value otherwise 

[7] BMDL Curve Calculation 

= 1 if BMDL Curve Calculation box is checked 
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= 0 otherwise 

[8] Restrict Power >= 1 (Note: Power = Rho parameter in model) 

= 1 if Restrict Power >= 1 box is checked 

= 0 otherwise 

[9] BMD Calculation 

= 1 if BMD calculation box is checked 

= 0 otherwise 

[10] Fixed Size 

= 1 if Ctrl Group Mean selected 

= 0 if overall mean selected 

[11] Append or Overwrite Output File 

= 1 if Append is selected 

= 0 if Overwrite is selected 

Note  This parameter is automatically set to 0 by the user interface and can only 
be changed by manually editing the .(d) file. 

[12] Smooth Option 

= 0 if Unique 

= 1 if C-Spline 

[13] BMR (BMR level) 

= User input value (or default of .100) 

[14] Risk Type 

= 0 if Extra 

= 1 if Added 

[15] Confidence Level 

= User input value (or default of .950) 

[16] Bootstrap Iterations 

= User input value (or default of 1000) 

[17] Seed 

= If specified, user input value in decimal format (or default of 0) 

[18] Alpha Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 
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[19] Rho Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[20] Beta Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[21] Theta1 Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[22] Theta2 Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[23] Phi1 Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[24] Phi2 Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[25] Phi3 Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[26+] Phi4 through Phi10 if necessary (as many Phi parameters as dose groups) 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[27] Initialize Parameters 

= 1 if one or more parameters are set to initialized 

= 0 otherwise 
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[28] Alpha Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[29] Rho Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[30] Beta Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[31] Theta1 Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[32] Theta2 Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[33] Phi1 Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[34] Phi2 Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[35] Phi3 Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[36+] Phi4 through Phi10 if necessary (as many Phi parameters as dose groups) 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[37] Dose Name 

[38] Response Name 

[39] Constant String: NEGATIVE_RESPONSE 

[40] Litter Specific Covariate 

[41] Column 5 name 
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Data 

Dose in first column 

Response in Second 

Total (Litter Size) minus Response in third column 

Litter Size 

Example Format 

[1] NCTR 

[2] BMDS MODEL RUN 

[3] C:\usepa\BMDS260\Data\Nested.dax 

[4] C:\usepa\BMDS260\Data\nct_Nested_Opt.out 

[5-5a] 39 4  

[6-12] 500 1.00E-08 1.00E-08 0 1 1 0 0 0 

[13-17] 0.1000 0 0.95 1000 0 

[18-22] -9999 -9999 -9999 -9999 -9999 

[23-26+] -9999 -9999 -9999 -9999 

[27] 0 

[28-32] -9999 -9999 -9999 -9999 -9999 

[33-36+] -9999 -9999 -9999 -9999 

[37-41] Dose Resp Negative_Resp Covariate Column 5 

0 1 15 16 -9999 

0 1 8 9 -9999 

0 2 13 15 -9999 

0 3 11 14 -9999 

0 3 10 13 -9999 

0 0 9 9 -9999 

0 2 8 10 -9999 

0 2 12 14 -9999 

0 1 9 10 -9999 

0 2 9 11 -9999 

25 4 10 14 -9999 

25 5 4 9 -9999 

25 6 8 14 -9999 

25 2 7 9 -9999 
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25 6 7 13 -9999 

25 3 9 12 -9999 

25 1 9 10 -9999 

25 2 8 10 -9999 

25 4 7 11 -9999 

25 3 11 14 -9999 

50 4 7 11 -9999 

50 5 6 11 -9999 

50 5 9 14 -9999 

50 4 7 11 -9999 

50 5 5 10 -9999 

50 4 7 11 -9999 

50 5 5 10 -9999 

50 6 9 15 -9999 

50 2 5 7 -9999 

50 4 10 14 -9999 

100 6 5 11 -9999 

100 6 8 14 -9999 

100 8 4 12 -9999 

100 7 6 13 -9999 

100 8 4 12 -9999 

100 6 8 14 -9999 

100 6 5 11 -9999 

100 5 3 8 -9999 

100 4 6 10 -9999 

See also: 

Input File Format Description 

NCTR Model Description 

POLYNOMIAL CONTINUOUS MODEL INPUT FILE 

[1] Model Name, in this case, the constant string Polynomial 

[2] User Notes 
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[3] Input file name 

[4] Output data file name 

[4a] Degree of polynomial 

= Default of 2 if user does not input a value 

= 1 if Linear model is chosen 

= User input value otherwise 

[5] Input type 

= 1 if entered as group data (e.g., Dose, N, Mean, Std.) 

= 0 if individual animal data (e.g., Dose, Response) is entered 

[6] A count of the number of observations 

[7] Adverse direction 

= 0 if Automatic (adverse direction with increasing dose estimated by model) 

= 1 if Up (dose-response curve trends up with increasing dose) 

= -1 if Down (dose-response curve trends down with increasing dose) 

[8a] Maximum # of iterations 

= Default of 500 if user does not input a value 

= User input value otherwise 

[8b] Rel Function Convergence 

= Default of 2.22045e-16 if user does not input a value 

= User input value otherwise 

[8c] Parameter Convergence. 

= Default of 1.49012e-8 if user does not input a value 

= User input value otherwise 

[9] BMDL Curve Calculation 

= 1 if BMDL Curve Calculation box is checked 

= 0 otherwise 

[10] Restriction on polynomial coefficients 

= 0 if none 

= -1 if non-positive 

= 1 if non-negative 

[11] BMD Calculation 

= 1 if BMD calculation box is checked 

= 0 otherwise 
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[12] Append or Overwrite Output File 

= 1 if Append is selected 

= 0 if Overwrite is selected 

Note  This parameter is automatically set to 0 by the user interface andcan only 
be changed by manually editing the .(d) file. 

[13] Smooth Option 

= 0 if Unique 

= 1 if C-Spline 

[14] BMR Type 

= 0 if Absolute Dev. 

= 1 if Std. Dev 

= 2 if Relative Dev.(Default) 

= 3 if Point 

= 4 if Extra 

[15] BMR (BMR Level) 

= User input value (or default of 0.1) 

[16] Constant Variance 

= 0 if not (the variance is to be modeled as Var(i) = alpha*mean(i)^rho) 

= 1 if box is checked (rho is set to 0 in the above equation) 

[17] Confidence Level 

= User input value (or default of .950) 

[18]-[22+] Parameter values, either user specified or default values. If the parameter is 
not specified, the default value is -9999 

[18] Alpha Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[19] Rho Parameter 

= 0 if Constant Variance box is checked 

If Constant Variance box not checked, 

= user input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 
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[20]-[22+] Beta parameters in order of appearance on option screen. 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[23] Initialize Parameters 

= 1 if one or more parameters are set to initialized 

= 0 otherwise 

[24] Alpha Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[25] Rho Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[26]-[28+] Beta parameters in order of appearance on option screen 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[29]-[32] IN THIS ORDER, by checking the column assignment pull down menus, these 
fields should contain: 

If Group data is entered: 

[29] 

Dose 
name 

[30] 

N name 

[31] 

Mean Name

[32] 

 Std Name 

If Individual data is entered: 

[29] 

Dose name 

[30] 

Response name 

In the same column order as above, this should just be a data listing. 

Example Format 

[1] Polynomial 

[2] BMDS MODEL RUN 

[3] Poly1.SET 

[4] Poly 

[4a] 2 
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[5-7] 1 6 0 

[8-13] 250 2.22045e-16 1.49012e-8 1 0 1 1 0 

[14-17] 1 1.00 1 0.95 

[18-22+] -9999 -9999 -9999 -9999 -9999 

[23] 0 

[24-28+] -9999 -9999 -9999 -9999 -9999 

[29-32] DOSE NI MEAN STD 

0 4 38.45 1.1683 

8 5 39.56 1.28218 

20 4 40.9 1.303 

30 4 41.95 1.418203 

40 4 42.725 1.438 

50 5 43.42 1.45932 

See also: 

Input File Format Descriptions 

Linear Model Description 

Polynomial Model Description 

POWER CONTINUOUS MODEL INPUT FILE 

[1] Model Name, in this case, the constant string Power 

[2] User Notes 

[3] Input file name 

[4] Output data file name 

[5] Input Type 

= 1 if entered as group data (e.g., Dose, N, Mean, Std.) 

= 0 if animal data (e.g., Dose, Response) is entered 

[6] A count of the number of observations 

[7] Adverse Direction 

= 0 if Automatic (adverse direction with increasing dose estimated by model) 

= 1 if Up (dose-response curve trends up with increasing dose) 

= -1 if Down (dose-response curve trends down with increasing dose) 

[8a] Maximum # of iterations 
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= Default of 500 if user does not input a value 

= User input value otherwise 

[8b] Rel Function Convergence 

= Default of 2.22045e-16 if user does not input a value 

= User input value otherwise 

[8c] Parameter Convergence. 

= Default of 1.49012e-8 if user does not input a value 

= User input value otherwise 

[9] BMDL Curve Calculation 

= 1 if BMDL Curve Calculation box is checked 

= 0 otherwise 

[10] Restrict power >= 1 

= 1 if Restrict Power >= 1 box is checked 

= 0 otherwise 

[11] BMD Calculation 

= 1 if BMD calculation box is checked 

= 0 otherwise 

[12] Append or Overwrite Output File 

= 1 if Append is selected 

= 0 if Overwrite is selected 

Note  This parameter is automatically set to 0 by the user interface andcan only 
be changed by manually editing the .(d) file. 

[13] Smooth Option 

= 0 if Unique 

= 1 if C-Spline 

[14] BMR Type 

= 0 if Absolute Dev. 

= 1 if Std. Dev. 

= 2 if Relative Dev.(Default) 

= 3 if Point 

= 4 if Extra 

[15] BMR (BMR Level) 
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= User input value (or default of 1.000) 

[16] Constant Variance 

= 0 if not (the variance is to be modeled as Var(i) = alpha*mean(i)^rho) 

= 1 if box is checked (rho is set to 0 in the above equation) 

[17] Confidence Level 

= User input value (or default of .950) 

[18] Alpha Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[19] Rho Parameter 

= 0 if Constant Variance box is checked 

If Constant Variance box not checked, 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[20] Control Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[21] Slope Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[22] Power Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[23] Initialize Parameters 

= 1 if one or more parameters are set to initialized 

= 0 otherwise 

[24] Alpha Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 
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[25] Rho Parameter 

= 0 if Constant Variance box is checked 

If Constant Variance box not checked, 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[26] Control Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[27] Slope Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[28] Power Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[29]-[32] IN THIS ORDER, by checking the column assignment pull down menus, these 
fields should contain: 

If Group data is entered: 

29 30 31  32 

Dose name N name Mean Name Std Name 

If data is entered: 

29 30 

Dose name Response name 

etc. 

In the same column order as above, this should just be a data listing. 

Format Example 

[1] Power 

[2] BMDS MODEL RUN 

[3] Power.SET 

[4] Power 

[5-7] 1 6 1 

[8-13] 250 2.22045e-16 1.49012e-8 1 0 1 1 0 

[14-17] 1 1.00 1 0.95 
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[18-22] -9999 -9999 -9999 -9999 -9999 

[23] 0 

[24-28] -9999 -9999 -9999 -9999 -9999 

 

[29-32] DOSE NI MEAN STD 

0 4 38.45 1.1683 

8 5 39.56 1.28218 

20 4 40.9 1.303 

30 4 41.95 1.418203 

40 4 42.725 1.438 

50 5 43.42 1.45932 

See also: 

Input File Format Descriptions 

Power Model Description 

PROBIT AND LOG-PROBIT DICHOTOMOUS MODEL INPUT 
FILES 

[1] Model name, in this case, the string Probit 

[2] User notes 

[3] Input file name 

[4] Output file name 

[5] Number of Observations 

[6a] Maximum # of iterations 

= Default of 500 if user does not input a value 

= User input value otherwise 

[6b] Rel Function Convergence 

= Default of 2.22045e-16 if user does not input a value 

= User input value otherwise 

[6c] Parameter Convergence 

= Default of 1.49012e-8 if user does not input a value 

= User input value otherwise 

[7] BMDL Curve Calculation 
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= 1 if BMDL Curve Calculation box is checked 

= 0 otherwise 

[8] Log transformation 

= 1 if Log transformation is to be used 

= 0 otherwise 

[9] Restrict Slope 

= 1 if Restrict Slope >= 1 box is checked (only appropriate for log-probit model) 

= 0 otherwise 

[10] BMD Calculation 

= 1 if BMD calculation box is checked 

= 0 otherwise 

[11] Append or Overwrite Output File 

= 1 if Append is selected 

= 0 if Overwrite is selected 

Note  This parameter is automatically set to 0 by the user interface andcan only 
be changed by manually editing the .(d) file. 

[12] Smooth Option 

= 0 if Unique 

= 1 if C-Spline 

[13] BMR (BMR level) 

= User input value (or default of .100) 

[14] Risk Type 

= 0 if Extra 

= 1 if Added 

[15] Confidence Level 

= User input value (or default of .950) 

[16] Background Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value or if Log transformation not selected 

[17] Slope Parameter 

= User input value if Specified Option is selected 
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= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[18] Intercept Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[19] Initialize Parameters 

= 1 if one or more parameters are set to initialized 

= 0 otherwise 

[20] Background Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected or if Log transformation not selected 

[21] Slope Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected 

[22] Intercept Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected 

[23] Dose Name 

[24] Response Name 

[25] Constant String: NEGATIVE_RESPONSE 

Data 

Dose in first column 

Response in Second 

Total minus Response in third column 

Example Format 

[1] Probit 

[2] BMDS MODEL RUN 

[3] EXAMPLE.SET 

[4] EXAMPLE 

[5] 4 

[6-12] 250 2.22045e-16 1.49012e-8 1 0 0 1 1 0 

[13-15] 0.10 0 0.95 
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[16-18] -9999 -9999 -9999 

[19] 0 

[20-22] -9999 -9999 -9999 

[23-25] Dose Resp NEGATIVE_RESPONSE 

0 3 47 

50 6 44 

100 10 40 

150 19 31 

See also: 

Input File Format Descriptions 

Probit Models Description 

Log-Probit Models Description 

QUANTAL LINEAR DICHOTOMOUS MODEL INPUT FILE 

[1] Model name, in this case, the string QuantalLinear 

[2] User notes 

[3] Input file name 

[4] Output file name 

[5] Number of Observations 

[6a] Maximum # of iterations 

= Default of 500 if user does not input a value 

= User input value otherwise 

[6b] Rel Function Convergence 

= Default of 2.22045e-16 if user does not input a value 

= User input value otherwise 

[6c] Parameter Convergence. 

= Default of 1.49012e-8 if user does not input a value 

= User input value otherwise 

[7] BMDL Curve Calculation 

= 1 if BMDL Curve Calculation box is checked 

= 0 otherwise 
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[8] This parameter is set to 0 by the user interface, but is ignored when running the 
Quantal Linear model. 

[9] BMD Calculation 

= 1 if BMD calculation box is checked 

= 0 otherwise 

[10] Append or Overwrite Output File 

= 1 if Append is selected 

= 0 if Overwrite is selected 

Note  This parameter is automatically set to 0 by the user interface andcan only 
be changed by manually editing the .(d) file. 

[11] Smooth Option 

= 0 if Unique 

= 1 if C-Spline 

[12] BMR (BMR level) 

= User input value (or default of .100) 

[13] Risk Type 

= 0 if Extra 

= 1 if Added 

[14] Confidence Level 

= User input value (or default of .950) 

[15] Background Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[16] Slope Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[17] Power parameter—for the Quantal Linear model, Power is set to a constant value 
of 1, regardless of what appears here in the input file. 

[18] Initialize Parameters 

= 1 if one or more parameters are set to initialized 

= 0 otherwise 

[19] Background Parameter. 
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= User specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected 

[20] Slope Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected 

[21] Power Parameter—Constant value -9999 for Quantal Linear model. 

[22] Dose Name 

[23] Response Name 

[24] Constant String: NEGATIVE_RESPONSE 

Data 

Dose in first column 

Response in Second 

Total minus Response in third column 

Example Format 

[1] QuantalLinear 

[2] BMDS MODEL RUN 

[3] EXAMPLE.SET 

[4] EXAMPLE 

[5] 4 

[6-11] 250 2.22045e-16 1.49012e-8 1 1 1 1 0 

[12-14] 0.10 0 0.95 

[15-17] -9999 -9999 1 

[18] 0 

[19-21] -9999 -9999 -9999 

[22-24] Dose Resp NEGATIVE_RESPONSE 

0 3 47 

50 6 44 

100 10 40 

150 19 31 

See also: 

Input File Format Descriptions 

Quantal Linear Model Description 
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RAI AND VAN RYZIN NESTED MODEL INPUT FILE 

[1] Model name, here constant string RaiVR 

[2] User notes 

[3] Input file name 

[4] Output file name 

[5] Number of Observations 

[5a] Number of Dose groups 

[6a] Maximum # of iterations 

= Default of 500 if user does not input a value 

= User input value otherwise 

[6b] Rel Function Convergence 

= Default of 1.00E-08 if user does not input a value 

= User input value otherwise 

[6c] Parameter Convergence. 

= Default of 1.00E-08 if user does not input a value 

= User input value otherwise 

[7] BMDL Curve Calculation 

= 1 if BMDL Curve Calculation box is checked 

= 0 otherwise 

[8] Restrict Power >= 1 (Note: Power = Rho parameter in model) 

= 1 if Restrict Power >= 1 box is checked 

= 0 otherwise 

[9] BMD Calculation 

= 1 if BMD calculation box is checked 

= 0 otherwise 

[10] Fixed Size 

= 1 if Ctrl Group Mean selected 

= 0 if overall mean selected 

[11] Append or Overwrite Output File 

= 1 if Append is selected 

= 0 if Overwrite is selected 
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Note  This parameter is automatically set to 0 by the user interface and can only 
be changed by manually editing the .(d) file. 

[12] Smooth Option 

= 0 if Unique 

= 1 if C-Spline 

[13] BMR (BMR level) 

= User input value (or default of .100) 

[14] Risk Type 

= 0 if Extra 

= 1 if Added 

[15] Confidence Level 

= User input value (or default of .950) 

[16] Bootstrap Iterations 

= User input value (or default of 1000) 

[17] Seed 

= If specified, user input value in decimal format (or default of 0) 

[18] Alpha Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[19] Rho Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[20] Beta Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[21] Theta1 Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[22] Theta2 Parameter 

= User input value if Specified Option is selected 
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= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[23] Phi1 Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[24] Phi2 Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[25] Phi3 Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[26+] Phi4 through Phi10 if necessary (as many Phi parameters as dose groups) 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[27] Initialize Parameters 

= 1 if one or more parameters are set to initialized 

= 0 otherwise 

[28] Alpha Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[29] Rho Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[30] Beta Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[31] Theta1 Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[32] Theta2 Parameter 
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= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[33] Phi1 Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[34] Phi2 Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[35] Phi3 Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[36+] Phi4 through Phi10 if necessary (as many Phi parameters as dose groups) 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if not checked 

[37] Dose Name 

[38] Response Name 

[39] Constant String: NEGATIVE_RESPONSE 

[40] Litter Specific Covariate 

[41] Column 5 name 

Data 

Dose in first column 

Response in Second 

Total (Litter Size) minus Response in third column 

Litter Size 

Example Format 

[1] Rai_and_Van_Ryzin 

[2] BMDS MODEL RUN 

[3] C:\usepa\BMDS260_alpha111014_b\Data\Nested.dax 

[4] C:\usepa\BMDS260_alpha111014_b\Data\rvr_Nested_Opt.out 

 

[5-5a] 39 4 

[6-12] 
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500 1.00E-08 1.00E-08 0 1 1 0 0 0 

[13-17] 0.1000 0 0.95 1000 0 

[18-22] -9999 -9999 -9999 -9999 -9999 

[23-26+] -9999 -9999 -9999 -9999 

[27] 0 

[28-32] -9999 -9999 -9999 -9999 -9999 

[33-36+] -9999 -9999 -9999 -9999 

[37-41] Dose Resp Negative_Resp Covariate Dose_Group 

0 1 15 16 -9999 

0 1 8 9 -9999 

0 2 13 15 -9999 

0 3 11 14 -9999 

0 3 10 13 -9999 

0 0 9 9 -9999 

0 2 8 10 -9999 

0 2 12 14 -9999 

0 1 9 10 -9999 

0 2 9 11 -9999 

25 4 10 14 -9999 

25 5 4 9 -9999 

25 6 8 14 -9999 

25 2 7 9 -9999 

25 6 7 13 -9999 

25 3 9 12 -9999 

25 1 9 10 -9999 

25 2 8 10 -9999 

25 4 7 11 -9999 

25 3 11 14 -9999 

50 4 7 11 -9999 

50 5 6 11 -9999 

50 5 9 14 -9999 

50 4 7 11 -9999 

50 5 5 10 -9999 
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50 4 7 11 -9999 

50 5 5 10 -9999 

50 6 9 15 -9999 

50 2 5 7 -9999 

50 4 10 14 -9999 

100 6 5 11 -9999 

100 6 8 14 -9999 

100 8 4 12 -9999 

100 7 6 13 -9999 

100 8 4 12 -9999 

100 6 8 14 -9999 

100 6 5 11 -9999 

100 5 3 8 -9999 

100 4 6 10 -9999 

See also: 

Input File Format Descriptions 

Ray and Van Ryzin Model Description 

WEIBULL DICHOTOMOUS MODEL INPUT FILE 

[1] Model name, in this case, the string Weibull 

[2] User notes 

[3] Input file name 

[4] Output file name 

[5] Number of Observations 

[6a] Maximum # of iterations 

= Default of 500 if user does not input a value 

= User input value otherwise 

[6b] Rel Function Convergence 

= Default of 2.22045e-16 if user does not input a value 

= User input value otherwise 

[6c] Parameter Convergence. 

= Default of 1.49012e-8 if user does not input a value 
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= User input value otherwise 

[7] BMDL Curve Calculation 

= 1 if BMDL Curve Calculation box is checked 

= 0 otherwise 

[8] Restrict power >= 1 

= 1 if Restrict Power >= 1 box is checked 

= 0 otherwise 

[9] BMD Calculation 

= 1 if BMD calculation box is checked 

= 0 otherwise 

[10] Append or Overwrite Output File 

= 1 if Append is selected 

= 0 if Overwrite is selected 

Note  This parameter is automatically set to 0 by the user interface and can only 
be changed by manually editing the .(d) file. 

[11] Smooth Option 

= 0 if Unique 

= 1 if C-Spline 

[12] BMR (BMR level) 

= User input value (or default of .100) 

[13] Risk Type 

= 0 if Extra 

= 1 if Added 

[14] Confidence Level 

= User input value (or default of .950) 

[15] Background Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[16] Slope Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 
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[17] Power parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[18] Initialize Parameters 

= 1 if one or more parameters are set to initialized 

= 0 otherwise 

[19] Background Parameter. 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected 

[20] Slope Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected 

[21] Power Parameter 

= user specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected 

[22] Dose Name 

[23] Response Name 

[24] Constant String: NEGATIVE_RESPONSE 

etc. 

Data 

Dose in first column 

Response in Second 

Total minus Response in third column 

Example Format 

[1] Weibull 

[2] BMDS MODEL RUN 

[3] EXAMPLE.SET 

[4] EXAMPLE 

[5] 4 

[6-11] 250 2.22045e-16 1.49012e-8 1 1 1 1 0 

[12-14] 0.10 0 0.95 

[15-17] -9999 -9999 -9999 
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[18] 0 

[19-21] -9999 -9999 -9999 

[22-24] Dose Resp NEGATIVE_RESPONSE 

0 3 47 

50 6 44 

100 10 40 

150 19 31 

See also: 

Input File Format Descriptions 

Weibull Model Description 

WEIBULL DICHOTOMOUS ALTERNATIVE MODEL WITH 
BACKGROUND DOSE INPUT FILE 

[1] Model name, in this case, the string Weibull 

[2] User notes 

[3] Input file name 

[4] Output file name 

[5] Number of Observations 

[6a] Maximum # of iterations 

= Default of 500 if user does not input a value 

= User input value otherwise 

[6b] Rel Function Convergence 

= Default of 1.00E-08 if user does not input a value 

= User input value otherwise 

[6c] Parameter Convergence. 

= Default of 1.00E-08 if user does not input a value 

= User input value otherwise 

[7] BMDL Curve Calculation 

= 1 if BMDL Curve Calculation box is checked 

= 0 otherwise 

[8] Restrict power >= 1 

= 1 if Restrict Power >= 1 box is checked 



Benchmark Dose Software (BMDS) User Guide  Appendix A: Input File Format Descriptions 

BMDS version: 2.6.0.1 Page 265 of 310 Release Date: February 12, 2016 

= 0 otherwise 

[9] BMD Calculation 

= 1 if BMD calculation box is checked 

= 0 otherwise 

[10] Append or Overwrite Output File 

= 1 if Append is selected 

= 0 if Overwrite is selected 

Note  This parameter is automatically set to 0 by the user interface and can only 
be changed by manually editing the .(d) file. 

[11] Smooth Option 

= 0 if Unique 

= 1 if C-Spline 

[12] BMR (BMR level) 

= User input value (or default of .100) 

[13] Risk Type 

= 0 if Extra 

= 1 if Added 

[14] Confidence Level 

= User input value (or default of .950) 

[15] Background Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[16] Slope Parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[17] Power parameter 

= User input value if Specified Option is selected 

= -9999 if Specified is not selected or when the user selects the Specified option, but 
does not enter a value 

[18] Initialize Parameters 

= 1 if one or more parameters are set to initialized 
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= 0 otherwise 

[19] Background Parameter. 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected 

[20] Slope Parameter 

= User specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected 

[21] Power Parameter 

= user specified initial value if “initialized” is selected for this parameter 

= -9999 if “initialized” is not selected 

[22] Dose Name 

[23] Response Name 

[24] Constant String: NEGATIVE_RESPONSE 

etc. 

Data 

Dose in first column 

Response in Second 

Total minus Response in third column 

Example Format 

[1] Weibull-BgDose 

[2] BMDS_MODEL_RUN 

[3] C:\usepa\BMDS250\Data\Dichotomous.dax 

[4] C:\usepa\BMDS250\Data\web_Dichotomous_Opt.out 

[5] 5 

[6-11] 500 1.00E-08 1.00E-08 0 1 1 0 0 

[12-14] 0.1000 0 0.95 

[15-17] -9999 -9999 -9999 

[18] 0 

[19-21] -9999 -9999 -9999 

[22-24] Dose Effect NEGATIVE_RESPONSE 

0 0 100 

50 5 95 
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100 30 70 

150 65 35 

200 90 10 

See also: 

Input File Format Descriptions 

Weibull Model Description 
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APPENDIX B: MODEL OPTIONS SCREEN REFERENCE 

DICHOTOMOUS MODEL OPTIONS FIELDS 

COLUMN ASSIGNMENTS 

Use the picklists to assign columns from the data file to the parameters that are 
required for model runs. 

BMDS expects the following fields to be defined: 

 Dose 

 # Subjects in Dose Group 

 Incidence 

 % Positive 

OPTIMIZER ASSIGNMENTS 

Specify information controlling the determination of convergence of the model 
runs. In general, you can safely leave these settings at their default values.  

Table 30: Dichotomous model optimization parameters 

Parameter Function 

Iteration An upper limit to the number of iterations that will be used in 
the optimizations (default = 250). 

Relative Function This specifies the criterion for ascertaining relative function 
convergence (default = 1.0e-8). 

Parameter Function This specifies the criterion for ascertaining parameter 
convergence (default = 1.0e-8). 

PARAMETER ASSIGNMENTS 

Choose one of three values related to the displayed parameters. Note: Not all 
models have these parameters.  

The parameters are: 

 Background 

 Slope 
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 Power 

 Intercept 

 Beta 1–18 

Table 31 describes the value you can select for each parameter. 

Table 31: Dichotomous model parameters 

Values Function 

Default The initial estimated value for a parameter is determined by the 
program and its value will vary during optimizations. 

Specified The initial value for a parameter is as specified by the user and its 
value will remain at that specified value during all optimizations. See 
“Parameter Ranges for Dichotomous Models” below.  

Initialized The initial estimated value for a parameter is entered by the user but 
its value will vary during optimizations. See “Parameter Ranges” 
below.  

If the Initialized option is selected for any parameter, the user 
must choose the Specified or Initialized option for all parameters. 

Parameter Ranges for Dichotomous Models 

 Background (if specified or initialized): The Background parameter must be a 

number 0 and 1. [Note: not all models have a Background parameter.] 

 Power (if specified or initialized): The Power parameter must be a positive 

number, 18. If user has chosen to restrict Power, it must also be 1; 
otherwise Power must be >0. [Note: not all models have a Power parameter. 

 Weibull model: The Power parameter, if specified or initialized, must be a 

positive number, 18. If the user has chosen to restrict Power, it must also 

be 1; otherwise Power must be greater than or equal to the value the 
user entered for the Lower Bound on Power (strictly greater than that 
bound if it is 0). 

 Slope (if specified or initialized): The Slope parameter must be a number >0. 

If user has chosen to restrict Slope, it must also be 1; otherwise Slope must 
be >0. [Note: not all models have a Slope parameter.] 
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OTHER ASSIGNMENTS 

Select parameter constraints and choices for BMD and BMDL calculations. All 
models contain the following fields in the Other Assignments section.  

Table 32: Dichotomous model parameters for BMD and BMDL calculations 

Parameter Function 

Risk Type Choices are “Extra” (Default) or “Added.” 

 Added risk is the additional proportion of total animals that 
respond in the presence of the dose, or the predicted 
probability of response at dose d, P(d), minus the predicted 
probability of response in the absence of exposure, P(0). 

 Extra risk is the additional risk divided by the predicted 
proportion of animals that will not respond in the absence of 
exposure, 1—P(0). 

The BMRF for all dichotomous models must be between 0 
and 1 (not inclusive). 

BMR The response, generally expressed as in excess of background, 
at which a benchmark dose or concentration is desired. User 
input value (or default of .1000). BMR must be a number >0 and 
<1. 

Confidence Level The confidence level (default 0.95) associated with the BMDL 
calculation. Confidence level must be a number >0 and <1. 

BMD Calculation Specifies whether or not the user wants a BMD (with associated 
BMDL) calculated. 

BMDL Curve Calc When this option is selected, the graph resulting from the model 
run will display a blue BMDL curve. The BMDL curve is estimated 
by calculating the BMDL for BMDs at BMRs of 1, 5, 10, 20 and 
30%, and connecting these points via either a straight line or a 
curve. 

The calculation of the BMDL curve has been known to cause 
some convergence problems and can significantly increase 
computer run time, particularly if several models are being run in 
a session. 

Thus, the current default and recommended option is to not 
request calculation of the BMDL curve unless absolutely 
necessary (the BMDL for the requested BMRF will still be 
estimated and displayed in the output file regardless of the choice 
for this option). 

Dose Groups This is a read-only field indicating the number of Dose groups 
recorded from the dataset file for input into the model.  
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Parameter Function 

Restrict Slope >= 1 Models: LogLogistic, Log-Probit, Dichotomous-Hill 

Selecting this feature (Default for LogLogistic and Dichotomous 
Hill models) restricts the slope parameter (β) to a value of 1 or 
greater. 

 For the LogLogistic and Dichotomous Hill models, if β < 1, the 
slope of the dose-response curve becomes infinite at the 
control dose. 

 For the LogProbit and LogProbit-BgDose models, the slope of 
the dose-response curve can be very steep at low doses at or 
below the BMD or BMDL, before it becomes smaller 
approaching zero dose. 

Such characteristics, for all four models, may be biologically 
unrealistic, and can lead to numerical problems. 

Restrict Power >= 1 Models: Gamma , Weibull 

Selecting this feature (Default) restricts the power parameter (α) 
to a value of 1 or greater. 

If α < 1, then the slope of the dose-response curve becomes 
infinite at the control dose. This may be biologically unrealistic, 
and can lead to numerical problems when computing confidence 
limits, so EPA recommends restricting α ≥ 1. 

Degree of Polynomial Models: Multistage, Multistage-Cancer 

This is the degree of the polynomial model that will be used, or 
the number of times dose is factored into the model equation 
(maximum = 23). The degree must be a positive integer (typically 
less than the number of dose groups.) 

A value must be entered here before the model will run. 
Polynomial degree should not exceed the number of dose groups 
unless the beta coefficients of the model are specified or 
restricted (beta coefficients are always restricted in the 
multistage-cancer model). 

Restrict Betas >= 0 Model: Multistage 

Selecting this feature (Default) restricts all of the beta (β) 
parameter coefficients in the multistage model to a value of 0 or 
greater. 

Lower Bound on Power Model: Weibull 

 If “Restrict Power>=1” is selected, then a default value of 1 is 
entered. If a zero is entered, then the model should set a lower 
bound of 1e-8. 

 If “Restrict Power>=1” is unselected, then enter a non-negative 

value 18.  

Note About BMRF and Graphs 
The response associated with the BMR that is displayed in the graphical 
model output will only be the same as the BMR when P(0) = 0. This is 
because to obtain the actual response value one must solve for P(d) in the 
equation for added or extra risk. In addition to the two options listed above 
for all dichotomous models, the following options are available for specific 
models of the Dichotomous or Dichotomous_Alternative Type. 
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FILE-RELATED FIELDS 

Table 33: File-related fields 

Field Function 

User Notes An editable field of up to 80 characters in length. The content 
of this field will be displayed in a single line of text under the 
date in the *.out file. 

Data File A field displaying the name of the data file (*.dax) file. 

Out File Name Displays the output path and file name. Click the Set button 
to change the file name and/or location. 

See also: 

 Dichotomous and Dichotomous_Alternative Model Option Screens 

 Dichotomous Model Descriptions 

 Dichotomous Alternative Model Descriptions 

 Optimization Criteria 

DICHOTOMOUS_ALTERNATIVE MODEL OPTIONS FIELDS 

COLUMN ASSIGNMENTS 

Use the picklists to assign columns from the data file to the parameters that are 
required for model runs. 

BMDS expects the following fields to be defined: 

 Dose 

 # Subjects in Dose Group 

 Incidence 

 % Positive 

OPTIMIZER ASSIGNMENTS 

Specify information controlling the determination of convergence of the model 
runs. In general, you can safely leave these settings at their default values.  
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Table 34: Dichotomous Alternative model optimization parameters 

Parameter Function 

Iteration An upper limit to the number of iterations that will be used in 
the optimizations (default = 250). 

Relative Function This specifies the criterion for ascertaining relative function 
convergence (default = 1.0e-8). 

Parameter Function This specifies the criterion for ascertaining parameter 
convergence (default = 1.0e-8). 

PARAMETER ASSIGNMENTS 

Choose one of three values related to the displayed parameters. Note: Not all 
models have these parameters.  

The parameters are: 

 v 

 g 

 Background 

 Slope 

 Power 

 Intercept 

 Beta 1–18 

The following table describes the value you can select for each parameter. 

Table 35: Dichotomous Alternative model parameters 

Values Function 

Default The initial estimated value for a parameter is determined by the 
program and its value will vary during optimizations. 

Specified The initial value for a parameter is as specified by the user and its 
value will remain at that specified value during all optimizations. See 
“Parameter Ranges” below.  

Initialized The initial estimated value for a parameter is entered by the user but 
its value will vary during optimizations. See “Parameter Ranges for 
Dichotomous Models” below.  

If the Initialized option is selected for any parameter, you must 
choose the Specified or Initialized option for all parameters. 



Benchmark Dose Software (BMDS) User Guide  Appendix B: Model Options Screen Reference 

BMDS version: 2.6.0.1 Page 274 of 310 Release Date: February 12, 2016 

Parameter Ranges for Dichotomous Models 

 v (if specified or initialized): The parameter v must be a number 0 and 1. 
[Note: not all models have a v parameter.] 

 g (if specified or initialized): The parameter g must be a number 0 and 1. 
[Note: not all models have a g parameter.] 

 Background (if specified or initialized): The Background parameter must be a 

number 0 and 1. [Note: not all models have a Background parameter.] 

 Power (if specified or initialized): The Power parameter must be a positive 

number, 18. If user has chosen to restrict Power, it must also be 1; 
otherwise Power must be >0. [Note: not all models have a Power parameter. 

 Weibull model: The Power parameter, if specified or initialized, must be a 

positive number, 18. If the user has chosen to restrict Power, it must also 

be 1; otherwise Power must be greater than or equal to the value the 
user entered for the Lower Bound on Power (strictly greater than that 
bound if it is 0). 

 Slope (if specified or initialized): The Slope parameter must be a number 0. 

If user has chosen to restrict Slope, it must also be 1; otherwise Slope must 

be 0. [Note: not all models have a Slope parameter.] 

OTHER ASSIGNMENTS 

Select parameter constraints and choices for BMD and BMDL calculations. All 
models contain the following fields in the Other Assignments section.  

Table 36: Dichotomous Alternative model parameters for BMD and BMDL calculations 

Parameter Function 

Risk Type Choices are “Extra” (Default) or “Added.” 

 Added risk is the additional proportion of total animals that 
respond in the presence of the dose, or the predicted probability 
of response at dose d, P(d), minus the predicted probability of 
response in the absence of exposure, P(0). 

 Extra risk is the additional risk divided by the predicted proportion 
of animals that will not respond in the absence of exposure, 1—
P(0). 

The BMRF for all dichotomous models must be between 0 and 
1 (not inclusive). 

BMR The response, generally expressed as in excess of background, at 
which a benchmark dose or concentration is desired. User input 
value (or default of .1000). BMR must be a number >0 and <1. 

Confidence Level The confidence level (default 0.95) associated with the BMDL 
calculation. Confidence level must be a number >0 and <1. 
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Parameter Function 

BMD Calculation Specifies whether or not the user wants a BMD (with associated 
BMDL) calculated. 

BMDL Curve Calc When this option is selected, the graph resulting from the model run 
will display a blue BMDL curve. The BMDL curve is estimated by 
calculating the BMDL for BMDs at BMRs of 1, 5, 10, 20 and 30%, 
and connecting these points via either a straight line or a curve. 

The calculation of the BMDL curve has been known to cause some 
convergence problems and can significantly increase computer run 
time, particularly if several models are being run in a session. 

Thus, the current default and recommended option is to not 
request calculation of the BMDL curve unless absolutely 
necessary (the BMDL for the requested BMRF will still be estimated 
and displayed in the output file regardless of the choice for this 
option). 

Dose Groups This is a read-only field indicating the number of Dose groups 
recorded from the dataset file for input into the model. 

Restrict Slope >= 1 Models: LogLogistic, Log-Probit, Dichotomous-Hill 

Selecting this feature (Default for LogLogistic and Dichotomous Hill 
models) restricts the slope parameter (β) to a value of 1 or greater. 

 For the LogLogistic and Dichotomous Hill models, if β < 1, the 
slope of the dose-response curve becomes infinite at the control 
dose. 

 For the LogProbit and LogProbit-BgDose models, the slope of the 
dose-response curve can be very steep at low doses at or below 
the BMD or BMDL, before it becomes smaller approaching zero 
dose. 

Such characteristics, for all four models, may be biologically 
unrealistic, and can lead to numerical problems. 

Restrict Power >= 1 Models: Gamma , Weibull 

Selecting this feature (Default) restricts the power parameter (α) to a 
value of 1 or greater. 

If α < 1, then the slope of the dose-response curve becomes infinite 
at the control dose. This may be biologically unrealistic, and can 
lead to numerical problems when computing confidence limits, so 
EPA recommends restricting α ≥ 1. 

Degree of Polynomial Models: Multistage, Multistage-Cancer 

This is the degree of the polynomial model that will be used, or the 
number of times dose is factored into the model equation (maximum 
= 23). The degree must be a positive integer (typically less than the 
number of dose groups.) 

A value must be entered here before the model will run. Polynomial 
degree should not exceed the number of dose groups unless the 
beta coefficients of the model are specified or restricted (beta 
coefficients are always restricted in the multistage-cancer model). 

Restrict Betas >= 0 Model: Multistage 

Selecting this feature (Default) restricts all of the beta (β) parameter 
coefficients in the multistage model to a value of 0 or greater. 
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Parameter Function 

Lower Bound on 
Power 

Model: Weibull 

 If “Restrict Power>=1” is selected, then a default value of 1 is 
entered. 

 If “Restrict Power>=1” is unselected, then enter a value from 0-. 

Note About BMRF and Graphs 
The response associated with the BMR that is displayed in the graphical 
model output will only be the same as the BMR when P(0) = 0. This is 
because to obtain the actual response value one must solve for P(d) in the 
equation for added or extra risk. In addition to the two options listed above 
for all dichotomous models, the following options are available for specific 
models of the Dichotomous or Dichotomous_Alternative Type. 

FILE-RELATED FIELDS 

Table 37: File-related fields 

Field Function 

User Notes An editable field of up to 80 characters in length. The 
content of this field will be displayed in a single line of text 
under the date in the *.out file. 

Data File A field displaying the name of the data file (*.dax) file. 

Out File Name Displays the output path and file name. Click the Set button 
to change the file name and/or location. 

See also: 

 Dichotomous and Dichotomous_Alternative Model Option Screens 

 Dichotomous Model Descriptions 

 Dichotomous Alternative Model Descriptions 

 Optimization Criteria 

CONTINUOUS MODEL OPTIONS FIELDS 

COLUMN ASSIGNMENTS 

Use the picklists to assign columns from the data file to the parameters that are 
required for model runs. 

BMDS expects the following fields to be defined: 
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 Dose 

 # Subjects in Dose Group 

 Mean 

 Std. Deviation 

 Response 

PARAMETER ASSIGNMENTS 

Choose one of three values related to the displayed parameters. Note: Not all 
models have these parameters.  

The parameters are: 

 Alpha 

 Rho 

 Control 

 Slope 

 Power 

 Beta 0–18 

 v 

 n 

 k 

The following table describes the value you can select for each parameter. 

Table 38: Continuous model option parameters 

Values Function 

Default The initial estimated value for a parameter is determined by the 
program and its value will vary during optimizations. 

Specified The initial value for a parameter is as specified by the user and its 
value will remain at that specified value during all optimizations. See 
“Parameter Ranges” below.  

Initialized The initial estimated value for a parameter is entered by the user but 
its value will vary during optimizations. See “Parameter Ranges for 
Continuous Models” below.  

If the Initialized option is selected for any parameter, you must 
choose the Specified or Initialized option for all parameters. 
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Parameter Ranges for Continuous Models 

 n (if specified or initialized): The parameter n must be a positive number. Also 
consider its restriction). 

 k (if specified or initialized): The parameter k must be a positive number. 

 Power: (if specified or initialized): The Power parameter must be a positive 

number, 18. If user has chosen to restrict Power, it must also be 1; 
otherwise Power must be >0. 

OTHER ASSIGNMENTS 

Select parameter constraints and choices for BMD and BMDL calculations. All 
models contain the following fields in the Other Assignments section. 

Table 39: Continuous model parameters for BMD and BMDL calculations 

Parameter Function 

Adverse Direction Refers to whether adversity increases as the dose-response 
curve rises “up” or falls “down.” Choices are “Automatic” 
(Default), “Up,” or “Down.” 

If automatic is chosen, the software chooses the adverse 
direction based on the shape of the dose-response curve. 
However, you can manually choose the adverse direction if you 
know the direction of adversity for the endpoint being studied. 

This selection only impacts how the user-designated BMR is 
used in conjunction with model results to obtain the BMD. 
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Parameter Function 

BMR Type The method of choice for defining the response level used to 
derive the benchmark dose (BMD). 

 Rel. Dev. (Relative Deviation) means the response 
associated with the BMR will be the background estimate plus 
or minus (depending on the Adverse Direction) the product of 
the background estimate times the BMRF entered by the 
user. 

 Abs. Dev. (Absolute Deviation) means the response 
associated with the BMR will be the background estimate plus 
or minus the BMRF. 

 Std. Dev. (Standard Deviation) means the response 
associated with the BMR will be the background estimate plus 
or minus the product of the BMRF times the standard 
deviation for the control group data. 

 Point means the response associated with the BMR will be 
the BMRF value itself. 

 Extra (Hill model only) means the response associated with 
the BMR will be the background estimate plus or minus the 
product of the BMRF times the difference between the 
background estimate and the model estimate of the 
maximum/minimum response. “Extra” is similar to Extra risk 
for dichotomous data, except that the maximum (or minimum) 
achievable response is not 1, but is estimated from the model. 

For more information on the mathematical formula behind each 
choice, see Continuous Model Option Screen. 

When response data is lognormally distributed, the BMR Types 
acquire different meanings. As of BMDS 2.4, only continuous 
exponential models can assume lognormal distribution. For 
more information, refer to Unique Options for Exponential 
Models. 

BMRF The factor defining the benchmark response level. Its value will 
depend on the Risk Type or BMR Type specified by the user 
(one of these types will also be in the Other Assignments 
section, depending on the model type). BMRF must be a 
positive number. If the BMR Type is “Extra,” BMRF must also be 
>0 and <1. 

Confidence Level The confidence level (default 0.95) associated with the BMDL 
calculation. Confidence level must be a number >0 and <1. 

Constant Variance When selected (Default), the model assumes a constant 
variance across all dose groups. 

If not selected, then the model assumes that the variance can 
be different for each dose group, and varies as a power function 
of the mean response (see Continuous Model Descriptions for 
more details). 

BMD Calculation Specifies whether or not the user wants a BMD (with associated 
BMDL) calculated. 
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The following options are available for specific continuous models. 

Table 40: Options for specific continuous models 

Parameter Function 

Degree of Polynomial Models: Linear, Polynomial 

This is the degree of the polynomial model that will be used, 
or the number of times dose is factored into the model 
equation (maximum = 21). A value must be entered here 
before the model will run. Polynomial degree should be a 
positive integer and should not exceed the number of dose 
groups unless the beta coefficients of the model are restricted. 

For the linear model, this field is set to 1 and is not editable. 

Restrict Power >= 1 Models: Power, Exponential 

The power parameter can be restricted to be greater than or 
equal to one. The power is unrestricted if this option is not 
selected. This option is currently disabled for the exponential 
models. 

Restrict n>1 Model: Hill 

The n parameter of the Hill model can be restricted to be 
greater than one. The n parameter is unrestricted if this option 
is not selected. 

Restriction Models: Linear, Polynomial 

Restrictions on coefficients of the dose terms can be “None” 
(Default), “Non-negative” (>0), or “Non-positive” (<0). 

Note that, while no restrictions (None) is the current default for 
this option, the user should specify that the parameters be 
restricted to either Non-negative or Non-positive values 
whenever possible to avoid “wavy” model responses (see 
details in Polynomial Model description). Since there is only 
one dose coefficient in the continuous Linear model, this is 
sometimes referred to as restricting the slope of this model. 

BMDL Curve Calc Models: Linear, Polynomial, Power 

When this option is selected, the graph resulting from the 
model run will display a blue BMDL curve. The BMDL curve is 
estimated by calculating the BMDL for BMDs at BMRs of 1, 5, 
10, 20 and 30%, and connecting these points via either a 
straight line or a curve. 

The calculation of the BMDL curve has been known to cause 
some convergence problems and can significantly increase 
computer run time, particularly if several models are being run 
in a session. 

Thus, the current default and recommended option is to not 
request calculation of the BMDL curve unless absolutely 
necessary (the BMDL for the requested BMRF will still be 
estimated and displayed in the output file regardless of the 
choice for this option). 
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FILE-RELATED FIELDS 

Table 41: File-related fields 

Field Function 

User Notes An editable field of up to 80 characters in length. The content 
of this field will be displayed in a single line of text under the 
date in the *.out file. 

Data File A field displaying the name of the data file (*.dax) file. 

Out File Name Displays the output path and file name. Click the Set button to 
change the file name and/or location. 

See also: 

 Continuous Exponential Model Options Fields 

 Continuous Models—Descriptions 

 Unique Options for Exponential Models 

CONTINUOUS EXPONENTIAL MODEL OPTIONS FIELDS 

COLUMN ASSIGNMENTS 

Use the picklists to assign columns from the data file to the parameters that are 
required for model runs. 

BMDS expects the following fields to be defined: 

 Dose 

 # Subjects in Dose Group 

 Mean 

 Std. Deviation 

 Response 

OTHER ASSIGNMENTS 

Select parameter constraints and choices for BMD and BMDL calculations. All 
models contain the following fields in the Other Assignments section. 
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Table 42: Continuous Exponential model parameters for BMD and BMDL calculations 

Parameter Function 

Distribution Specify whether the data are Normally or Lognormally distributed 
around the dose-group-specific means. 

The choice of the distribution affects the type of maximum-likelihood 
estimation (MLE) solution that may be obtained (see the description 
for the Solution option). 

Moreover, when a lognormal distribution is assumed, only constant 
(log-scale) variance models will be fit to the data; such models 
correspond to an assumption of a constant coefficient of variation. 

Solution Choose to get an “Exact” or “Approximate” maximum-likelihood 
estimation (MLE) solution. 

When the data are assumed to be normally distributed, the choice 
is fixed at “Exact” because the exact solution is available no matter 
how the data are presented (either as group-specific means and 
variances or as individual responses). 

When the data are assumed to be lognormally distributed and the 
data are presented in terms of group-specific means and standard 
deviations, then the exact MLE solution cannot be obtained. In that 
case, the “Solution” option is fixed at “Approximate” and the means 
and standard deviations of the log-transformed data are estimated 
as follows: 

log-scale mean = ln(mean)—ln(1+(std/mean)2)/2 

log-scale std = sqrt[ln(1+(std/mean)2)] 

When the data are assumed to be lognormally distributed and the 
individual responses are available the user may choose between the 
exact and approximate solutions. In this case, the user is advised to 
select the exact solution; the only reason to select the approximate 
solution in this case would be to compare it to other calculations that 
were done approximately out of necessity. 

Confidence Level The confidence level (default 0.95) associated with the BMDL 
calculation. Confidence level must be a number >0 and <1. 

Constant Variance When selected (Default), the model assumes a constant variance 
across all dose groups. 

If not selected, then the model assumes that the variance can be 
different for each dose group, and varies as a power function of the 
mean response (see Continuous Model Descriptions for more 
details). 

BMD Calculation Specifies whether or not the user wants a BMD (with associated 
BMDL) calculated. 

Restrict Power >= 1 The power parameter can be restricted to be greater than or equal 
to one. The power is unrestricted if this option is not selected. This 
option is currently disabled for the exponential models. 
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Parameter Function 

Adverse Direction Refers to whether adversity increases as the dose-response curve 
rises “up” or falls “down.” Choices are “Automatic” (Default), “Up,” or 
“Down.” 

If automatic is chosen, the software chooses the adverse direction 
based on the shape of the dose-response curve. However, you can 
manually choose the adverse direction if you know the direction of 
adversity for the endpoint being studied. 

This selection only impacts how the user-designated BMR is used in 
conjunction with model results to obtain the BMD. 

BMR Type The method of choice for defining the response level used to derive 
the benchmark dose (BMD). 

 Rel. Dev. (Relative Deviation) means the response associated 
with the BMR will be the background estimate plus or minus 
(depending on the Adverse Direction) the product of the 
background estimate times the BMRF entered by the user. 

 Abs. Dev. (Absolute Deviation) means the response associated 
with the BMR will be the background estimate plus or minus the 
BMRF. 

 Std. Dev. (Standard Deviation) means the response associated 
with the BMR will be the background estimate plus or minus the 
product of the BMRF times the standard deviation for the control 
group data. 

 Point means the response associated with the BMR will be the 

BMRF value itself. 

 Extra (Hill model only) means the response associated with the 
BMR will be the background estimate plus or minus the product of 
the BMRF times the difference between the background estimate 
and the model estimate of the maximum/minimum response. 
“Extra” is similar to Extra risk for dichotomous data, except that 
the maximum (or minimum) achievable response is not 1, but is 
estimated from the model. 

For more information on the mathematical formula behind each 
choice, see Continuous Model Option Screen. 

When response data is lognormally distributed, the BMR Types 
acquire different meanings. As of BMDS 2.4, only continuous 
exponential models can assume lognormal distribution. For more 
information, refer to Unique Options for Exponential Models. 

BMRF The factor defining the benchmark response level. Its value will 
depend on the Risk Type or BMR Type specified by the user (one of 
these types will also be in the Other Assignments section, 
depending on the model type). BMRF must be a positive number. If 
the BMR Type is “Extra,” BMRF must also be >0 and <1. 

Definition of BMR Types under Lognormal Distribution Assumption 

The Exponential models allow the user to assume that the response data are 
lognormally distributed, with median values defined by the dose-response 
function and a constant log-scale variance. Under such an assumption the BMR 
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types are defined and implemented so that they are calculated by the program to 
return BMDs as follows (where BMRF is the numerical value, specified by the 
user, indicating the response, or change in response, of interest): 

 Relative Deviation: The natural scale median value at the BMD, m(BMD), 
differs from the natural scale median at 0 dose, m(0), such that |m(BMD)—
m(0)|/m(0) = BMRF. 

 Absolute Deviation: The natural scale median value at the BMD, m(BMD), 
differs from the natural scale median at 0 dose, m(0), such that |m(BMD)—
m(0)| = BMRF. 

 Standard deviation: The log-scale mean at the BMD, ln(m(BMD)), differs 
from the log-scale mean at 0 dose, ln(m(0)), such that |ln(m(BMD))—

ln(m(0))|/(0) = BMRF, where σ(0) is the log-scale standard deviation at 0 

dose. Recall that (0) = ln(GSD(0)). This definition allows the user to use 
BMRF’s typical of an analysis where a normal distribution of responses is 
assumed (e.g., the EPA default of 1 standard deviation) and still maintain the 
logic and rationale for such choices, since the log-transformed response 
values under the lognormal assumption would themselves be normally 
distributed. 

 Point: The natural scale median value at the BMD, m(BMD), equals the 
BMRF, i.e., m(BMD) = BMRF. 

MODEL SELECTION 

The exponential model choice allows you to run up to four models that have 
exponential-dose terms. These models are referred to as exponential Models 2–
5 (following a designation by Dr. Wout Slob, wherein the restricted (flat) model 
was model 1). Refer to the section on Exponential Continuous Model Description 
for additional details. 

You may choose to run any or all of the exponential models when running from a 
Session screen. (When running on a single dataset by use of the data grid, all 
exponential models will be run.) Moreover, you may select to have the 
exponential model runs reported (grouped) together in one output file or on 
separate output files. 

 Model 2 

 Model 3 

 Model 4 

 Model 5 

 Grouped—Select to have the selected exponential model runs reported 
(grouped) together in one output file or on separate output files. 
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FILE-RELATED FIELDS 

Table 43: File-related fields 

Field Function 

User Notes An editable field of up to 80 characters in length. The 
content of this field will be displayed in a single line of text 
under the date in the *.out file. 

Data File A field displaying the name of the data file (*.dax) file. 

Out File Name Displays the output path and file name. Click the Set button 
to change the file name and/or location. 

See also: 

 Continuous Models—Descriptions 

 Exponential Continuous Model Description 

 Continuous Model Options Fields 

 Unique Options for Exponential Models 

NESTED MODEL OPTIONS FIELDS 

COLUMN ASSIGNMENTS 

Use the picklists to assign columns from the data file to the parameters that are 
required for model runs. 

BMDS expects the following fields to be defined: 

 Dose 

 Litter Size 

 Incidence 

 Litter Specific Covariate 

OPTIMIZER ASSIGNMENTS 

Specify information controlling the determination of convergence of the model 
runs. In general, you can safely leave these settings at their default values.  
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Table 44: Nested model optimization parameters 

Parameter Function 

Iteration An upper limit to the number of iterations that will be used in 
the optimizations (default = 250). 

Relative Function This specifies the criterion for ascertaining relative function 
convergence (default = 1.0e-8). 

Parameter Function This specifies the criterion for ascertaining parameter 
convergence (default = 1.0e-8). 

PARAMETER ASSIGNMENTS 

Choose one of three values related to the displayed parameters. Note: Not all 
models have these parameters.  

The parameters are: 

 Alpha 

 Rho 

 Beta 

 Theta1 

 Theta2 

 Phi1–10 

The following table describes the value you can select for each parameter. 

Table 45: Nested model parameter assignments 

Values Function 

Default The initial estimated value for a parameter is determined by the 
program and its value will vary during optimizations. 

Specified The initial value for a parameter is as specified by the user and its 
value will remain at that specified value during all optimizations. See 
“Parameter Ranges” below.  

Initialized The initial estimated value for a parameter is entered by the user but 
its value will vary during optimizations. See “Parameter Ranges for 
Nested Models” below.  

If the Initialized option is selected for any parameter, you must 
choose the Specified or Initialized option for all parameters. 

Parameter Ranges for Nested Models 

Any Phi (if specified or initialized): Phi must be a number 0 and 1. 
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OTHER ASSIGNMENTS 

Select parameter constraints and choices for BMD and BMDL calculations. All 
models contain the following fields in the Other Assignments section. 

Table 46: Nested model parameters for BMD and BMDL calculations 

Parameter Function 

Risk Type Choices are “Extra” (Default) or “Added.” 

 Added risk is the additional proportion of total animals that 
respond in the presence of the dose, or the probability of 
response at dose d, P(d), minus the predicted probability of 
response in the absence of exposure, P(0). 

 Extra risk is the additional risk divided by the predicted 
proportion of animals that will not respond in the absence of 
exposure, 1—P(0). 

Thus, extra and additional risk are equal when background rate 
is zero. 

Fixed Litter Size Choices are “Control Group Mean” (Default) or “Overall Mean.” 
See Nested Model Descriptions for an explanation as to why 
this option is necessary, and which choice would be preferred 
for your given dataset. 

Basically, if the Litter Specific Covariate is not affected by dose, 
the Overall Mean should be used. If the Litter Specific 
Covariate is affected by dose, consider using the Control 
Group Mean. 

Litter Specific Covariate Provides user with the option to allow the models to attempt to 
account for a litter specific covariate or not. 

 If “Use Litter Specific Covariate” is selected (Default), all of 
the Theta values are estimated. 

 If “Don't Use Litter Specific Covariate” is chosen, all of the 
Theta values are set to zero. 

Intralitter Correlations Provides user with the option to allow the models to attempt to 
estimate intralitter correlations or assume they are zero. 

 If “Estimate Intralitter Correlations” is selected (Default), all of 
the Phi values are estimated (one for each dose group). 

 If “Assume Intralitter Correlations Zero” is chosen, all of the 
Phi values are set to zero. 

Dose Groups This is a read-only field indicating the number of Dose groups 
recorded from the dataset file for input into the model. 

Restrict Power>=1 Selecting this feature (Default) restricts the power parameter 
(α) to a value of 1 or greater. 

If α < 1, then the slope of the dose-response curve becomes 
infinite at the control dose. This may be biologically unrealistic, 
and can lead to numerical problems when computing 
confidence limits, so EPA recommends restricting α ≥ 1. 

BMD Calculation Specifies whether or not the user wants a BMD (with 
associated BMDL) calculated. 
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Parameter Function 

BMDL Curve Calc When this option is selected, the graph resulting from the 
model run will display a blue BMDL curve. The BMDL curve is 
estimated by calculating the BMDL for BMDs at BMRs of 1, 5, 
10, 20 and 30%, and connecting these points via either a 
straight line or a curve. 

The calculation of the BMDL curve has been known to cause 
some convergence problems and can significantly increase 
computer run time, particularly if several models are being run 
in a session. 

Thus, the current default and recommended option is to 
not request calculation of the BMDL curve unless 
absolutely necessary (the BMDL for the requested BMRF will 
still be estimated and displayed in the output file regardless of 
the choice for this option). 

BMR The response, generally expressed as in excess of 
background, at which a benchmark dose or concentration is 
desired. User input value (or default of .1000). BMR must be a 
number >0 and <1. 

Confidence Level The confidence level (default 0.95) associated with the BMDL 
calculation. Confidence level must be a number >0 and <1. 

Bootstrap Iterations Specify the number of bootstrap iterations (default is 1000) to 
run to estimate goodness of fit. It is recommended to keep the 
value at a minimum of 1000.  

Specify Bootstrap Seed Select this feature to specify a bootstrap seed for the random 
number generator. Default is that BMDS auto-generates a seed 
for the random number generator based on the system clock. 

Seed (Hexadecimal Value) If Specify Bootstrap Seed is selected, enter the value here in 
hexadecimal form. Example: “1E240”.  

FILE-RELATED FIELDS 

Table 47: File-related fields 

Field Function 

User Notes An editable field of up to 80 characters in length. The content of 
this field will be displayed in a single line of text under the date 
in the *.out file. 

Data File A field displaying the name of the data file (*.dax) file. 

Out File Name Displays the output path and file name. Click the Set button to 
change the file name and/or location. 

See also: 

 Nested Model Options Fields 

 Nested Models—Descriptions 
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REPEATED RESPONSE MEASURES MODEL OPTIONS 
FIELDS 

COLUMN ASSIGNMENTS 

Use the picklists to assign columns from the data file to the parameters that are 
required for model runs. 

BMDS expects the following fields to be defined: 

 Animal ID 

 Dose 

 Time 

 Response 

PLOTTING ASSIGNMENTS 

The ToxicoDiffusion model includes graphical outputs showing the observed and 
model-predicted time-course data, residuals, and a summary of the bootstrap-
based BMDL calculations. You can specify the properties of the resulting graphs 
here. In general, you can safely leave these settings at their default values. 

 Chart Title (optional) 

 Time Axis Scale: Select either Natural (default) or Log. 

 # of Time Points: Default is 100. 

 X-Axis Minimum Value 

 X-Axis Maximum Value 

 Y-Axis Minimum Value 

 Y-Axis Maximum Value 

PARAMETER ASSIGNMENTS 

Choose one of three values related to the displayed parameters. Note: Not all 
models have these parameters.  

The parameters are: 

 A0 

 B0 
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 C0 

 K0 

 A1 

 A2 

The following table describes the value you can select for each parameter. 

Table 48: Repeated Response Measures model option parameters 

Values Function 

Default Enable the program to find initial values for the optimization runs 
(the default values of “-9999” shown in the option screen are 
merely flags to pass to the input file that indicate this default 
option—they are not real initial values) 

Initialized Initialize the parameter values to values of the user's choice.  

OTHER ASSIGNMENTS 

Table 49: Repeated Response Measures model option parameters 

Field Function 

Exposure Time The time must be a real number  0. 

The value should be chosen to be consistent with the timing of 
the observations as recorded in the data set. For example, if the 
exposure time is “4.5,” then exposure occurred at time 0, with the 
time of the first observation of a response occurring 4.5 hours 
later (if hours are the units used to designate the time 
parameter). 

Background Degree Specify the background degree that determines how the 
responses are assumed to vary over time in the absence of 
exposure. This background (without-exposure) variation is 
defined by a polynomial of the specified degree. 

Choices are: 

 0—Constant (default) 

 1—Linear 

 2—Quadratic 

BMR Risk Type Choices are : 

 Extra risk (default) is the additional risk divided by the 
predicted proportion of animals that will not respond in the 
absence of exposure, 1—P(0). 

 Added risk is the additional proportion of total animals that 
respond in the presence of the dose, or the predicted 
probability of response at dose d, P(d), minus the predicted 
probability of response in the absence of exposure, P(0).  
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Field Function 

BMR Risk Level The response, generally expressed as in excess of background, 
at which a benchmark dose or concentration is desired. User 
input value (or default of .05). It must be a number >0 and <1. 

Adverse Direction Refers to the “tail” of the distribution of the response variable 
where adverse values are assumed to fall. 

 Lowertail (default) means that low values are indicative of 
adversity; this is typically associated with a dose-response 
curve that decreases as exposure to a toxic substance 
increases. 

 Uppertail means that high values are indicative of adversity; 
this is typically associated with a dose-response curve that 
increases as exposure to a toxic substance increases. 

 Bothside indicates that values that are either high or low (i.e., 
far from the average response) are indicative of adversity; this 
option is less frequently used 

Adverse Definition Choices are Background Rate (default) or Cut Point. 

Adverse responses can be defined in one of two ways. 

 A background rate (probability) of adverse response is 
specified (e.g., a 5% rate of adverse response in the absence 
of exposure). Select Background Rate and then specify the 
rate in the Adverse Level field. 

 Specified cut-off value(s), with the assumption that values 
above or below (depending on the adverse direction) the cut-
off(s) are adverse. Select Cut Point to enable the Low Cut-off 
and High Cut-off fields (which fields are enabled is based on 
Adverse Direction). 

Adverse Level User-specified or .05 (default) if Adverse Definition = 
“Background Rate”. Field is disabled if Adverse Direction is “Cut 
Rate.” 

A value of .05 represents a 5% rate of adverse response in the 
absence of exposure. 

Low Cut-off User-specified or -9999 default. Values below the cut-off are 
adverse. 

Enabled when: 

 Adverse Direction is Lowertail or Bothside 

 Adverse Definition is Cut Point 

High Cut-off User-specified or -9999 default. Values above the cut-off are 
adverse 

Enabled when: 

 Adverse Direction is Uppertail or Bothside 

 Adverse Definition is Cut Point 

Use Two Sided CI? Default is unselected (i.e., one-sided). See the description of the 
Bootstrap Iterations parameter. 
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Field Function 

Confidence Level The confidence level (default 0.05) associated with the BMDL 
calculation. Confidence level must be a number >0 and <1. 

For “Confidence Level” the user must actually enter a p value 
such that the level of confidence is (1-p)*100%. For example, a 
“Confidence Level” value of 0.05 corresponds to requesting 95% 
confidence limits: (1—0.05)*100% = 95%. 

Bootstrap Iterations Specify the number of bootstrap iterations (default is 100) to run 
to estimate confidence bounds. The bounds can be one-sided or 
(if the “Use Two Sided CI?” box is checked) two-sided. 

The number of bootstrap iterations should be large enough to 
provide a stable estimate of the bounds. Values on the order of 
100 or more will probably be required in most cases; the user 
should perhaps do several runs to determine that the bound 
estimates have stabilized for the number of iterations chosen. 

Increasing the number of iterations will noticeably increase the 
time it takes to run the model. 

Save Bootstrap Result? Default is unselected (i.e., do not save bootstrap result). 

STUDY DESCRIPTION 

Supply any additional experiment-specific information to be reported in the output 
files. 

 Chemical Name 

 Exposure Type 

 Species Name 

 Gender 

FILE-RELATED FIELDS 

Table 50: File-related fields 

Field Function 

User Notes An editable field of up to 80 characters in length. The 
content of this field will be displayed in a single line of text 
under the date in the *.out file. 

Data File A field displaying the name of the data file (*.dax) file. 

Out File Name Displays the output path and file name. Click the Set button 
to change the file name and/or location. 
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See also: 

 Repeated Response Measures Option Screen 

 Repeated Response Measures Model Description 



Benchmark Dose Software (BMDS) User Guide  Appendix C: Version History 

BMDS version: 2.6.0.1 Page 294 of 310 Release Date: February 12, 2016 

APPENDIX C: VERSION HISTORY 

The following sections document new, changed, or updated BMDS features as 
documented in each version's respective readme file. The information is included 
here for historical and reference purposes. 

BMDS 1.2 

September 2, 2000—A new user interface (BMDS0900.exe) was distributed to 
fix some problems with installation of BMDS on certain Windows 98 
configurations. If you successfully installed BMDS version 1.2 using a previous 
installation procedure you do not need this upgrade. This upgrade merely 
simplifies the installation process and corrects some problems that did not allow 
BMDS to install to certain computer hardware/software configurations. (This 
version of the software is no longer being made available as there are newer 
versions now available which fix problems that were being encountered on newer 
operating systems.) 

BMDS 1.2.1 

October 25, 2000—A new version of BMDS, version 1.2.1, is being distributed at 
this time. This version contains new versions of the continuous Polynomial 
(version 2.1) and Hill (version 2.1) models. If you do not want to completely 
reinstall BMDS, you can download the the new model executables (see Latest 
Versions of BMDS Help and Model Files) and run them separately or under the 
BMDS version 1.2 interface. These new versions of the polynomial and Hill 
models fix problems associated with running the model on Windows NT/2000 
operating systems, provide improved model fit for certain unique data sets and 
improve upon the rate of convergence on a BMD and BMDL. 

BMDS 1.3 

March 22, 2001—Version 1.3 of BMDS is now available! This latest version of 
BMDS, version 1.3, contains new continuous Polynomial (v2.1), Power (v2.1) 
and Hill (v2.1) models, new dichotomous Multistage (v2.1), Weibull (v2.1) and 
Gamma (v2.2) models, and an improved user interface. The new models are 
more compact and stable (will converge on BMD and BMDL solutions more 
often). The user interface upgrades are described in the new help manual (PDF 
format) for version 1.3 and the readme.txt file that is distributed with the upgrade. 

http://www.epa.gov/ncea/bmds/versions.html
http://www.epa.gov/ncea/bmds/versions.html
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BMDS 1.3.1 

January 22, 2002—Version 1.3.1 of BMDS is now available! Version 1.3.1 
contains a revised help manual and user interface, including a revision to the 
interface that allows the Multistage model to calculate BMD and BMDL values for 
very low (below E-5) benchmark response (BMR) levels. 

November 13, 2002—A new polynomial model (Version 2.2) is now available 
that fixes the previous incompatibility with Windows 2000. Download it to your 
main bmds directory (same directory as the bmds.exe file). 

BMDS 1.3.2 

May 23, 2003—Version 1.3.2 of BMDS is now available! Version 1.3.2 contains 
revised polynomial (poly.exe) and nested logistic (nlogist.exe) models that are 
compatible with Windows 2000. If you are using a Windows 98 or older operating 
system, you may need to update your msvcrt.dll driver. We suggest that you 
obtain the latest msvcrt.dll driver from Microsoft or download this version of the 
msvcrt.dll driver and copy it to the c:\windows\system directory of your computer 
(you may have to exit Windows and do this in DOS mode). 

BMDS 1.4.1 

February 5, 2007—Version 1.4.1 is now available! All models have been 
recompiled to improve speed, stability and compatibility with the latest Windows 
operating systems. Improvements have been made to the model output format 
for all models. A Multistage-Cancer model has been added that calculates and 
reports a cancer slope factor and plots the linear extrapolation from the BMDL to 
the background response estimate per EPA's 2005 cancer guidelines. Unlike the 
Multistage model, the Multistage Cancer model does not estimate added risk, nor 
does it allow beta coefficients to be unrestricted. The Quantal-Quadratic model 
was removed from Dichotomous model choices (note: the user can still run this 
model by specifying the power term of the Weibull model to be 2, but this model 
is not retained in the BMDS dichotomous model listings) 

Issues in the continuous models that caused occasional errors in degrees of 
freedom assignments which impacted continuous model test results have been 
resolved. Acceptance criteria for Tests 2, 3 and 4 was changed from p>=0.05 to 
p>=0.1 and default risk type changed to “Std. Dev.” for all continuous models to 
be consistent with EPA's draft BMD technical guidance (EPA, 2000). Issues with 
the Hill model have been fixed, including memory problems which were causing 
some operating systems to crash. Parameter standard error estimates and Chi-
squared residual calculations in all the continuous models were checked and 
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corrected if in error. Model A3 of the continuous model testing procedures has 
been modified so that it always uses the user-specified value for the parameter 
rho, including the constant-variance case where rho = 0. When rho = 0, model A3 
is the same as model A1, and it is reported explicitly in the constant-variance 
runs. As a consequence, all model runs report the entire set of models (A1, A2, 
A3, R and the fitted model) and all four hypothesis tests. 

Issues in the Nested models that caused occasional errors in degrees of freedom 
assignments have been resolved. Memory problems which were causing 
problems for some NCTR model runs have been fixed. 

August 29, 2007—BMDS Version 1.4.1b has been added to replace version 
1.4.1. This version contains an update to the BMDS help file. 

November 9, 2007—BMDS version 1.4.1c is now available. This version 
updates dichotomous models that were already included on BMDS version 
1.4.1b. The updates primarily improve the handling of parameter specifications, 
particularly in situations where the user may wish to specify the background 
parameter to be zero. 

BMDS 2.0 (BETA) 

September 28, 2007—BMDS Version 2.0 beta is now available for inspection 
and testing (NOTE: this is a beta test version, provided only for your examination 
and testing—BMDS 1.4.1b should be used for definitive risk assessment 
calculations). BMDS 2.0 beta employs a new graphical user interface and makes 
it easy to run a number of models for one data set and compare the results. 
BMDS 2.0 beta also has a new set of quantal models with alternative background 
parameters (i.e., background additive to dose). We welcome comments and 
suggestions on the functioning of the interface and its new features, and on the 
new models. 

October 10, 2007—BMDS 2.0 beta—Build 19 released on October 10, 2007 
replaces the first BMDS 2.0 beta release of September 28, 2007 (Build 13). The 
new Build 19 has important changes and enhancements as a result of additional 
testing and user exposure and should be downloaded and used instead of Build 
13. Enhancements include the ability to better run a number of the BMD models 
and also added flexibility and fixes for user interface features. Changes include 
the designation of the new Dichotomous models as Alternate Dichotomous to 
better reflect their production status. Please refer to the readme.txt file included 
with the software installation for more details on the BMDS 2.0 beta. 
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BMDS 2.0 (FINAL) 

July 10, 2008—BMDS Version 2.0 final is now available. Released on July 10, 
2008, it replaces BMDS 1.4.1c as the official BMDS software. BMDS 2.0 is a 
rewrite of the user interface and risk assessment modeling framework, with a 
markedly improved functionality and enhanced multi-model processing 
capabilities. It uses the same underlying source code for the models in BMDS 
1.4.1 software, with minor corrections and some important additions. For details 
on the new user interface, go to the BMDS 2.0 Help menu option in the installed 
software. BMDS 2.0 also has a new set of quantal models with alternative 
background (i.e., background additive to dose) and asymptote (i.e., Hill model) 
parameters, as well as a Beta Exponential set of models. 

BMDS 2.1 (BETA) 

September 30, 2008—EPA is making version 2.1 of BMDS available at this time 
for public beta testing. Version 2.1 includes a beta (external peer review) version 
of a new time-dependent toxicodiffusion model for continuous outcomes (Zhu et 
al., 2005), incorporates graphical plots for the continuous exponential models 
and allows for the use of individual animal continuous response data. The BMDS 
toxicodiffusion model was developed by the USEPA National Center for 
Environmental Assessment (NCEA), through partnerships with the USEPA 
Neurotoxicology Division (NTD) and the University of South Florida, to 
characterize toxic effects (e.g., neurotoxicity) that potentially evolve along critical 
time points. It does this by: 

 modeling a dose-response along a time-course of repeated response 
measures; and 

 computing benchmark doses and their confidence limits along the time 
course. 

Documentation for the toxicodiffusion model can also be downloaded. The 
documentation contains a full description of the model, input requirements, model 
run options and sample runs. 

In addition, EPA is distributing an external review (beta) version of a 
concentration-time (CxT) model originally programmed by Wil ten Berge. The 
EPA ten Berge model implements an approach to evaluating the CxT 
relationships for effects associated with chemical exposures. The EPA's version 
1.0 implementation of this model is being distributed along with associated 
documentation and comments on the model received from external peer 
reviewers. EPA plans to respond to external review comments and incorporate 
the ten Berge model into a future version of BMDS. 
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BMDS 2.1 (BUILD 52) 

July 30, 2009—EPA is now distributing the final release of Version 2.1 (Build 52) 
of the Benchmark Dose Software (BMDS). BMDS 2.1 (Build 52) contains user 
interface enhancements as well as several additions/enhancements to the suite 
of models available for modeling dose-response data, including new features for 
the continuous exponential models and a new interface for the ten Berge 
concentration-time model. For details on the changes to the user interface, go to 
the BMDS 2.1 Help menu option in the installed software. The Readme.rtf file 
distributed with BMDS describes the improvements made in version 2.1 (Build 
52), installation requirements, and known problems. 

The exponential models contained in this version of BMDS have been developed 
in conjunction with the Netherlands' National Institute for Public Health and the 
Environment (RIVM) to be consistent with the exponential models contained in 
the RIVM's PROAST software . The USEPA and RIVM are working together to 
achieve consistency between the BMDS and PROAST software and methods. 

BMDS 2.1.1 (BUILD 55) 

November 9, 2009—EPA is now distributing Version 2.1.1 (Build 55) of the 
Benchmark Dose Software (BMDS). BMDS 2.1.1 (Build 55) contains a flexible 
new feature that allows users to export select BMDS summary report data and 
plots to Excel. It also contains a comprehensive set of sample session and model 
option files to assist users in running batch operations, and several 
improvements to the ten Berge model that were not available in version 2.1. The 
Readme.rtf file distributed with BMDS provides details on the improvements 
made in Version 2.1.1 (Build 55), installation requirements, and known problems. 

BMDS 2.1.2 (BUILD 60) 

June 11, 2010—BMDS 2.1.2 (Build 60) contains user interface enhancements to 
the “Summary Report” feature, new sample session and model option files, and 
improvements to the ten Berge model that were not available in version 2.1.1: 

 BMDS 2.1.2 can access folders or files with embedded space(s) in them. 
Combinations of the path and file name must be less than 256 characters. 

 The default location for searching for certain files (i.e. “Session,” “Option,” 
“Data,” “Plot,” and “Output” files) is now the last location (folder) to which the 
user saved that type of file or from which he accessed that type of file. There 
is a separate “memory” for file location for each of the above-listed file types. 

http://www.rivm.nl/proast
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 Improvements have been made to the “Export to Excel” feature associated 
with the “Summary Report” of a session run. . This feature allows the user to 
select which variables will be exported to Excel by checking/un-checking, in 
the “Export to Excel” column, the boxes corresponding to the variable rows 
the user wishes to export. The plots are exported as well, in a separate Excel 
“Plots” sheet. 

 Additional session and option files have been added to the “SessionFiles” and 
“OptionFiles” folders. These folders contain sample sessions that allow the 
user to quickly run a specific set of models and model options for a selected 
dataset. 

 The dichotomous Weibull model can accept a lower bound on power 
specified by the user. The EPA default choice (power restricted to be greater 
than or equal to 1) can still be checked, but if the user wishes not to restrict 
the power in that way, s/he may specify a value greater than or equal to zero; 
zero was the only other option in previous versions and that could cause 
biologically unrealistic fitted curves and numerical problems. 

 The Toxicodiffusion model no longer needs the R(D)com Active-X control and 
will run with any version of R, 2.6.2 or later. 

 Plots created by BMDS can be viewed using capabilities within BMDS or 
using GnuPlot. Those two options are accessed under the “Tools” menu item, 
the “View Plot” option. Using GnuPlot, the user can edit the plots to choose 
colors, fonts, line styles, etc. 

 The option screen for the ten Berge CxT (concentration-time) model BMDS 
2.1.2 had been improved to—address some issues and to allow saving the 
output file with a name of the user’s choosing. More importantly, CxT results 
from the ten Berge model are automatically exported to an Excel template file 
containing two customizable plots, one that shows the contour of 
concentration and time combinations for a user-specified probability and a 
second that shows the probability of response as a function of either 
concentration or time. In both plots, the user specifies the values of the other 
variables in the model. 

Like BMDS 2.1.1, BMDS 2.1.2 contains the following additions/enhancements 
over BMDS 2.0: 

 The ten Berge CxT model alluded to in item 5 above, allows for fitting of 
dichotomous response data sets having two or more explanatory variables 
(as in acute inhalation toxicity experiments). The explanatory variables can be 
entered as main effects or in interaction (cross-product) terms. The user can 
request the value (and its bounds) of one explanatory variable when a 
response rate is specified (fixing the other explanatory variables at some 
user-specified values) and/or conversely, the value (and its bounds) of the 
response rate, given specification of all explanatory variables. 
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 The executable for the set of models known as the exponential models, 
proposed by Dr. Wout Slob of RIVM in The Netherlands has been expanded 
to allow the assumption of log-normally distributed data (the previous versions 
of the exponential models and all other continuous models in BMDS assume 
that the data are normally distributed). The four exponential models fit by 
BMDS are defined and labeled as follows: 

Model 2: m(dose) = a*exp{sign*b*dose} 

Model 3: m(dose) = a*exp{sign*(b*dose)d} 

Model 4: m(dose) = a*(c—(c-1)*exp{-*b*dose}) 

Model 5: m(dose) = a*(c—(c-1)*exp{-*(b*dose)d}) 

where “sign” indicates the direction of change in the responses (sign=+1 for 
increasing responses; sign=-1 for decreasing responses). 

 A version of a new ToxicoDiffusion model for continuous outcomes (Zhu et 
al., 2005) allows for the analysis of repeated-measures data. The BMDS 
Toxicodiffusion model is able to characterize toxic effects (e.g., neurotoxicity) 
that potentially evolve with time points by 

 Modeling a dose-response along a time-course of repeated response 
measurements; 

 Computing benchmark doses and their confidence limits along the time 
course. 

The ToxicoDiffusion model includes graphical outputs showing the observed 
and model-predicted time-course data, residuals, and a summary of the 
bootstrap-based BMDL calculations. 

For further detail see Zhu, Y., Jia, Z., Wang, W., Gift, J., Moser, V.C., and B.J. 
Pierre-Louis (2005), Data Analysis of Neurobehavioral Screening Data: 
Benchmark Dose Estimation. Regulatory Toxicology and Pharmacology, pp 
190–201. 

BMDS 2.2 (BUILD 66) 

September 6, 2011—EPA is now distributing the final release of Version 2.2 (Build 66) 
of the Benchmark Dose Software (BMDS). Key enhancements in BMDS 2.2 (Build 66) 
include: 

 Multiple Tumor Analysis—BMDS 2.2 adds the capability to perform a 
combined analysis of multiple tumors. If the user is willing to assume that 
those tumors are independent and are well described by a multistage-cancer 
model, then the Multiple Tumor Analysis capability (accessed through the 
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File/New or File/Open tool-bar choices) allows the user to estimate BMDs and 
BMDLs for the combined incidence of the tumors in question (i.e., BMDs and 
BMDLs for the likelihood of getting one or more of those tumors). 

 Trend Test for Dichotomous Data—Another major addition is the new 
capability to perform a trend test on dichotomous data sets. This is the first in 
a series of trend test to be added to BMDS (future versions will also include 
trend test for continuous and nested data). The trend testing feature can be 
found on the dataset screens, accessible once a dataset has been identified 
by the user as containing dichotomous response data. The test performed is 
the Cochran-Armitage trend test described by Haseman (1984). 

 The Dichotomous Hill model has been modified—Changes to the 
parameter initialization section of the Dichotomous Hill code have improved 
the convergence features of this model. 

 Automatic Transfer of Variable Name Changes to Other Option Files in a 
Session—When working within a session, variable name changes (e.g., for 
dose, sample size, response, mean, or standard deviation variables) made in 
one option file (i.e., for one model) can be “transferred” to other option files 
included in that session (i.e., those for other models). The user will be 
prompted to determine if variable name assignment changes made in one 
option file should be made in all other option files included in that session. 
Thus, users can change variable name assignments once in a session, 
without having to make those changes separately in every option file. 

 Default Column Headers for New Datasets—Note also that newly created 
dichotomous, continuous or nested model data files will start with default 
column headers, in a particular order, as appropriate for the type of data (e.g., 
Dose, N, and Effect for dichotomous datasets; Dose, N, Mean, and Std for 
summarized continuous datasets). The user may change those default 
headers, but will be warned that doing so may affect the running of BMDS-
supplied sessions that look for those default names. 

BMDS 2.2 (BUILD 67) 

December 8, 2011—EPA is now distributing BMDS 2.2 (Build 67), which include 
minor modifications to the user interface. 

BMDS 2.3 (BUILD 68) 

September 12, 2012—BMDS 2.3 introduces more flexible error-trapping 
functionality, enabling users to store essential comments, documentation, 
notations, etc. on their data in the datasets and spreadsheets without triggering a 
data validation error. 
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Previously, BMDS ran validation checks on the dataset each time the file was 
opened. BMDS would interpret notes, comments, extraneous text, etc. contained 
in the dataset as data errors and would not open the file. This would require 
opening the file in a separate program and purging any comments or text. 

In BMDS 2.3, the application instead checks for data errors when the data is sent 
to the model. BMDS bases its validation on the dataset’s column assignments 
from the Option Screen. 

After you open the dataset, select the Model and Model Type, and then select 
Proceed, the Option Screen displays. In the Column Assignments section of the 
Option Screen, specify the data labels corresponding to the dataset variables 
(see the following screenshot). 

 

When you click Run, BMDS will validate and error-check the data for only those 
assigned columns. BMDS will then display a message box describing any errors 
related to invalid values or blank cells found in those columns. 

BMDS will also flag any duplicate column headers if they conflict with the Column 
Assignments specifications. Note that BMDS is case-sensitive, so BMDS 
considers dose, Dose, and DOSE to be separate variable names. 

BMDS 2.3 also features the following fixes and enhancements: 

 Fixes a problem reported by users of Microsoft Office in Windows 7, in which 
clipboard errors would crash both BMDS and Microsoft Office. 

 Warns the user when saving a file using a name that exceeds the Windows 
limit of 256 characters. To correct the problem, rename the file or move the 
file to a directory higher in the hierarchy. 

 Enhances Option screen validation to provide more thorough parameter 
constraint checking and to display pop-up messages describing errors. 

 Fixes bug that prevented BMDS from adding a new/existing data set to the 
Session Grid. 

 Fixes bug related to dynamically drawn dialog boxes. 
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 An issue was discovered in the computation of the A3 model log-likelihood for 
the continuous models when the user specified the variance parameter alpha. 
While this issue is being investigated and resolved, the option to specify alpha 
has been disabled for those models. 

 Fixes intermittent bug where occasionally, when running the exponential 
model, BMDS failed to display a summary graph and report, even when 
output files were produced. 

 Edits and updates to several Help topics: 

 Updated all Model Description topics to reflect upper parameter limit of 18 
for some models. 

 Added the following topics under “Other Data or Analysis Types”: Data 
With Negative Means, Test for Combining Two Data Sets for the Same 
Endpoint 

 Added the following Troubleshooting topics: Help File Does Not Display, 
Decimal Separator Should Be a Period (see Section 3, “Usage Tips,” in 
this file for more information) 

 Added description of multitumor model (.d) file to the Multiple Tumor 
Analysis topic. 

 Added text to the Dichotomous Hill and Logistic models descriptions to 
address occasional error messages that appear for these models. 

 Under the “Graphic Output from Models” topic, added the subtopic “Error 
Bar Calculations,” explaining how BMDS generates error bars for various 
model types. 

BMDS 2.3.1 (BUILD 69) 

September 28, 2012—BMDS maintenance release Version 2.3.1 (Build 69) 
replaces Version 2.3 (Build 68). It simplifies how data validation errors for certain 
models are reported to the user. BMDS 2.3 also introduced user interface 
improvements. 

None of the actual dose-response models in BMDS were modified for versions 
2.3 and 2.3.1. 

BMDS 2.4 (BUILD 70) 

BMDS 2.4 includes several enhancements to improve usability and ensure 
accurate and reliable results, such as more informative plot titles and the ability 
to change an option file on the fly within a session. The help file includes a new 
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section on “BMDS Best Practices” containing valuable information and guidance 
on such topics as optimization criteria, alternative models, re-initializing 
parameters, and lognormal response option, among others. 

Also, in this release, the BMDS install package includes ICF International's 
BMDS Wizard, an Excel-based tool that facilitates the preparation and 
organization of, and enhances the reporting capabilities of, BMDS modeling 
sessions. 

BMDS 2.4 adds the following new or enhanced functionality: 

 BMDS plots now provide more informative titles, such as “Weibull Model, with 
BMR of 10% Extra Risk and 0.95 Lower Confidence Limit for the BMD 
(BMDL).” 

 BMDS now includes the cancer slope factor for the MS_Combo output. 

 When an option file is modified via the Session Grid and saved under a new 
name, BMDS now automatically links that file to the current session. 

 In a modeling session, after changes are made to a model option file, BMDS 
lists the changes for the user and asks whether they should be applied to the 
other model option files in the session. A warning is given to remind the user 
that changes to option files will affect other sessions that use those option 
files. 

BMDS 2.4 also features the following fixes or changes: 

 Gnuplot files now remain on the screen until the user closes them. 

 Fixes a problem where exporting rows to Excel would shift column values to 
different headers on the Dichotomous Format and Continuous Format 
worksheets. 

 Fixes a problem where BMDS dichotomous models treated “%Positive” as 
Incidence data. 

 Fixes a problem where cut and paste operations on session data fields 
worked erratically on Windows 7 systems. 

 Fixes a problem where BMDS could not open datasets saved with a capital 
.DAX extension. 

 Fixes a problem where selecting a column in the data grid for a Log10 
transformation returned incorrect results. 

 Removes “Exact” as an available solution in the exponential model for 
summary data. 

 Removes the “Extra” option for all continuous models but Hill. 

 Removes the Optimization section from the options screens for all models 
that are not affected by optimization settings. 
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 Changes the default model iterations for all models from 250 to 500. 

 Harmonizes the output for all continuous models so that when the “Rel Dev.” 
BMR type is selected in the option screen, the “Risk Type” reported in the 
output file says “Relative deviation” rather than “Relative risk.” 

 Fixes a problem in the Multitumor Model (ms_combo) where BMDS failed to 
return a valid combined BMDL if the largest dose in the first dataset listed in 
the tumor analysis was less than the maximum dose in the other tumor 
analysis datasets. 

 Edits and updates several Help topics, including: 

 A new section, “BMDS Best Practices for Obtaining Optimal Model 
Convergence.” 

 A new topic under Troubleshooting: “Avoid using special characters in 
filenames.” 

 A new topic documenting the model files (with their version numbers) used 
in BMDS 2.4. 

 A new appendix for BMDS version history information that originally 
appeared in those versions' readme files. 

 A new note on log transformations for the topic “Data Transformation 
Types.” 

ICF INTERNATIONAL'S BMDS WIZARD 

The BMDS 2.4 install package includes ICF International's BMDS Wizard, an 
Excel-based tool that facilitates the preparation and organization of and 
enhances the reporting capabilities of BMDS modeling sessions. This install 
includes multiple copies of the ICF BMDS Wizard files that are preformatted for 
continuous, dichotomous, and dichotomous-cancer datasets. 

BMDS “power users” employ ICF BMDS Wizard as a shell to simplify the BMD 
modeling process by streamlining data entry, model selection, option file 
development, output file reporting, and model comparisons. 

ICF BMDS Wizard 1.7 can also export Microsoft Word-formatted reports that 
employ the latest EPA-approved reporting format (as of February 15, 2013). It 
can only export reports for continuous, dichotomous, and dichotomous-cancer 
models. 

To run the ICF BMDS Wizard, go to the BMDS 2.4 program directory and locate 
the “BMDS Wizard 1.7” subdirectory. ICF has included a readme and quickstart 
guide to the software. Please refer to that documentation for details on running 
the tool. 
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More information on the ICF BMDS Wizard can be found at ICF's Web site. 

Please note that ICF BMDS Wizard is not endorsed or approved by EPA. Please 
contact ICF International at wizard@icfi.com for support. 

BMDS 2.5 (BUILD 82) 

BMDS 2.5 provides updates to ICF International's BMDS Wizard, which includes 
support for 32-bit and 64-bit versions of Microsoft Office on Windows 7, as well 
as a new MS_Combo (multi-tumor) template. 

In addition, BMDS 2.5 contains various improvements to model stability and 
reliability. 

RESOLVED ISSUES 

BMDS 2.5 features the following enhancement and fixes: 

 The BMDS Tools>View Plot menu entry has been simplified to make it easier 
to generate a plot from a previously created .plt file. 

 The Multistage, Multistage Cancer and MS_Combo models now provide 
accurate results when non-integer input data values for Incidence and 
Number of Subjects used. 

 The Multistage, Multistage Cancer and MS_Combo models now work 
correctly when beta parameters are specified by the user. Previously, the 
models would fail to calculate BMDL. 

 The Power model now honors the direction of adversity specified by the user. 
Previously, the model always determined the direction automatically. 

 An intermittent crash in the MS_Combo model has been resolved. 

 Several Help topics have been revised, including: 

 Specified in the Troubleshooting section that path+filenames should not 
exceed 127 characters. 

 Added a topic documenting the MS_Combo model input file. 

 Added Appendix B, which documents, for each model options screen, all of 
that screen's fields, including any field constraints. 

 Updated the following topics to reflect BMDS .out files content: Continuous 
Model Text Output, Continuous Model Maximum Likelihood, Tests of Fit. 

http://www.icfi.com/insights/products-and-tools/bmds-wizard
mailto:wizard@icfi.com
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BMDS 2.6 

BMDS 2.6 includes several enhancements to improve usability and ensure 
accurate and reliable results. 

BMDS 2.6 also introduces a significant new feature: the ability for BMDS to 
automatically detect and, optionally, install software updates. This feature will 
ensure BMDS users have access to the latest version of the software with up-to-
date fixes and enhancements. 

The BMDS install package includes ICF International's BMDS Wizard, an Excel-
based tool that facilitates the preparation and organization of, and enhances the 
reporting capabilities of, BMDS modeling sessions. See the next section on the 
ICF BMDS Wizard for more information. 

BMDS 2.6 features the following enhancement and fixes: 

 Resolved the following issues related to the nested models (NLogistic, NCTR, 
and Rai and van Ryzin): 

 The approach to evaluating goodness-of-fit for the nested models has 
been changed. Now, a bootstrap-based approach (using the fitted model 
and the underlying beta-binomial distribution of the observations) is used 
to evaluate the lack of fit. This obviates the need to group the litter-specific 
observations across litters and avoids asymptotic approximations. 

 Fixed a calculation error that occurred when the litter-size covariate (LSC) 
was larger than the litter size. (Although the reliability of the Rai and van 
Ryzin model has been improved, there is a remaining issue where the 
model erroneously reports the same value for the BMD and BMDL under 
certain circumstances.) 

 Added scaled residual of interest calculations to the results report. Output 
includes min, average, and max scaled residual of interest, and number of 
litters used for the calculation. 

 BMDS now handles file and path names more robustly across all models. 
Specific changes include: 

 Full path length (folder plus file name) is now 255 characters rather than 
127. 

 Spaces and ampersands (&) are now permitted. 

 Fixed several issues that occurred when the user specified output and 
session names in some models. 

 BMDS now supports UNC (network) path names structured as 
\\ComputerName\ShareName\Path (e.g., 
\\FileSrv1\Users\JDoe\USEPA\BMDS260). The total number of characters 
cannot exceed 255. 
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 The ToxicoDiffusion and MS_Combo models are now out of “beta” status. 
Detailed technical documentation of these models can be viewed or 
downloaded from the BMDS Download page. 

 The ToxicoDiffusion model can now run when R has been installed on a per-
user basis. 

 Resolved an issue with the Linear and Polynomial models where incorrect 
MLE's were produced for non-constant variance in some situations. 

 Resolved an issue so that BMDS now correctly calculates and displays 
Standard Error Estimates for all models in the “Parameter Estimates” table, 
whereas previously most models displayed “*”. 

 Changed the color scheme for BMDS plots so they are easier to read. 

 Included the most recent version of gnuplot (version 4.6.3). 

 Fixed the Export to Excel function so it can export results for sessions 
containing any number of models. (Previously, sessions containing more than 
24 models produced an error during export.) 

 Fixed an issue so that BMDS now supports regional settings for the decimal 
separator in the user interface and in spreadsheets created by the Export to 
Excel function. However: 

 Files generated by BMDS (such as the .out files and .d files) will still show 
“.” as the decimal. 

 No “thousands separator” (regardless of regional setting) can be used in 
the data; that is, one thousand can only be written as 1000 rather than as 
1,000. 

 Added the following items to the summary table in the BMDS user interface: 
“Scaled Residual for Control Group” and “Scaled Residual for Dose Group 
Nearest the BMD”. The relevant values are already printed out in the 
“Goodness of Fit” table. 

 Improved the e-Ticket system for users to request support and guidance. The 
new URL is http://bmds.epa.gov/eticket. 

 Fixed an issue in the Power model where the specified power parameter 
output value was displayed incorrectly in the output text. 

 Fixed an error in the restricted linear model when variance is non-constant. 

 Fixed the alpha parameter initialization feature in the model options screen. 

 New data grid windows now default to display 1000 rows. The previous 
default was 100. 

 In addition to minor changes to accommodate the fixes and enhancements 
described above, the following Help file topics have been significantly revised 
or added: 
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 Added: Troubleshooting>No Thousands Separator Can Be Used in the 
Data 

 Added: Troubleshooting>Requesting Support using eTicket 

 Added: Using BMDS 2.6.0>Keeping BMDS Up to Date 

 Added: Model Descriptions>Multitumor (MS_Combo) Model Description 

 Added a note to the Output From Models>Text Output from 
Models>Dichotomous Model Text Output topic, describing how standard 
error methods are calculated for parameters for multistage models vs. 
other dichotomous models. Also added text to the Continuous Model Text 
Output and Nested Model Text Output topics describing how their 
parameter standard errors are obtained. 

 Revised text on standard error calculations for the continuous model 
topics. 

 Updated the Model Descriptions>Nested Model Descriptions topic to 
describe how the goodness-of-fit p-values are calculated using a bootstrap 
approach. The Nested Model Description subtopics also include revised 
formula descriptions. 

 Updated the topic “Models Included in BMDS 2.6.0” to reflect updated 
versioning information. 

 Updated several topics in “Appendix A: Model Input File Format 
Descriptions” to reflect user interface changes. Also added input file 
details for the Dichotomous Hill and Quantal with Background Dose 
models. 

 Updated several topics in “Appendix B: Model Options Screen Fields 
Reference” to reflect user interface changes. 

BMDS 2.6.0.1 

BMDS 2.6.0.1 contains the following fixes and enhancements: 

 Resolves an issue in BMDS 2.6 that prevented users from specifying 
parameter values for Continuous models. (BMDS still prevents users from 
specifying the Continuous model Alpha parameter to work around an open 
issue where BMDS sometimes reports a non-optimal A3 log likelihood when 
the Alpha parameter is specified.) 

 Resolves an issue with previous versions where BMDS occasionally reported 
incorrect scaled residuals when a session referenced multiple data files with 
differing dose values. 
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 Enhances the Nested models' text results to display the minimum, maximum, 
and mean of the absolute value of the scaled residuals, as well as the 
minimum, maximum, and mean of the scaled residuals. 

 Resolves an issue where BMDS 2.6 could not display plots generated by 
previous BMDS versions. 

 Implements a fix for an intermittent issue where the BMDS Wizard did not 
import plots generated by BMDS 2.4 and later. 

 Correctly validates the v parameter for the Continuous Hill model, an issue 
since BMDS 2.3. Although the v parameter must be 0 < v ≤1 for Dichotomous 
Hill, it should be unconstrained for the Continuous Hill model. 

 Adds an Update button to the About BMDS box (accessible from the 
Help>About menu item). Click the Update button to have BMDS check for and 
optionally install a BMDS update. 
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